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1.  Introduction 
 

FRANC3D is a program that inserts cracks and/or voids in pre-existing finite element (FE) 

meshes.  This manual describes the components of the graphical user interface of the program, 

specifically for Version 8.  It also includes underlying concepts and theory where appropriate; 

the User’s Guide provides more details on concepts, and the (future) Theory Reference will 

provide more details on theory.  A separate FRANC3D Command Language & Python 

Extensions reference provides a listing of all the commands to run in batch-mode along with the 

corresponding Python functions and a description of the Python user-crack-growth capabilities. 

 

There are four FRANC3D Tutorial documents that describe the program usage when combined 

with the three supported commercial FE codes: ANSYS, ABAQUS and NASTRAN.  There are 

preliminary Tutorials for each of the three analysis codes to describe the interface between 

FRANC3D and the analysis codes.  A more generic Tutorial#2-14 document describes additional 

example simulations.  

 

There is also a FRANC3D Benchmark document that describes crack configurations for which 

there are analytical or handbook solutions for stress intensity factors (SIFs), and the FRANC3D 

SIFs are compared to these values.  

 

To get started using FRANC3D, one can choose one of the preliminary Tutorials and follow the 

steps.  You can consult this Reference document for more details at any of the steps in the 

tutorial.  You should also try to reproduce the Benchmark models or choose your own models for 

validation. 

 

In this document, menu buttons, dialog or wizard panel titles, and buttons on these panels are 

indicated by bold text.  Fields, labels and selectable options inside the dialog or wizard panels 

are indicated by underlined text.  Model and file names will be indicated by italic text.  

 

 

2.  General and 3D View Manipulation 
 

An image of the main FRANC3D window is shown in Fig 2.0.1.  Most of the window consists of 

a 3D graphics space that displays the current model. 

 

When a model is first displayed, the 3D view is set such that the viewer is looking toward the 

center of the model from a position in the positive z direction.  The distance from the viewer to 

the model is set so that the full model is visible. 

 

The 3D view is changed by moving the mouse in the graphics window with the appropriate 

combination of mouse buttons and keyboard keys depressed.  There are five basic functions for 

view manipulation.  A unique combination of mouse buttons and keyboard keys is defined for 

each of the functions.  The button and key assignments can be changed using the 3D View tab in 

the Preferences dialog box (described in Section 5.4). 
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Figure 2.0.1  FRANC3D main window. 

 

 

 

The view functions are (using FRANC3D default mouse and keyboard key assignments): 

 

Rotate (left mouse button, no keyboard keys): Mouse motion rotates the model on the screen.  

The mouse can be moved in any direction.  The axis of rotation is defined to be perpendicular to 

the mouse motion and passes through the current center of rotation.  The center of rotation is 

defined as the horizontal and vertical center of the graphics window at a location midway 

between the front and back clipping planes (described below).  The center of rotation can be 

changed, Fig 2.0.2, using the Ctrl key and left mouse button (or with the Recenter button). 

 

Pan (center mouse button or wheel, no keyboard keys): Mouse motion pans or drags the model 

around the screen. The mouse can be moved in any direction, and the model moves in such a 

way as if it were following the mouse. 

 

Zoom/Spin (right mouse button, no keyboard keys):  These are two distinct types of motion 

activated by the same mouse key.  If the mouse is moved up or down, it will appear as if the 

viewer is getting closer or farther, respectively, from the model.  If the mouse is moved left or 

Menu Bar

3D Model 
View Window 

Camera 
Positions

and 
View 

Controls

Status Bar

Orientation 
Axes 
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right, the model rotates about an axis that is perpendicular to the plane of the screen and passes 

through the horizontal and vertical centers of the window. 

 

  

Figure 2.0.2  Recenter. 

 

 

Front Clip (center mouse button or wheel plus shift key):  A cutting (or clipping) plane can be 

moved parallel to the screen from the viewer toward the model.  This can be used to clip away 

the front of a model to see internal features such as cracks.  Moving the mouse upward "pushes" 

the clipping plane away from the viewer toward the model, cutting away the portion of the model 

closest to the viewer.  Moving the mouse downward "pulls" the plane away from the model and 

toward the viewer. 

 

Back Clip (right mouse button or wheel plus shift key):  A cutting plane can be moved parallel to 

the screen from behind the model toward the viewer.  This can be used to clip away parts of the 

model that might be making the view confusing (this is especially useful when the model is 

displayed in "wireframe" mode without polygons).  Moving the mouse upward "pushes" the 

clipping plane away from the viewer.  Moving the mouse downward "pulls" the clipping plane 

toward the viewer, which will cut away the back portion of the model. 

 

 

2.1 View Controls 
 

The view controls box, along the right-hand side of the FRANC3D main window, provides 

additional options for manipulating the view of the model, Fig 2.1.1. 

Recenter 

Point 
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Figure 2.1.1  View controls side panel. 

 

 

 

Graphical Element Toggles: Graphics in 3D display windows consist of a combination of 

markers, vectors, polygons, and text.  The toggles in this box will turn these items on or off 

independently.  The surface mesh and crack fronts can be turned on or off as well. 

 

Named camera positions: The list of named camera positions is displayed in the list box. There 

should always be a reset view provided as the default (d) view.  A crack view will be saved 

automatically after a crack is inserted. User-named camera positions can be Saved to a file and 

Read from a file.  

 

Preset Controls: These preset camera position icons provide quick access to preset views that 

place the viewer along one of the Cartesian axes.  The two icons on the right switch the view 

between perspective and orthographic. 

 

View Options:  This button displays the dialog in Fig 2.1.2.  In this dialog, the Show Axes turns 

the Cartesian axes display on or off.  The Different Front/Back Colors turns the front/back 

coloring on or off.  By default, the front and back sides of a surface are shaded differently.  This 

toggle is useful when looking at the crack surface, where the two surfaces are coincident. The Set 

Speed sliders allow one to control the rotation, translation, zoom and spin speeds independently. 

The Cutting Planes option allows one to define cutting planes normal to the global Cartesian 

axes.  These will cut away a portion of the model.  These are independent from the front and 

back clipping planes.  

Graphical Element Toggles

Named Camera Positions

Preset Camera Positions

View Options
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Figure 2.1.2  View Options dialog. 

 

 

 

Recenter:  This button displays the Set Rotation Center dialog, Fig 2.1.3.  One can specify the 

center of rotation interactively, using the dialog in Fig 2.1.4.  A node id or Cartesian coordinates 

can be specified also.  In the Setcenter View dialog, Fig 2.1.4.  The center of rotation can be set 

by dragging the red boxes left or right and up or down.  The new center of rotation is the 

intersection of the three lines that have the red-box-handles.   

 

 

 

 

Figure 2.1.3  Set Rotation Center dialog. 
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Figure 2.1.4  Setcenter View dialog. 

 

 

 

Capture:  This button displays the Save File As dialog, Fig 2.1.5.  The current view of the 

model is captured and saved to a file.  Either a .png or .jpg file can be saved.  

 

 

 

Figure 2.1.5  Save File As dialog. 

 

 

The bottom of row of icons, Fig 2.1.6, allow one to do a box-zoom, to take measurements on the 

model surface, and to define front and back clipping planes. 
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Figure 2.1.6  Bottom row of icons: box-zoom, measurements, and clipping planes. 

 

 

Box Zoom: This allows one to zoom-in on a portion of the model by dragging a box, Fig 2.1.7.  

Press the Box Zoom button and then, using the left mouse button, click and hold, then drag the 

mouse to create the box, and then release the mouse button. 

 

 

 

Figure 2.1.7  Box zoom used to zoom-in on a portion of the model. 

 

 

 

Measurements: This allows one to find the Cartesian coordinates of a point on the model 

surface, or to find the distance between two points on the model surface, Fig 2.1.8.  Using the 

left mouse button, click on the model surface to view the coordinates; click and hold and then 

drag the mouse to obtain the distance between two points on the model surface. 

 

 

Zoom box
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Figure 2.1.8  Surface measurement. 
 

 

 

Clipping:  This icon displays the Clipping View dialog, Fig 2.1.9.  The front and back clipping 

planes can be moved by dragging the red boxes left or right.  This is an alternative to the mouse-

keyboard combinations described previously. 

 

 

 

Figure 2.1.9  Clipping view dialog. 
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3.  Menus 
 

A summary of the menus, from the menu bar shown in Fig 2.0.1, is provided here.  In general, 

selecting a menu item leads to a wizard or dialog.   

 

The Help menu is described here, while all other menu options are described in more detail in 

Sections 4 through 14. 

 

 

3.1  Help 
 

The Help menu, Fig 3.1.1, is on the far-right side of the menu bar and has options for accessing 

the FRANC3D documentation either locally, if installed, or on-line from FAC’s web site 

(http:\\www.fracanalysis.com/software.html).  The appropriate documentation will be displayed 

in a web browser if the files have been installed locally and the file path set.  If the file path has 

not been set, the user is presented with a dialog box, Fig 3.1.2, and the appropriate .pdf file can 

be selected.  Alternatively, if the FRANC3D Website menu option is selected, FAC’s web site is 

accessed, and the appropriate documentation can be selected there.  

 

 

 

 

 

Figure 3.1.1  Help Menu. 

 

 

http://www.fracanalysis.com/software.html
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Figure 3.1.2  FRANC3D documentation file location dialog. 

 

 

3.1.1  License Status 

 

The second last menu item displays the License Status dialog, Fig 3.1.3, which shows the 

current license expiration. 

 

 

 

Figure 3.1.3  License status dialog box. 

 

 

3.1.2  About Dialog 

 

The last menu item displays the About dialog, which contains the version number, the build 

number and date, acknowledgements, and a list of supporting agencies, Fig 3.1.4.  We also 

appreciate the help, support, and contributions of our users.  
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Figure 3.1.4  FRANC3D About dialog box. 

 

 

 

 

3.2  File 
 

The File menu is shown in Fig 3.2.1.  Each of the menu items is listed below. 

 

 

Fig 3.2.1  File Menu. 
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Open ... - Displays an Open File dialog box that allows a user to read a FRANC3D restart file; 

see Section 4.1.   

 

Work Directory ... - Displays a dialog box that allows a user to set the working directory; see 

Section 4.2.   

 

Close - Closes the current model so that a new model can be read or imported; see Section 4.3. 

 

SaveAs ... - Displays a Save File As dialog box, which allows a user to save the current model to 

a FRANC3D restart file; see Section 4.4. 

 

Import ... – Allows a user to import an uncracked FE model file.  The file types that can be read 

include:  .cdb, .inp, .bdf.  The .cdb files are ANSYS database files in ASCII format.  The .inp 

files are ABAQUS input files.  The .bdf (or .nas) files are NASTRAN database files; see Section 

4.5. 

 

Export ... – Allows a user to export a FE model file.  ANSYS .cdb, ABAQUS .inp and 

NASTRAN .bdf file formats can be written; see Section 4.6. 

 

Read Results ... - Invokes the Read Results File dialog; see Section 4.7. 

 

Playback ... - Invokes the Playback Session File dialog, which allows a user to read in a session 

log file and reproduce the commands in that file; see Section 4.8. 

 

Quit - Closes the model and exits the program; see Section 4.9. 

 

 

3.3  Edit 
 

The Edit menu is shown in Fig 3.3.1.  Each of the menu items is listed below. 

 

 

Figure 3.3.1  Edit Menu. 

 

 

Unit Conversion... - Invokes the Model Units dialog box; see Section 5.3. 

 

Preferences... - Invokes the Preferences dialog box; see Section 5.4. 

 

 

3.4  Cracks 
 

The Cracks menu is shown in Fig 3.4.1.  Each of the menu items is listed below. 
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Figure 3.4.1  Cracks Menu. 

 

 

New Flaw Wizard ... - Invokes the New Flaw wizard; see Section 6.1. 

 

Flaw From Files ... - Invokes the Locate Flaw File dialog, described in Section 6.2, followed by 

a subset of the New Flaw wizard.  This option allows a user to select a flaw description from a 

file, or from multiple files, and insert it into the current model. Note that one cannot insert a 

crack into an already-cracked model. 

 

Multiple Flaw Insert ... Invokes the Multiple Flaw wizard; see Section 6.3. 

 

Compute SIF's ... - Invokes the Compute SIF's wizard; see Section 6.4.  Note that 

displacements from a completed analysis must be available for this option to be enabled. 

 

Grow Crack ... - Invokes the Crack Growth wizard; see Section 6.5.  Note that displacements 

from a completed analysis must be available for this option to be enabled. 

 

Read Crack Growth ... - Invokes the Read Crack Growth wizard; see Section 6.6.  

 

Grow/Merge Cracks ... - Invokes the Crack Growth/Merge wizard; see Section 6.7.  

 

Edit Crack Geometry ... - Invokes the Edit Crack Geometry dialog; see Section 6.8.  

 

SIFs Along a Path ... - Invokes the SIFs Along a Path dialog; see Section 6.9.  

 

SIFs For All Fronts... - Invokes the SIFs For All Fronts dialog; see Section 6.10.  
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3.5  Loads 
 

The Loads menu is shown in Fig 3.5.1.  Each of the menu items is listed below. 

 

 

 

Figure 3.5.1  Loads Menu. 

 

 

Crack Face Pressure/Traction ... - Invokes the Crack-Face Tractions dialog; see Section 7.1. 

 

 

3.6  Analysis 
 

The Analysis menu is shown in Fig 3.6.1.  Each of the menu items is listed below. 

 

 

Figure 3.6.1  Analysis Menu. 

 

 

Static Crack Analysis ... - Invokes the Static Crack Analysis wizard; see Section 8.1. 

 

Crack Growth Analysis ... – Invokes the Crack Growth Analysis wizard; see Section 8.2. 

 

 

3.7  Fatigue 
 

The Fatigue menu is shown in Fig 3.7.1.  Each of the menu items is listed below. 

 

 

Figure 3.7.1  Fatigue Menu. 

 

 

Fatigue Life Predictions ... - Invokes the Fatigue Life dialog; see Section 9.1. 
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View/Edit Growth Parameters ... – Allows one to open a growth parameters file and then edit it; 

see Section 9.2. 

 

Crack Front Fatigue Values ... – Displays a plot of the crack growth data; see Section 9.3. 

 

 

 

3.8  Fretting 
 

The Fretting menu is shown in Fig 3.8.1.  Each of the menu items is listed below.  Note that the 

Fretting menu is not turned on by default; it can be turned on in the Preferences dialog. 

 

 

 

Figure 3.8.1  Fretting Menu. 

 

 

Read Model and Results ... - Invokes the Fretting Model Import wizard; see Section 10.1. 

 

Import Nucleation Data ... - Invokes the Fretting Data Import wizard; see Section 10.2. 

 

Fretting Crack Nucleation ... - Invokes the Fretting Crack Nucleation wizard; see Section 

10.3. 

 

Region Color ... - Invokes the Region Color dialog; see Section 10.4. 

 

 

3.9  Display 
 

The Display menu is shown in Fig 3.9.1.  Each of the menu items is listed below. 

 

 

 

Figure 3.9.1  Display Menu. 

 

View Response ... - Invokes the View Response dialog; see Section 11.1. 

 

Create Animation ... - Invokes the Animation dialog; see Section 11.2. 
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3.10  Single Crystal 
 

The Single Crystal menu is shown in Fig 3.10.1.  Each of the menu items is listed below. Note 

that the Single Crystal menu is not turned on by default; it can be turned on in the Preferences 

dialog. 

 
 

 

Figure 3.10.1  Display Menu. 
 

Resolved Stress Intensities... - Invokes the Resolved SIF's wizard; see Section 12.1.  Note that 

displacements from a completed analysis must be available for this option to be enabled. 

 

Resolved SIFs Along a Path... - Invokes the Resolved SIFs Along a Path dialog; see Section 

12.2. 

 

View Crystal Orientations... - Invokes the Crystal Orientations dialog; see Section 12.3. 

 

 

3.11  Electrical 
 

The Electrical menu is shown in Fig 3.11.1.  Each of the menu items is listed below. Note that 

the Electrical menu is not turned on by default; it can be turned on in the Preferences dialog. 

 
 

 

Figure 3.11.1  Display Menu. 
 

Electrostatic Energy Release Rates... - see Section 13.1.   

 

 

 

 

3.12  Advanced 
 

The Advanced menu is shown in Fig 3.12.1.  Each of the menu items is listed below. 
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Figure 3.12.1  Advanced Menu. 

 

 

Edges Wizard ... - Invokes the Edge Extraction wizard; see Section 14.1. 

 

Display COD Data ... - Invokes the Display COD Data dialog; see Section 14.2. 

 

Write Template Data ... - Invokes the Write Template Data dialog; see Section 14.3. 

 

Create Growth History ... - Invokes the Create Growth History dialog; see Section 14.4. 

 

Export Crack Data ... - Invokes the Export Crack Data dialog; see Section 14.5. 

 

Read User Extensions ... - Invokes the Read User Extensions wizard; see Section 14.6. 

 

Initial Stress File ... - Invokes the Initial Stress File dialog; see Section 14.7. 

 

Initial Strain File ... - Invokes the Initial Strain File dialog; see Section 14.8. 

 

Plot CFT Stress File ... – Displays mesh-based crack face tractions; see Section 14.9. 

 

Edit Retained Nodes ... – Invokes the Edit Retained Nodes dialog; see Section 14.10. 

 

Contour Integral Data ... – Invokes the Contour Integral Data dialog; see Section 14.11. 

 

 

 

4.  File Menu Wizards and Dialog Boxes 
 

The wizards and dialog boxes for the File menu options are described in this section.  
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4.1  Open…Ctrl-O 
 

The File →Open menu option allows the user to read a FRANC3D restart file, with .fdb 

extension.  The Restart File dialog allows one to select a .fdb file, Fig 4.1.1. 

 

 

 

Figure 4.1.1  Model File dialog box. 

 

 

 4.1.1  FRANC3D Restart (.fdb) Files 

 

FRANC3D reads the contents of the .fdb file along with reading any files that are referenced 

inside it.  The .fdb file is organized in blocks, with each block having a title and version number.  

The blocks and their content are summarized here: 

 
F3D_V8.1 ( 

Uncracked FE file name, type, and retained data. 

) 

HISTORY_SUMMARY ( 

Summary of the crack step file names. 

) 

STATICMETA ( 

Analysis type, and input and results file names. 

) 

FLAWSURF ( 

Description of crack geometry: surface patches, crack front vertices, and template parameters. 
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Note that this block can be extracted and saved to a .crk file. 

) 

CRACKFRONTIDS ( 

List of crack front identifiers. 

) 

TEMPLATENODES { 

List of crack front mesh template node ids. 

} 

TEMPLATENODECOORDS { 

List of crack front mesh template node coordinates. 

} 

SIF_COMP_PARAMS ( 

Stress intensity factor computation parameters. 

) 

GROWTH_PARAMS ( 

Crack growth model parameters. 

) 

TEMPLATE_PARAMS ( 

Crack front mesh template parameters. 

) 

CRACKFACENODES { 

List of crack face nodes with the local normal to the crack surface. 

} 

EDGE_EXTRACT_PARAMS ( 

Edge extraction parameters. 

) 

MESH_PARAMS ( 

Meshing parameters. 

) 

CRACK_GROWTH_DATA ( 

Crack growth history data. 

) 

UNITS ( 

Model units for length, stress, and temperature. 

) 

SUBMODEL_NODE_MAP ( 

Node id mapping between .fdb and FE model input. 

) 

SUBMODEL_ELEM_MAP ( 

Element id mapping between .fdb and FE model input. 

) 

SAVED_VIEWS { 

List of saved camera positions. 

} 

 

 

FRANC3D attempts to read all the files referenced in the .fdb file.  If a file is missing, the user is 

prompted to locate that file, Fig 4.1.2.  Note that FRANC3D needs to access the original 

uncracked FE model files as well as files associated with the current crack growth step.  
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Figure 4.1.2  Locate File dialog box for finding missing files. 

 

 

4.2  Work Directory 
 

The File →Work Directory menu item allows the user to set a current working directory to save 

subsequent analysis files.  The dialog, Fig 4.2.1, allows one to select the desired folder; press 

Accept once the folder is highlighted.  This should be done first to ensure the session log and 

other files are saved to this folder. 

 

 

 

Figure 4.2.1  Set Working Directory dialog box for setting the current directory. 
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4.3  Close 
 

The File →Close menu item closes the current model without quitting FRANC3D.  If a model is 

open and has not been saved, the Save Model Warning dialog, Fig 4.3.1, is displayed.  If the 

user wishes to save the model, the Cancel button can be selected.  Selecting the OK button will 

close the model without saving. 

 

 

 

Figure 4.3.1  Save Model Warning dialog. 

 

 

4.4  Save As… 
 

The File →Save As menu item can be used to save the FRANC3D restart (fdb) file of a cracked 

model if the user does not want to perform an immediate analysis of the model.  In addition to 

the .fdb file, a FE analysis file will be saved; the FE file type will be the same as the original 

input file type.  The user is prompted to enter the .fdb file name, Fig 4.4.1, and press Accept. 

 

 

 

Figure 4.4.1  Save File As dialog. 
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Note that the files saved with the Save As option can differ from the files saved with the Static 

Crack Analysis and Crack Growth Analysis options (see Section 8).  The Save As option does 

not write the merged local-cracked + global FE file. 

 

 

4.5  Import… 
 

The File →Import menu item is used to import initial uncracked FE models into FRANC3D.  

The dialog shown in Fig 4.5.1 is presented.  The user can choose: 1) import a complete model 

into FRANC3D, 2) import and divide so that FRANC3D works on a local submodel, or 3) 

import an already divided model.  Depending on the radio button that is chosen, different dialogs 

will be displayed next. 

 

 

 

Figure 4.5.1  Select Model Import Type dialog. 

 

 

 

4.5.1  Import a Complete Model 

 

The dialog shown in Fig 4.5.2 is displayed.  The user chooses the FE model type: ANSYS, 

ABAQUS or NASTRAN using the radio button at the top.  If ANSYS is chosen, the user can 

also check the Extra load files box, if ANSYS load step files (.s##) are to be imported as well. 

 

If the ANSYS Extra load files box is checked, the dialog shown in Fig 4.5.3 is displayed. The 

user can select one or more .s## files.  Use the Shift or Ctrl key to select multiple file names. 
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Figure 4.5.2  Select Model to Import dialog. 

 

 

 

 

Figure 4.5.3  Select ANSYS Extra load step files dialog. 
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Once the FE model file has been selected, the Select Retained BC Surfaces dialog is displayed, 

Fig 4.5.4.  Any surface that has boundary conditions will be highlighted in blue.  These surfaces 

can be selected using the Select All button, and the blue surfaces will become red.  Node sets, 

element surface sets and surfaces can also be displayed using the Show Node Sets, Show Surf 

Sets and Show Surfaces buttons; these buttons allow sets/surfaces without boundary conditons 

to be retained.   

 

Note that cracks cannot be inserted into or propagated into a surface mesh that has been retained.  

If a surface has boundary conditions and a crack must be inserted into this surface, do not retain 

the mesh facets on this surface; the boundary conditions will be transferred to the remeshed 

surface.  If a crack will not be inserted into a surface with boundary conditions, it is more 

efficient and more exact to retain the mesh so that boundary conditions are transferred directly. 

 

 

 

Figure 4.5.4  Select Retained BC Surfaces dialog. 

 

 

4.5.2  Import and Divide Model 

 

If the user chooses to import and divide, the first dialog that is presented is the same as that 

shown in Fig 4.5.2.  Once the model file has been selected, the Submodel tool is displayed, Fig 

4.5.5.  There are options for selecting a portion or portions of the model, and these are described 

in the subsections below.  Once a sub-model is defined and cropped, press Next and this will 

lead to the Select Retained BC Surfaces dialog (see Fig 4.5.5) if the sub-model has boundary 

conditions or sets/surfaces. 
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Figure 4.5.5  Define a Local Submodel dialog. 

 

4.5.2.1  Cropping Selection Options 

 

The first setting in the Cropping Options allows one to specify which ‘side’ of the selection plane 

or box is selected.  The top row of radio buttons in Fig 4.5.6 lets one choose the ‘left’ or ‘right’ 

side (Fig 4.5.7); this is straightforward to describe when using the planar options below, but it 

also applies to the other options.  For instance, when using the Rubberband Box, the selection 

will be either inside or outside of the rubberband box depending on which radio button is 

selected. 

 

The second row of radio buttons allows one to select elements with either one or all nodes of the 

element collected.  Fig 4.5.8 shows a case where the cutting plane is half-way through the 

elements; choosing the first option includes these cut-elements, while choosing the second option 

discards the elements that are cut. 

 

Note that selected elements are colored red. 

 

 

Figure 4.5.6  Cropping Options selection options dialog. 
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Figure 4.5.7  Selection based on ‘left’ and ‘right’ selection. 
 

  

Figure 4.5.8  Selection based on Retain if: ‘one node in’ and ‘all nodes in’ selection. 

 

4.5.2.2  Relative to a principal plane 

 

The first crop-type allows one to define a plane that is aligned with the Cartesian axes, Fig 4.5.9.  

The plane can be offset from the origin, and the elements on either the ‘left’ or ‘right’ side of the 

plane are selected.  In this case and in all cases below, the radio buttons at the top (see Section 

4.5.2.1) are set to the defaults, which means left-side selection and one-node-in, Fig 4.5.10. 

 

 

 

Figure 4.5.9  Relative to principal plane cropping option. 
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Figure 4.5.10  Selection based on offset YZ principal plane and left-side selection. 
 

4.5.2.3  Plane normal and offset 

 

The second crop-type allows one to define a plane that is normal to the unit vector defined by the 

x, y and z coordiantes, Fig 4.5.11.  The plane can be offset from the origin.  Fig 4.5.12 shows a 

plane that is normal to the vector (1,0,0), which is the same as the YZ principal plane in Section 

4.5.2.2. 

 

 

Figure 4.5.11  Plane normal and offset cropping option. 

 

 

Figure 4.5.12  Selection based on a plane normal and offset. 
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4.5.2.4  Plane from three points 

 

The third crop-type allows one to define a plane based on the selection of three points, Fig 

4.5.13.  The user presses the Select button for each point, and then uses the (cross) cursor to pick 

the point; three points of a triangle define the plane.  Fig 4.5.14 shows the second (blue) point 

that was selected here.  Fig 4.5.15 shows the resulting plane that was created by picking 3 points 

at x=5 coordinates; this is the same as the YZ principal plane in Section 4.5.2.2. 

 

 

Figure 4.5.13  Plane from three points cropping option. 

 
 

 

Figure 4.5.14  Second (blue) selected point used to define a plane. 

 
 

 

Figure 4.5.15  Selection based on a plane from three points. 

 

4.5.2.5  Rubberband box 

 

The fourth crop-type allows one to define a box or cylinder, Fig 4.5.16.  The user selects the 

Rectangular or Circular radio button, presses the Define button, and then uses the left-mouse 

button to drag the outline of a box or cylinder on the screen,  Fig 4.5.17.  The right-side image in 

Fig 4.5.17 is rotated to show the box.  
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Figure 4.5.16  Rubberband box cropping option. 

 
 

  

Figure 4.5.17  Selection based on a rectangular rubberband box. 
 

4.5.2.6  Element by element 

 

The fifth crop-type allows one to select (or unselect) individual elements, Fig 4.5.18.  The user 

presses the Select button and then uses the left-mouse button to select elements one at a time,  

Fig 4.5.19.  The default is to have all elements pre-selected and the Select button actually turns 

off the selection, while the Unselect button re-selects the element. 

 

 

Figure 4.5.18  Element-by-element cropping option. 

 
 

 

Figure 4.5.19  Selection based on element-by-element picking. 
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4.5.2.7  By material 

 

The sixth crop-type allows one to select elements based on the material id, Fig 4.5.20.  The user 

selects the material id # after pressing the Select button.  The model in Fig 4.5.21 has two 

materials and material 1 is selected. 

 
 

 

Figure 4.5.20  By material id cropping option. 

 
 

  

Figure 4.5.21  Selection based on material id.   
 

4.5.2.8  By element group 

 

The seventh crop-type allows one to select elements based on an element group name, Fig 

4.5.22.  The user selects the label after pressing the Select button.  The model in Fig 4.5.23 has 

several element groups, one of which has been selected. 

 

For ANSYS, element groups are defined by ‘CMBL’ data in the .cdb file, and for ABAQUS, the 

‘ELSET’ data in the .inp file defines the groups. 

 

 

 

Figure 4.5.22  By element group label cropping option. 
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Figure 4.5.23  Selection based on element group label. 
 

4.5.2.9  Retained from file 

 

The final crop-type allows one to select element id’s from a file, Fig 4.5.24.  The user presses the 

Browse button to display the file selection dialog,  Fig 4.5.25.  This option is useful for re-

selecting elements that were selected during a previous import.  The .txt file is ASCII and 

contains a list of element ids; a range of ids is specified using a dash.  Fig 4.5.26 shows the 

selected elements that were identified in the .txt file. 
 

 

Figure 4.5.24  Retained from file cropping option. 

 
 

 

Figure 4.5.25  Retained element id file selection dialog. 
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Figure 4.5.26  Selection based on element ids provided in an ASCII .txt file. 

 

4.5.2.10  Crop, Undo and Redo 

 

The three buttons near the bottom on the left side perform the actual cropping.  Once the 

selection has been made using one of the options above, the selected elements are cropped by 

pressing the Crop button, Fig 4.5.27.  The un-selected elements are removed.  The user can 

Undo or Redo the cropping.  Multiple selections and crops can be performed in sequence. 

 

 

  

Figure 4.5.27  Crop button pressed to remove the un-selected elements. 

 

4.5.2.11  Reference Point 

 

The Reference Point button, next to the Crop/Undo/Redo buttons, allows you to specify a 

reference point, using either a node id or Cartesian coordinates, for the center of rotation, Fig 

4.5.28.  The reference point is displayed using a red dot.  Double-click the (reset)(d) camera 

position to reset to the default. 
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Figure 4.5.28  Reference Point dialog to set the rotation center. 
 

4.5.2.12  Show elems and Show outline 

 

The Show elems option at the bottom turns on or off the display of element edges, Fig 4.5.29.  

For some models, with many elements or with very refined meshes, the element edges can 

obscure the element selection.  Un-checking this box turns off the black element edge coloring, 

which should make the red-colored elements more visible.  The Show outline option is useful 

when selecting interior elements as it shows the exterior outline of the model. 

 

  

Figure 4.5.29  Show elems option. 
 

4.5.2.13  Show beam and shell elements for reference 

 

The Show beam and shell elements option at the bottom turns on or off the display of shell or 

beam elements, Fig 4.5.30.  Shell and beam elements cannot be selected; they automatically are 

added to the global portion of the model. 
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Figure 4.5.30  Show beam and shell elements option. 
 

 

4.5.3  Import Already Divided Model 

 

If the user has model files that have already been subdivided, the dialog shown in Fig 4.5.31 is 

displayed, which allows the user to select the global and local model files.  These can be files 

created by FRANC3D (as in Section 4.5.2) or can be files created by the user using the FE 

analysis software. There is no option to select “extra load files”; all load step information must 

already be included in the local and global FE files. 

 

 

 

Figure 4.5.31  Select Global and Local files dialog. 

 

 

4.6  Export… 
 

The File →Export menu item can be used to save the FE model data without saving the 

FRANC3D .fdb file.  The dialog shown in Fig 4.6.1 is presented; the user selects the analysis FE 

model type and enters the file name.  This option can be used to convert FE model files from one 

type to another.  FRANC3D now passes as much of the original FE data through as possible, 

thus it might only be the solid elements and nodes that are converted correctly. 
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Figure 4.6.1  Export Model File dialog. 

 

 

4.7  Read Results  
 

The File →Read Results menu item invokes the dialog shown in Fig 4.7.1, which allows the 

user to choose the analysis results file to be read.    

 

For ANSYS, the results file be a .dtp file that is created using the FRANC3D generated ANSYS 

macros.  The .dtp file will contain displacements, temperatures if those are not equal to the 

reference temperature and contact pressures on crack surfaces if such exist.   

 

For ABAQUS, the results file will be a .dtp file, which is created using the FRANC3D generated 

ABAQUS Python script.  The .dtp file will contain displacements, temperatures if those are not 

equal to the reference temperature and contact pressures on crack surfaces if such exist.   

 

For NASTRAN, displacement results will be contained in a NASTRAN generated .pch file.  

Temperatures and contact pressures are not included in the .pch file.  Temperatures are based on 

the applied temperatures.  Contact pressures are not available, so NASTRAN users should not 

rely on M-integral or VCCT SIFs if crack face contact is included in the analysis. 

 

The Do Map Results option is on by default.  A user can turn it off if they have manually 

combined the ANSYS local and global .cdb files in ANSYS WorkBench to run the analysis.  

This is the only known use-case for turning off the mapping.  FRANC3D stores the node and 
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element ID mapping for the local cracked mesh in the .fdb file, and the FE analysis results are 

mapped back into FRANC3D based on this mapping. 

 

 

 

Figure 4.7.1  Read results file dialog. 

 

 

4.8  Playback…. 
 

The File →Playback menu item allows playback of recorded session (log) files.  Each time the 

FRANC3D program is executed, a session##.log file is saved.  This file records the commands 

that the user executes using the menus and dialogs.  A sample .log file might look like this: 

 
OpenMeshModel ( 

    model_type=ANSYS, 

    file_name='C:\cube\cube.cdb', 

    retained_nodes_file=`cube_RETAINED.txt' 

) 

 

InsertFileFlaw ( 

    file_name='C:\cube\cube_05.crk') 

 

RunAnsysAnalysis ( 

    file_name='C:\cube\cracked_cube', 

    flags=[QUADRATIC], 

    executable='C:\ANSYS Inc\v121\ansys\bin\WINX64\ANSYS150.exe', 

    command='"C:\ANSYS Inc\v121\ansys\bin\WINX64\ANSYS150.exe" -b -p  

       struct -i "C:\cube\cracked_cube.macro" -o "C:\cube\cracked_cube.out"', 

    license=struct) 
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ComputeSif ( 

    do_press_terms=true) 

 

CloseModel() 

 

 

A complete description of the FRANC3D command language is provided in the FRANC3D 

Command Language & Python Extensions document.   

 

Selecting the Playback menu item invokes the Playback Session File dialog, Fig 4.8.1.  The 

user selects the desired session file and then presses Accept.  FRANC3D will read and execute 

the commands from the session file. 

 

 

 

Figure 4.8.1  Playback session file selection dialog. 

 

 

The Fatigue menu options currently do not support session log commands.  

 

 

4.9  Quit - Ctrl-Q 
 

The File Quit menu item exits FRANC3D.  The Save Model Warning dialog (see Fig 4.3.1) 

will be displayed if the model has not been saved. 
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5.  Edit Menu Wizards and Dialog Boxes  
 

The wizards and dialog boxes for the Edit menu options are described in this section.  

 

5.1  Unit Conversion… 
 

Selecting the Edit →Unit Conversion menu item invokes the Model Units dialog, which allows 

one to set the FE model units for length, stress, temperature and time, Fig 5.1.1.  The units are 

used to label plots, and they are important when defining the crack growth model where 

additional material data is entered that is not typically part of the FE model.  The original FE 

units can be set whenever you import a new model, but the display units will be based on your 

choice here. 

 

FRANC3D will do unit conversions when matching the crack growth material data with the FE 

model results to compute crack growth or fatigue cycles.  

 

 

 

Figure 5.1.1  Model Units dialog. 

 

 

If you consistently use the same set of units, those can be set in the Preferences, which is 

described in the next section. 

 

 

5.2  Preferences… 
 

Selecting the Edit →Preferences menu item invokes the Preferences dialog, which allows one 

to set program-wide configurations, Fig 5.2.1.  These preferences are stored in a database that is 

read when FRANC3D is started.  Some settings might not take effect until the program is 
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restarted, so if you change settings, it is best to quit and restart.  The Preferences dialog has ten 

tabs, which are described next. 

 

 

 

Figure 5.2.1  Preferences dialog with General tab displayed.  

 

 

5.2.1  General 1 Tab 

 

In the General 1 tab, one can set the default work and help file directories (see Fig 5.2.1) and 

other generic settings.  

 

The Fallback directory is the folder where the model files will be read from and written to by 

default if a work directory is not set or if it is invalid.  The work directory should be set using 

File →Work Directory. 

 

The Help File directory is the top-level directory for the documentation, described in Section 3.1.  

Documentation is accessed from the Help menu.  

 

The Suppress directory… option might be needed by users that must access network-mounted 

drives/directories.  If you find that FRANC3D is taking significant amounts of time to list 

files/folders when opening/saving, try turning this option on. 
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The Double size graphics… option might be needed by users with a very high-resolution display.  

Turning this on will double the size of the graphics, so the user might have issues displaying 

dialogs or plots for standard resolution displays. 

 

The Available FE Input check box allows one to turn off GUI support for a FE program.  For 

example, if you will only be using ABAQUS, turn off ANSYS and NASTRAN to limit the 

options when importing/saving/analyzing. 

 

The Default FE Input radio button sets the user’s default FE model type for importing a new 

model (see Section 4.5).  For example , if you have both ANSYS and ABAQUS but mostly use 

ABAQUS, you can set the default to ABAQUS to simplify import and analysis. 

 

The FE Input Checks option allows a user to check the FE model for potential errors/issues when 

importing.  Turning this option on will alter the import dialog by adding an extra option, Fig 

5.2.2.  Press the Choose Checks button to turn on/off specific checks, Fig 5.2.3.  The options are 

described in Section 5.4 of the User’s Guide.  In general, one should not need to run these 

checks, but if there are errors during crack insertion/meshing, the user can check the input FE 

model for errors before sending a bug report. 

 

 

 

Figure 5.2.2  Import dialog with FE Input Checks turned on.  

 

 

Figure 5.2.3  FE input checks.  
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The Release license… option allows one to turn off the license-release during the FE analysis.  

Typically, before the FE analysis starts, FRANC3D will release its license so another instance of 

the software can be used.  If there are issues releasing and/or retrieving the license after the FE 

analysis has finished, this option can be turned off.  

 

The NASGRO user defined XML material… option allows one to specify an .xml file containing 

NASGRO material data.  An .xml file can be exported from NASGRO.  The file can be used 

during subcritical crack growth and fatigue life computations. 

 

 

5.2.2  General 2 Tab 

 

The General 2 tab, Fig 5.2.4, provides the option to disable the Fretting and Single Crystal 

menus.  Symmetry crack capabilities can be turned on/off.  There are additional settings for 

saving timing output and Python rerun scripts.  

 

 

 

Figure 5.2.4  General 2 preferences tab.  

 

 

There are two options for On exit send timing…; the first sends information to the terminal (or 

CMD) window and the second sends information to a timing.txt file.  If a user wants to 

understand where time is spent during a crack growth simulation, these options will provide 

insight.  
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The Turn on fretting menu… will make the Fretting menu available in the FRANC3D main 

menu.  If you do not use the fretting module, you can turn it off. 

 

The Turn on single crystal menu… will make the Single Crystal menu available in the 

FRANC3D main menu.  If you do not use the single crystal module, you can turn it off. 

 

The Turn on electrical menu… will make the Electrical menu available in the FRANC3D main 

menu.  If you do not use the electrical module, you can turn it off. 

 

The Generate Python rerun scripts is used to save Python scripts that are equivalent to the session 

log commands. 

 

The Turn on symmetry crack… turns on the option to “insert” symmetry surface cracks in the 

flaw insertion wizard; see Section 6.1. 

 

The Use old volume meshing algorithm… switches back to the prior volume meshing algorithm. 

 

 

5.2.3  Window Tab 

 

In the Window tab, one can set the font and colors used in the graphical user interface windows, 

Fig 5.2.5.  The GUI font Select button will pop up a dialog box that allows one to select from the 

available fonts, Fig 5.2.6.   

 

Clicking any of the color swatches (colored rectangles) will pop up a dialog box, Fig 5.2.7, 

which allows one to select a new color.   

 

The GUI Equation Display option lets one adjust the equation scaling and display.  Different 

graphics settings and monitors might display the equations or plot labels differently.  These 

settings might help improve the display. 

 

The Startup Window Size can be set by editing the width and height, or by selecting the Current 

button, which will measure the current window and then update the numbers.  

 

The Defaults button restores all values to default settings. 
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Figure 5.2.5  Window tab of Preferences dialog. 

 

 

 

Figure 5.2.6  Font selection dialog. 
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Figure 5.2.7  Color selection dialog. 

 

 

5.2.4  3D View Tab 

 

The 3D View tab is used to set the combinations of mouse buttons and keyboard keys that are 

used to invoke the view and select functions, Fig 5.2.8.  One should ensure that each function has 

a unique set of buttons and keys. The view manipulations are described in Section 2. 

 

 

 

Figure 5.2.8  3D View tab of Preferences dialog. 

 

 

The L, M, R and W correspond to the left, middle, right and wheel buttons of the mouse. Note 

that the Ctrl-key plus a left mouse button click provides a quick center of rotation selection. 
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The Defaults button (next to View Projection) restores all values to default settings.  Rotate, pan, 

zoom and the front and back clipping options were described in Section 2.1.  The Select option is 

used by the Flaw Editor (see Section 6.1.11). 

 

In addition, the color settings in the Window tab, there are additional 3D view colors that can be 

set.  Clicking any of the color swatches will pop up a dialog box (see Fig 5.2.7), which allows 

one to select a new color.  The line width can be set also; the default is 1, but this value can be 

increased for thicker lines.  The program can be restarted, or the model reread for these settings 

to take effect. 

 

The Defaults button (next to Line width) restores all view colors to the default settings. 

 

 

5.2.5  ANSYS Tab 

 

The ANSYS tab allows the user to set default ANSYS analysis parameters, Fig 5.2.9.  

Configuration details that do not change frequently, such as the path to the ANSYS executable 

and the license type can be set here.  These values will then appear as default values for every 

ANSYS analysis. 

 

Ansys Executable stores the path to the ANSYS executable program.  The Browse button will 

pop up a file browser that can be used to locate the program; Fig 5.2.9 shows the ANSYS 

executable for ANSYS 2021. 

 

License Type stores the ANSYS license type.   Many ANSYS license strings have been encoded 

here.  If you have a license string that is not included, you can add your string to the FRANC3D 

resource file.  There is a franc3D.ini (or .franc3d.rc for Linux) file in the user’s home folder.  

This file can be edited.  Look for the [f3d_ansys] block and change the license string: 
[f3d_ansys] 

executable="C:\\Program Files\\ANSYS Inc\\v192\\ansys\\bin\\winx64\\ANSYS192.exe" 

license=ansys 

 

Job Name allows one to specify an ANSYS ‘job’ name.   

 

Total and Database Memory options allow one to set the amount of memory that will be 

requested on the ANSYS command line (see ANSYS documentation for details). 

 

Number of Processors is self-explanatory. The Use mpi option can be turned on for HPC license 

installations and analyses. 

 

Add to command allows the user to add extra options to the ANSYS command line. 

 

Include full path in file names adds the path to any file name for the ANSYS analysis files 

written by FRANC3D.  Note that this option is usually needed if the analysis files are not all in 

the same folder. 
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Delete unnecessary analysis files allows FRANC3D to delete ANSYS analysis files that are not 

needed by FRANC3D.  The ANSYS .db and .rst file are not deleted so that one can use ANSYS 

to visualize the model and results.  Note however that these two files can be regenerated by 

rerunning the analysis. 

 

Output results allows one to limit the amount of output that is written to the .dtp file from 

ANSYS.  The default is to save results for all nodes of the local cracked submodel portion for the 

last substep of each load step. 

 

 

 

Figure 5.2.9  ANSYS tab of Preferences dialog. 

 

 

5.2.6  ABAQUS Tab 

 

The ABAQUS tab allows the user to set default ABAQUS analysis parameters, Fig 5.2.10.   

 

Abaqus Executable stores the path to the ABAQUS executable program.  The Browse button 

will pop up a file browser that can be used to locate the program.  For MSWindows, choose the 

abaqus.bat file from the ABAQUS Commands folder. 

 

Number of Processors is self-explanatory.  

 

Include full path in file names adds the path to any file name for the ABAQUS files written by 

FRANC3D.  Note that this option is usually needed if the analysis files are not all in the same 

folder. 
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Delete unnecessary analysis files allows FRANC3D to delete ABAQUS analysis files that are 

not needed by FRANC3D.  The ABAQUS .odb file is not deleted so that a user can use 

ABAQUS CAE to visualize the model and results.  Note that this file can be regenerated by re-

running the analysis.  

 

Ask: ‘Old job files exist. Overwrite? (y/n)’ disables the ABAQUS prompt. 

 

Output results allows one to limit the amount of output that is written to the .dtp file from 

ABAQUS. The default is to save results for all nodes of the local cracked submodel portion for 

the last frame (substep) of each load step. 

 

 

 

Figure 5.2.10  ABAQUS tab of Preferences dialog. 

 

 

5.2.7  NASTRAN Tab 

 

The NASTRAN tab allows the user to set default NASTRAN analysis parameters, Fig 5.2.11.   

 

NASTRAN Executable stores the path to the NASTRAN executable program.  The Browse 

button will pop up a file browser that can be used to locate the program.  

 

Crack front elements allows one to choose quarter-point or mid-side node locations for the crack 

front wedge elements. Mid-side nodes might be required for NX NASTRAN. 
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Include full path in file names adds the path to any file name for the NASTRAN files written by 

FRANC3D. Note that this option is usually needed if the analysis files are not all in the same 

folder. 

 

Delete unnecessary analysis files allows FRANC3D to delete NASTRAN analysis files that are 

not needed by FRANC3D. 

 

 

 

Figure 5.2.11  NASTRAN tab of Preferences dialog. 

 

 

5.2.8  Meshing Tab 

 

The Meshing tab allows the user to set default meshing parameters, Fig 5.2.12.  The options are 

listed here.  

 

Max volume elements sets a limit on the number of volume elements FRANC3D can generate. 

 

Max backtrack restarts sets a limit on the number of FRANC3D volume meshing attempts.  If 

the volume meshing gets stuck, the program will backtrack and restarts. 

 

Do coarsen crack mouth turns on/off the mesh coarsening along the crack mouth. For shallow 

cracks or for cases where the user wishes to have a higher mesh density, this box can be 

unchecked.  The higher surface mesh density will result in a higher volume mesh density. 

 

Do crack proximity refinement turns on/off the local surface mesh refinement for surfaces near 

the crack. 
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Do not coarsen more than uncracked mesh turns on/off the option to define the new surface mesh 

density based on the original surface mesh.  In some cases, the default meshing algorithm creates 

a surface mesh that is too coarse to capture curved geometry features.  Turning this option on 

produces a surface mesh that is more like the original uncracked surface mesh density. Further 

details can be found in Section 6.1.21. 

 

Volume mesh using allows the user to choose between FRANC3D, ANSYS and ABAQUS 

volume meshing.  Note that the Max volume elements and Max backtrack restarts only applies to 

FRANC3D volume meshing. 

 

ANSYS or ABAQUS volume meshing:  write files only allows the user to write the surface mesh 

and the commands to generate the volume mesh from the surface mesh to files without running 

ANSYS or ABAQUS.  This gives the user the option of sending the files to a different computer 

or modifying the commands.  During the meshing phase of crack insertion, FRANC3D will 

prompt the user to save the surface mesh files, and then wait for the volume mesh file.  

 

 

Figure 5.2.12  Meshing tab of Preferences dialog. 

 

5.2.9  Advanced Meshing Tab 

 

The Advanced Meshing tab allows the user to set default advanced meshing parameters, Fig 

5.2.13.  The options are described in the dialog and are described more fully in the FRANC3D 

Users Guide. The volume meshing algorithm is described in journal articles; for example: 

 
  An Algorithm for Three-Dimensional Mesh Generation for Arbitrary Regions with Cracks,  

  Cavalcante et al., Engineering with Computers (2001) 17: 75–91. 
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Figure 5.2.13  Advanced Meshing tab of Preferences dialog. 

 

 

A brief description of each field is provided in the dialog.  Decreasing the values will usually 

increase the mesh density. 

 

 

5.2.10  Units Tab 

 

The Units tab allows the user to set default units for the FE model and for display, Fig 5.2.14.  

The options are the same as for Edit →Unit Conversion; there is an extra option for changing 

the label for the number of passes through the load schedule.  The passes are displayed in the 

Fatigue Life dialog (see Section 9). 

 

The FEM and display units can be overridden when importing a new FE model or when 

displaying results.   
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Figure 5.2.14  Units tab of Preferences dialog. 

 

 

 

6.  Cracks Menu Wizards and Dialog Boxes 
 

The wizards and dialog boxes for the Cracks menu options are described in this section.  

 

The process of crack insertion (either the initial crack or subsequent steps of crack growth) 

requires geometric intersection of the crack surface with the model surface.  The geometry, for 

both, is defined using triangular Bezier patches; this is briefly described in the User’s Guide 

along with a summary of the geometric approach to crack extension.  Surface and volume 

meshing is constrained by this underlying geometry; this includes the crack front template mesh 

described in Section 6.1.14. 

 

 

6.1  New Flaw Wizard 
 

The New Flaw wizard leads the user through the process of creating and orienting a 

parametrically defined flaw.  This wizard contains several panels; however, normally one will 

not see all panels.  Choices in the panels determine which panels are shown next.  The overall 

flow is illustrated in Fig 6.1.1.  Note that the elliptical and through crack boxes house a couple of 

crack shapes. 
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The individual wizard panels are described below. 

 

 

Figure 6.1.1  New Flaw wizard flow diagram. 

 

 

6.1.1  Flaw type panel 

 

The first panel determines the flaw type, Fig 6.1.2; either a crack (zero volume flaw) or a void 

(finite volume flaw) can be inserted.   

 

There is also the option to save the flaw description to a file.  The default is to add the flaw to the 

model without saving to a (.crk) file.  The second radio button (Save to file and add flaw) allows 

the user to save the flaw to a file and add it to the model.  The third option (Save to file only) 

saves the flaw to a file without adding it to the model.  Note that you cannot add a flaw to a 

model that already has a flaw.  

 

The last two options provide support for interface and symmetry cracks.  If the user is inserting a 

crack that is embedded in a bi-material interface, this box should be checked.  The second option 

will only be displayed if symmetry cracks is turned on in the Preferences (see Section 5.2.2).  If 

the user is inserting a symmetry surface crack, this box should be checked.  

 

The crack types cannot be mixed; for example, you cannot insert a void and a crack into a model 

at the same time.  Multiple crack insertion is described in Section 6.3. 

 

 

Flaw Type

Finite volume voids Zero volume cracks

Elliptical Through User-defined

Translations and Rotations

Crack front template mesh
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Figure 6.1.2  New Flaw wizard first panel selects flaw type. 

 

 

 

6.1.2  Crack type panel 

 

The current crack (zero volume flaw) types include:  

 

1) elliptical crack with one crack front – top left icon in Fig 6.1.3,  

2) through-the-thickness crack with one front – bottom left icon,  

3) through-the-thickness crack with two fronts – top second from the left,  

4) long-shallow surface crack shape – bottom second from the left,  

5) elliptical crack shape with two fronts – top third from the left,  

6) long-shallow interior crack shape – bottom third from the left,  

7) curvilinear elliptical crack – top fourth from the left, 

8) user-defined crack – bottom fourth from the left, or  

9) user-defined-surface mesh crack – top right.  

 

The long shallow crack shapes can be used instead of long thin ellipses; they will produce better 

template elements at the ends of the major axis.  The crack fronts are indicated by the thicker 

lines.   

 

Selecting the crack shape icon determines the crack type that will be shown in the next panel, 

where the dimensions are set. 
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Figure 6.1.3  New Flaw Wizard crack (zero volume flaw) types. 

 

 

6.1.3  Elliptical crack panel 

 

Single front elliptical cracks are defined by entering the semi-axes lengths (a and b), Fig 6.1.4.  

Once values have been specified for the length of the axes, the ellipse is displayed in the 3D 

view window.  The ellipse is displayed in its local orientation, which is in the x-y plane and 

centered at the global Cartesian origin.   

 

The Advanced Geometry button allows one to add more boundary points, which might be 

needed for high aspect ratio ellipses.  The associated dialog is described in Section 6.1.12.  This 

button is available for all crack shapes except for the two user-defined cracks. 
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Figure 6.1.4  New Flaw Wizard elliptical crack parameters panel. 

 

 

6.1.4  Single-front Through-the-thickness crack panel 

 

Single-front through-the-thickness cracks are specified using three lengths (a – c) and the width 

(d), Fig 6.1.5.  If set appropriately, the three lengths can be used to define a straight or a 

quadratic shape crack front. The crack is displayed in its local orientation, which is in the x-y 

plane with one corner at the global Cartesian origin.   

 

 

 

Figure 6.1.5  New Flaw Wizard single-front through-crack parameters panel. 
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6.1.5  Two-front Through-the-thickness crack panel 

 

Two-front through-the-thickness center cracks are specified using six crack lengths (a – f) and 

the crack width (g), Fig 6.1.6.  If set appropriately, the six lengths can be used to define either 

straight or quadratic shape crack fronts. The crack is displayed in its local orientation, which is in 

the x-y plane with one mid-side at the global Cartesian origin. 

 

 

 

Figure 6.1.6  New Flaw Wizard two-front through-crack parameters panel. 

 

 

6.1.6  Long shallow surface crack panel 

 

Long-shallow-surface cracks are specified using the crack length (a), the crack width (b), and a 

corner radius (r), Fig 6.1.7.  This crack shape can be used in place of high-aspect ratio elliptical 

surface cracks. The crack is displayed in its local orientation, which is in the x-y plane with the 

global Cartesian origin as shown in Fig 6.1.7. 
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Figure 6.1.7  New Flaw Wizard long shallow surface crack parameters panel. 

 

 

6.1.7  Two-front Elliptical crack panel 

 

Two-front elliptical (ring) cracks are defined by entering the outer semi-axes lengths (a and b) 

and the inner semi-axes lengths (c and d).  The user also has the option of turning off the crack 

front for either the outer or inner front; this allows one to define a circumferential crack in the 

outer or inner wall of a pipe.   

 

Once values have been specified for the length of the axes, the ellipses are displayed in the 3D 

view window, Fig 6.1.8.  The ellipses are displayed in the local orientation, which is in the x-y 

plane and centered at the Cartesian origin.  Both outer axes must be larger than the inner axes to 

create a valid crack. 
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Figure 6.1.8  New Flaw Wizard two-front elliptical crack parameters panel. 

 

 

6.1.8  Long shallow interior crack panel 

 

Long-shallow-interior cracks are specified using the crack length (a), the crack corner radius (r), 

Fig 6.1.9.  This crack shape can be used in place of high-aspect ratio elliptical interior cracks. 

The crack is displayed in its local orientation, which is in the x-y plane with the global Cartesian 

origin as shown in Fig 6.1.9. 

 

 

 

Figure 6.1.9  New Flaw Wizard long shallow interior crack parameters panel. 
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6.1.9  Curvilinear elliptical crack panel 

 

Curvilinear elliptical cracks are specified by entering the semi-axes lengths (a and b) and the 

‘surface’ radius (r), Fig 6.1.10.  Once values have been specified for the length of the axes, the 

ellipse is displayed in the 3D view window.  The crack is displayed in its local orientation, which 

is in the x-y plane with the global Cartesian origin as shown in Fig 6.1.10. Note that there are 

limitations on the dimensions; you should not define a crack that has edges that overlap or 

intersect. 

 

 

 

Figure 6.1.10  New Flaw Wizard long shallow interior crack parameters panel. 

 

 

6.1.10  User-defined crack panel 

 

The user-defined crack requires a set of points that defines the crack boundary.  Click on 

View/Edit Points, Fig 6.1.11, to display a dialog that allows one to enter the geometry points, 

Fig 6.1.12.  The front column in Fig 6.1.12 allows one to define points as crack front points 

using a value of 1; non-front points be set to 0.  Note that unless one is defining an interior crack, 

there should be at least one point on the crack boundary that is not a crack front point.  The front 

points are displayed in blue and numbered corresponding to the listing shown in Fig 6.1.12.  

Points must be consecutive around the boundary. 

 

One can read the points from a file using the Read From File button.  The file should be a 

simple ASCII .txt file with the format:  

x     y    z    flag 

x     y    z    flag 

x     y    z    flag 
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The Smooth Front Points option in Fig 6.1.11 allows the user to smooth and re-parameterize the 

crack front points.  This allows for more uniform crack surface geometry.   

 

The boundary points are used with a surface triangulation algorithm to produce the interior crack 

surface geometry.  Enough non-front points should be defined to produce a reasonable 

triangulation of the interior region.  The Generate Non-Front button can be used to create non-

front points if none exist. 

 

Some non-planarity is possible; however, the user does not define crack-surface-interior points, 

therefore, this crack type works best for planar or near-planar cracks.  Note that the first and last 

point should not be repeated. 

 

 

 

Figure 6.1.11  New Flaw Wizard  user-defined crack panel. 

 

 

 

Figure 6.1.12  User-defined crack points dialog. 
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6.1.11  User-mesh crack panel 

 

The user-mesh crack allows one to convert a surface mesh into a crack.  Click on Read mesh 

File, Fig 6.1.13, to display the file selector dialog, Fig 6.1.14.  FRANC3D can read ABAQUS 

(.inp), ANSYS (.cdb) and NASTRAN (.bdf) files containing planar or shell elements.  The file 

should contain a node “set” that defines the nodes that form the crack front, Fig 6.1.15.  After 

selecting the front node set, select Accept, and the surface will be displayed, Fig 6.1.16.   

 

 

  

Figure 6.1.13  New Flaw Wizard  user-mesh crack panel. 

 

 

 

Figure 6.1.14  User-mesh crack mesh file dialog 
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Figure 6.1.15  User-mesh crack front component (or node set) 

 

 

 

Figure 6.1.16  User-mesh crack surface. 

 

 

In addition to the surface mesh files, FRANC3D can also import STL files. If the File type in Fig 

6.1.14 is set to .stl, then the Extra front file check box is activated.  STL files contain a collection 

of triangles.  The extra front file allows the user to specify the vertex coordinates for the crack 

front edge.  The extra file is a simple ASCII txt file with lines of:  x  y  z.  FRANC3D will 

compare the data in the front file with the STL file to obtain the crack front vertices and edges. 

 

The scale factor field, in Fig 6.1.16, allows one to scale the user-mesh crack.  This can be 

especially useful for STL files that are saved using units of meters when the model is in 

millimeters. 

 

Chapter 6 of the User’s Guide provides additional information for user-defined crack shapes. 
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6.1.12  Advanced Geometry button 

 

Selecting the Advanced Geometry button on the predefined crack shapes (where it exists) leads 

to the dialog shown in Fig 6.1.17.  The crack shape shown here corresponds to an ellipse with 

equal major and minor axes.  Note that the triangular facets represent the geometry, not a finite 

element surface mesh. 

 

There are three buttons on the top menu bar: Refine, Reset and Edit.  The crack geometry is 

shown in the window.  The menu options are described below.  Note that some flaw shapes will 

not include the Edit button. 

 

 

 

Figure 6.1.17  Crack Advanced Geometry dialog. 

 

6.1.12.1  Refine 

 

The Refine button alters the discretization of the crack surface geometry.  Although cracks 

notionally have an analytical geometry (e.g., elliptical or quadratic), they are defined 

geometrically by triangular cubic-Bezier patches.  These patches only approximate the analytical 

form.  As the number of geometry patches is increased, the approximation improves, but at the 

cost of additional processing time required to insert the crack.  The Refine button performs a 

uniform refinement of the patches, where each patch is divided into four smaller patches.  This is 

illustrated in the images in Fig 6.1.18.  The Refine process can be repeated any number of times.   

 

Refinement might be required for high-aspect ratio elliptical cracks, specifically for the ends of 

the major axis. 
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Figure 6.1.18  Example of a Refined crack geometry.  The left panel shows one level of 

refinement from Fig 6.1.17, and the right panel shows a second level of refinement. 

 

6.1.12.2  Reset 

 

The Reset button sets the crack geometry back to the original default configuration. 

6.1.12.3  Edit 

 

The Edit button invokes the Flaw Editor, Fig 6.1.19.  This dialog allows the user to redefine the 

default shape of the flaw.  The vertices (black circles in Fig 6.1.19) can be selected by holding 

down the Shift-key and selecting the black circle with the left-mouse button.  The vertices turn 

red when they are selected (see right panel of Fig 6.1.19).  The red circle can be moved by 

holding down the Shift-key and dragging the item to the new location using the left mouse 

button.  The x and y coordinates of the vertex are shown in the fields near the top of the dialog.  

 

Unselect the vertex by holding the Shift-key down and picking a point that is not close to any 

vertex. The undo and redo icons (to the left of the coordinate fields) allow the user to undo (or 

redo) any movement of the vertices that is not desired. 

 

Select Accept and the revised flaw shape will be shown in the initial Advanced Geometry 

window (Fig 6.1.17).   

 

Select Accept in the Advanced Geometry window to return to the regular flaw insertion wizard 

panel.  The user can then proceed to locate and orient the edited flaw in the model. 

 

Note that the flaw editor must be used before rotating and translating the flaw.  
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Figure 6.1.19  Flaw Editor - left panel shows initial and right panel shows edited geometry. 

 

 

6.1.13  Void type panel 

 

The current void (finite volume flaw) types include:  

 

1) ellipsoid – top left icon in Fig 6.1.20,  

2) thick ellipse – top middle, 

3) thick through-thickness with two fronts – top right,  

4) thick through-thickness with one front – bottom left,  

5) thick long-shallow surface – bottom middle, and 

6) thick curvilinear ellipse – bottom right. 

7) user-defined-volume mesh crack – top right.  
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Figure 6.1.20  New Flaw Wizard void (finite volume flaw) types. 

 

 

6.1.14  Ellipsoid panel 

 

Ellipsoidal voids are defined by entering the three semi-axes lengths (a, b, and c), Fig 6.1.21. The 

void is displayed in the local orientation and centered at the Cartesian origin.  There are no 

“front” edges identified for an ellipsoid. 

 

 

 

Figure 6.1.21  New Flaw Wizard ellipsoidal void parameters panel. 
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6.1.15  Thick (flat) elliptical void panel 

 

Single front thick (or finite volume) ellipse voids are defined by entering the semi-axes lengths 

(a and b) and the thickness, Fig 6.1.22.  Once values have been specified, the thick ellipse is 

displayed in the 3D view window.  It is displayed in its local orientation, which is in the x-y 

plane and centered at the global Cartesian origin.   

 

The Advanced Geometry button is available but might be difficult to use with this shape. 

 

 

 

Figure 6.1.22  New Flaw Wizard elliptical crack parameters panel. 

 

 

6.1.16  Two-front Through-thickness void panel 

 

Two-front through-thickness voids are specified using six crack lengths (a – f), the crack width 

(g) and the thickness, Fig 6.1.23.  If set appropriately, the six lengths can be used to define either 

straight or quadratic shape crack fronts. The crack is displayed in its local orientation, which is in 

the x-y plane with one mid-side at the global Cartesian origin.  
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Figure 6.1.23  New Flaw Wizard two-front through-crack parameters panel. 

 

6.1.17  Single-front Through-thickness void panel 

 

Single-front through-thickness voids are specified using three lengths (a – c), the width (d) and 

the thickness, Fig 6.1.24.  If set appropriately, the three lengths can be used to define a straight or 

a quadratic shape crack front. The crack is displayed in its local orientation, which is in the x-y 

plane with one corner at the global Cartesian origin.   

 

 

 

Figure 6.1.24  New Flaw Wizard single-front through-crack parameters panel. 
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6.1.18  Long shallow surface void panel 

 

Long-shallow-surface voids are specified using the crack length (a), the crack width (b), a corner 

radius (r) and the thickness, Fig 6.1.25.  The crack is displayed in its local orientation, which is 

in the x-y plane with the global Cartesian origin as shown in Fig 6.1.25. 

 

 

 

Figure 6.1.25  New Flaw Wizard long shallow surface crack parameters panel. 

 

 

6.1.19  Curvilinear elliptical void panel 

 

Curvilinear elliptical voids are specified by entering the semi-axes lengths (a and b), the 

‘surface’ radius (r) and the thickness, Fig 6.1.26.  The crack is displayed in its local orientation, 

which is in the x-y plane with the global Cartesian origin as shown in Fig 6.1.26. Note that there 

are limitations on the dimensions; you should not define a void that has edges that overlap or 

intersect. 
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Figure 6.1.26  New Flaw Wizard long shallow interior crack parameters panel. 

 

 

6.1.20  User-mesh void panel 

 

User-mesh voids are added by importing a volume mesh.  Click on Read mesh File, Fig 6.1.27, 

to display the file selector dialog, Fig 6.1.29.  FRANC3D can read ABAQUS (.inp), ANSYS 

(.cdb) and NASTRAN (.bdf) files containing volume elements.  A cylinder model is selected, Fig 

6.1.29, and will be inserted into a cube to create a cylindrical void. 

 

 

  

Figure 6.1.27  New Flaw Wizard  user-mesh crack panel. 
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Figure 6.1.28  User-mesh void file dialog 

 

 

Figure 6.1.29  Cylinder volume mesh 

 

 

The void can be translated into position relative to the model, Fig 6.1.30.  The resulting model 

surface mesh is shown in Fig 6.1.31. 
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Figure 6.1.30  Cylinder volume mesh 

 

 

Figure 6.1.31  Cylinder volume mesh 
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6.1.21  Symmetry crack surface select panel 

 

If a user checks the Symmetry surface crack box (see Fig 6.1.2), an extra dialog is displayed 

prior to selecting the crack type, Fig 6.1.32.  Surfaces with symmetry boundary conditions are 

displayed in blue.  The user should choose the symmetry surface using the Shift key and the left 

mouse button (assuming default mouse settings are used).  Click Next to continue defining the 

crack. 

 

 

Figure 6.1.32  User-mesh crack mesh file dialog 

 

6.1.22  Flaw translation and rotation panel 

 

Once a flaw (crack or void) is defined, it must be inserted (translated and rotated) into the proper 

location relative to the unflawed body.  The flaw orientation panel displays the flaw and the 

model in a 3D graphics window, along with controls to translate and rotate the flaw, Fig 6.1.33.  

Translations and rotations can be specified in the global or a local coordinate system. 

 

The translations move the origin of the flaw.  It is usually simpler to specify translations and then 

"zoom in" on the display of the flaw before specifying the rotations. 

 

Up to three rotations about the (rotated) Cartesian axes can be specified.  These are Euler angles, 

but the order of the rotation axes can be specified.  The rotations follow a "right-hand-rule" 

where the thumb points in the positive direction along the axis and the fingers curl in the positive 

rotation direction. 

 

The Define Local Axes button allows the user to specify a local Cartesian system to aid in 

placing the flaw; this is described in the next sub-section.  The adjacent Reset button clears any 

local coordinate system and resets the original default crack translation and rotation. 
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The Display panel on the right side has two additional options to display the local axes and the 

crack axes. 

 

 

 

Figure 6.1.33  New Flaw Wizard orientation panel. 

 

6.1.22.1  Define Local Axes 

 

The Define Local Axes button displays a dialog, Fig 6.1.34, that allows one to specify a local 

Cartesian coordinate system.  See Section 6.5 of the User’s Guide for additional details on flaw 

placement and local axes. 

 

The Anchor at node normal to surface option allows one to specify a node ID, which will define 

the crack local origin.  The model surface-normal defines the crack plane.  

 

The Anchor at point normal to surface is like the previous option, but the user must specify the 

global Cartesian coordinates of the point on the surface. 

 

The Define by three nodes option allows one to specify three node IDs to define the origin and 

crack plane. 

 

The Define by three points option is like the previous option, but the user must specify the global 

Cartesian coordinates of the three points. 

 

The Define by angles option is allows the user to specify the global Cartesian origin and three 

rotations. 
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Figure 6.1.34  New Flaw Wizard orientation vectors dialog. 

 

 

6.1.23  Crack Front Mesh Template Panel 

 

For accurate stress-intensity factor computations, a pattern or "template" of elements with 

controlled sizes and shapes is placed about all crack fronts.  The template takes the form of 

generalized cylindrical tubes of elements with the crack fronts serving as the axes of the 

cylinders.  Wedge shaped elements are placed immediately adjacent to the crack fronts.  These 

are surrounded by rings of brick elements, Fig 6.1.35. 
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Figure 6.1.35  Crack front mesh element types. 
 

 

Fig 6.1.36 shows the Crack Front Mesh Template wizard panel with an elliptical surface crack 

being inserted into a cube.  The user can turn off the crack front template elements with the use 

crack-front template toggle.  In some cases, a crack front template mesh cannot be added to the 

model; a crack front that touches or crosses a material boundary currently is one such case.  

 

The overall radius of the template can be adjusted with the Template Radius field.  The default 

value of the radius is based on a notion of the crack size, but it can be inappropriate in some 

cases.  In addition, the template radius can be decreased if a user wishes to do a mesh 

refinement/convergence study.  

 

The template elements are displayed in the 3D graphics window superimposed on the flaw and 

model geometry.  By default, only one half of the template elements are shown.  This allows one 

to view the progression of element sizes as the elements transition from the crack front to the 

outer boundary of the template.  One can view the full template by turning on the Display Full 

Template toggle. 

 

The Simple Template Intersections Only toggle allows the user to terminate the template inside 

the model surfaces.  For cases where the template will intersect the model surface at shallow 

angles or at corners, Fig 6.1.37, this option allows a crack to be inserted with template elements 

along the bulk of the crack front, Fig 6.1.38.  FRANC3D attempts to recognize instances where 

the template will intersect model surfaces at poor angles and automatically triggers this option as 

needed. 

 

The Meshing Parameters button at the bottom left is used to specify surface and volume 

meshing parameters as well as choosing the volume mesher (see Section 6.1.21.1).  The 

Advanced Options button allows the user to adjust the template elements (see Section 6.1.21.2). 

 

quarter-point singular wedge 

crack-front elements

two or more “rings” of 

brick elements

pyramids provide compatibility 

between bricks and tetrahedra

tetrahedral elements used 

for most of volume mesh
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Figure 6.1.36  Crack front mesh template panel. 

 

 

Note that this panel is displayed even if the flaw does not have any crack fronts (e.g., an 

elliptical void).  In this case, simply ignore this panel and select finish. 

 

 

 

 

Figure 6.1.37  Crack front mesh template intersecting model surface at an angle. 
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Figure 6.1.38  Crack front mesh template pulled back from the model surface. 
 

 

6.1.23.1  Meshing Parameters Dialog 

 

The Meshing Parameters dialog, Fig 6.1.39, was shown in the Preferences meshing tab 

described in Section 5.4.8.  The user can control aspects of the surface and volume meshing. 

Section 7 of the User’s Guide provides additional information. 

 

The first parameter, Maximum Generated Elements, limits the total number of volume elements 

that FRANC3D will create during volume meshing. The second parameter, Maximum Volume 

Mesh Restarts, limits the number of volume meshing restarts.  These two options only work 

when FRANC3D is used for volume mesh.  FRANC3D uses an advancing front volume meshing 

algorithm; this algorithm can get stuck sometimes and the algorithm is designed to backtrack 

(i.e., remove elements) and restart the meshing.  If the program fails to create a volume mesh 

after several restarts, then one can try volume meshing with ANSYS or ABAQUS. 

 

The next two options allow the user to control surface mesh refinement: on the crack surface, 

using the Do coarsen crack mouth mesh option, and on the model surface in areas where adjacent 

region boundaries are near, using Do crack proximity refinement.  The effect of the Do coarsen 

crack mouth mesh option is shown in Fig 6.1.40. 

 

The Do not coarsen more than uncracked mesh option modifies the surface meshing algorithm to 

respect the original surface mesh density.  Fig 6.1.41 shows an example where the option is 

turned off (left panel) and then turned on (right panel). 

 

FRANC3D, by default, is used to mesh the volume, but ANSYS and ABAQUS can also be used 

by selecting the appropriate radio button for Volume mesh using...  Note that the user must have 

a licensed working copy of these programs to use their meshing algorithms.  The user can select 

the ANSYS and ABAQUS executables, using the Browse button, if not already set in the 

Preferences (see Section 5.4). 
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For ANSYS or ABAQUS:  write files only allows the user to write the surface mesh and the 

commands to generate the volume mesh from the surface mesh to files, without running ANSYS 

or ABAQUS.  This gives the user the option of sending the files to a different computer or 

modifying the commands.   

 

 

 

 

Figure 6.1.39  Meshing parameters dialog. 

 

 

 

 

Figure 6.1.40  Effects of Do coarsen crack mouth option: on – left panel and off – right panel. 
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Figure 6.1.41  Effects of Do not coarsen more than uncracked mesh option: off – left panel and 

on – right panel. 

 

 

6.1.23.2  Advanced Template Options Dialog 

 

The Advanced Template Options dialog allows the user to adjust the default crack front mesh 

template parameters, Fig 6.1.42.  The parameters are described below and illustrated in Fig 

6.1.43, which shows a typical cross-section of a crack-front template. Section 7 of the User’s 

Guide provides additional information. 

 

Progression Ratio sets the relative width of the element (in the direction perpendicular to the 

crack front) going from the crack front to the outer surface of the template.  For example, a ratio 

of 1 means that all the rings of elements will have the same width.  For a ratio of 1.5, the width 

of the elements in a ring will be 50% greater than the width of the elements in the next ring as we 

approach the crack front. 

 

Num Rings sets the number of rings of elements in the template. 

 

Num Circumferential Elem sets the number of elements in the circumferential direction around 

the crack front. 

 

Max Aspect Ratio controls the aspect ratio of the quadrilateral faces on the outer surface of the 

template that will trigger 1:2 or 1:3 transitions in the outer ring of elements.  
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Figure 6.1.42  Advanced template options dialog. 

 

 

 

 

 

Figure 6.1.43  Crack front template cross-section. 

 

 

 

 

6.1.24 Flaw Insertion 

 

After selecting Finish on the crack front mesh template panel (see Fig 6.1.39), the flaw is 

inserted into the body and the model is remeshed.  An information box is displayed to give the 

status of operations, Fig 6.1.44.  The crack geometry is inserted into the model geometry first, 

represented by the Doing geometric intersections... status.  Once the crack geometry has been 

inserted, trimmed, and tied to the model geometry, surface and then volume meshing occurs.  If 

using the FRANC3D volume meshing, the final volume mesh is smoothed to improve the 

element quality. 

 

first ring

second ring

third ring

first ring
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third ring
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Figure 6.1.44  Flaw Insertion Status dialog. 

 

 

 

6.2   Flaw from Files 
 

The user has the option of saving the flaw to a .crk file when defining a new flaw (see Fig 6.1.2).  

The Flaw from Files menu option allows the user to read one or more .crk files and insert these 

crack(s) into the model.  The Locate .crk flaw file dialog, Fig 6.2.1, is displayed, which allows 

the user to select one or more .crk files.  Use the Ctrl or Shift-key to select multiple files. After 

selecting Accept, the flaw is displayed within the model, Fig 6.2.2.  A flaw can be translated, but 

rotation is not allowed.  

 

Select Next to define the crack front template mesh; this was described in Section 6.1.21. 

 

The .crk file contains the triangular Bezier patches that defined the surface and a description of 

the crack front vertices.  It also contains crack front template meshing parameters.  This data is 

also stored in the FRANC3D restart .fdb file.  As the crack grows, new geometry is added, and 

this information is saved in the .fdb file.  If needed, the FLAWSURF block of the .fdb file can be 

extracted and saved as a .crk file (see Section 4.1.1). 
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Figure 6.2.1  Locate flaw file dialog. 

 

 

 

Figure 6.2.2  Orient a flaw-from-file dialog; only translation is allowed. 
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6.3  Multiple Flaw Insert 
 

The Multiple Flaw Insertion wizard, Fig 6.3.1, allows one to add multiple cracks to a model.  

The user defines each crack using the Flaw Insertion wizard panels, which are described in 

Section 6.1.  When all cracks have been defined, they can be added to the model and/or saved to 

a file.  

 

The user starts by selecting the Add button in the dialog shown in Fig 6.3.1.  This leads to the 

flaw insertion wizard panels.  Either cracks or voids can be added.  

 

Once a flaw has been added to the list, it can be edited or deleted by selecting the flaw name and 

then selecting the Edit or Delete button.  All the added flaws can be displayed in the model, Fig 

6.3.2, to ensure that they do not overlap or intersect; select the Display button to show this 

dialog.  Select the Finish button to return to the Multiple Crack Definition dialog. 

 

The set of radio buttons at the bottom of the dialog in Fig 6.3.1 allows one to: 1) add the flaws to 

the model without saving to a file, 2) add the flaws to the model after prompting for a file name 

to save a .crk file, or 3) save the flaws to a file without adding them to the model.   

 

If the flaws are just being added, select Accept to close the dialog and begin the process of crack 

insertion and re-meshing.  The flaw insertion status window as described in Section 6.1.22 is 

displayed.  If the flaws will be saved to a file, the Save File dialog is presented before the crack 

insertion process starts. 

 

Note that mixing of crack types is not currently supported; for example, you cannot add a 

symmetry crack and a regular crack at the same time.  Multiple symmetry cracks can be inserted 

if the cracks fall on the same surface; multiple symmetry cracks on multiple planes will not have 

the correct boundary conditions mapped onto the new mesh.  

 

 

  

Figure 6.3.1  Multiple flaw insertion - top level dialog. 
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Figure 6.3.2  Multiple flaw insertion – flaw display window. 

 

 

 

6.4  Compute SIFs  
 

The user can compute and plot the stress intensity factors (SIFs) after performing an analysis of 

the cracked model; the Analysis menu is described in Section 8.   

 

SIFs are computed at mid-side nodes along the crack front. 

 

 

6.4.1  M-integral, Displacement Correlation or Virtual Crack Closure Panel 

 

The Compute SIFs menu option brings up the Compute SIFs dialog box, Fig 6.4.1.  Either the 

M-integral, Displacement Correlation (DC) or Virtual Crack Closure (VCCT) method can be 

chosen to compute the SIFs.  The M-integral method1 is usually the most accurate.  The DC 

option can be used to check the M-integral values.  For models where a crack front template 

cannot be added, displacement correlation currently is the only option.  The VCCT method was 

implemented for cracks in material interfaces.  

 

 
1 Banks-Sills et al, EFM 74, p 1293-1307. 
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Note that if you switch SIF computation method, that method will continue to be used until you 

switch back.  If you use the DC method to check the SIFs, you should recompute SIFs with the 

M-integral before growing the crack – if you want to use the M-integral SIFs. 

 

The Plot Stress Intensity Factors option turns on/off the display of the SIF plot dialog, which is 

described in Section 6.4.1.1. 

 

 

 

Figure 6.4.1  Compute SIFs panel allows one to choose either M-integral, DC or VCCT. 

 

 

The (M-integral and VCCT) Advanced buttons display the dialog in Fig 6.4.2a. The fields in the 

dialog are described below. 

 

 

Figure 6.4.2a  Compute SIFs M-Integral and VCCT Advanced Parameters dialog 

 

 

Include Thermal Terms:  Thermal terms can be included in the M-integral computation.  The 

nodal temperatures should exist in the results database and the user should supply the reference 

temperature if not already given with the initial FE input file.  This option should be checked 

automatically if there are temperatures. 
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Include Applied Crack Traction:  Any applied crack face traction/pressure terms should be 

included in the M-integral. This should be checked automatically if crack face traction exists. 

 

Include Contact Crack Pressure:  Any induced crack face contact pressure should be included in 

the M-integral. The contact pressure results should exist in the results file. This option should be 

checked automatically if there are contact pressure results. 

 

Note that it is possible to have both applied pressure and contact pressure on a crack surface and 

these terms will be summed.  

 

Large Rotations:  The local crack front coordinate system is defined based on the deformed 

configuration if this option is checked; this is required if there are large rigid body rotations.  

This option is not set automatically. 

 

Elastic Plastic J:  The elastic plastic J-integral values will be computed. 

 

 

The Displacement Correlation Advanced button displays the dialog in Fig 6.4.2b.  The user can 

choose to compute SIFs at element corner or midside nodes along the front. This should be 

automatically set correctly based on the crack front mesh. 

 

 

Figure 6.4.2b  Compute SIFs Displacement Correlation Advanced Parameters dialog 

 

 

 

6.4.2  SIF Plot Panel 

 

Stress-intensity factor distributions are displayed in this dialog, Fig 6.4.3.  The left side of the 

dialog is a 3D graphics window that displays the crack in model.  The right side of the dialog is a 

tab box that shows graphs of the computed stress-intensity factor (SIF) distributions along the 

crack front.  The mode I, II, and III SIFs are represented by the KI, KII and KIII tabs, 

respectively.   
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Figure 6.4.3  SIF plot panel. 

 

 

The J-integral tab displays a plot of the total (elastic) J-integral distribution (total energy release 

rate not segregated into modal components).  J-integral values from M-integral and 

Displacement Correlation will be slightly different as the computations are done differently.  The 

T-Str tab displays a plot of the T-stress.  The Table tab shows a table of the SIF values along 

with the parametric location along the crack front (N Coord); the crack front length is normalized 

from 0 to 1, going from A to B (shown in the window on the left). 

 

The Export tab allows one to export the SIF data to a file, Fig 6.4.4.  The user can specify the 

type of delimiters to use, the grouping of the data, and order of the data.  The program initially 

assigns one end of the crack front as A and the other end as B.  The data is plotted along the 

crack front, normalized by the crack front length, starting from point A.  Use the Create File 

button to select the file name and save the data. 

 

   

Figure 6.4.4  SIF table tab (left panel) and export tab (right panel). 
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The dialog shown in Fig 6.4.3 includes options to display SIF data for a model with multiple 

load steps (and substeps), multiple crack fronts, and multiple crack growth steps.  The drop-

down boxes above the tabs provide these options, Fig 6.4.5.  

 

                                    

Figure 6.4.5  SIF display drop-down selections for load step, crack front and crack growth step. 

 

 

6.4.2.1 SIF Plot menu bar 

 

The menu bar at the top left contains three entries:  File, Data and Axes.  These are described 

here.  The same menu appears in other dialog panels with XY plots. 

 

The File menu is shown in Fig 6.4.6.  The Export as .png… and Export as .jpg… options both 

present the standard FRANC3D File Save As dialog (see Section 4.4).  One can save either .png 

or .jpg images of the XY plot.  The Close option closes the SIF display. 

 

 

 

Figure 6.4.6  SIF display panel File menu. 
 
 

The Data menu is shown in Fig 6.4.7.  The Swap A-B option swaps the X-axis and data in the 

XY plot, Fig 6.4.8.  The Information box… option displays the dialog shown in Fig 6.4.9. 

 

 

 

Figure 6.4.7  SIF display panel Data menu. 
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Figure 6.4.8  Effect of the Swap A-B menu option. 

 

 

Figure 6.4.9  Information box dialog. 

 

 

Turning on the Display Information box adds a box of text to the XY plot, Fig 6.4.10, which lists 

the options used to compute SIFs. 
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Figure 6.4.10  Information box added to XY plot. 

 

 

 

Convert Units allows one to change the units for the XY plot.  The dialog described in Section 

5.3 is displayed. 

 

The Axes menu is shown in Fig 6.4.11.  The Format X Axis option displays the dialog shown in 

Fig 6.4.12.  One can define the axis limits and grid spacing.  The Format Y Axis displays the 

same dialog with the label changed to Y Axis.  The Labels… option displays the dialog in Fig 

6.4.13.  One can change the plot title and axis labels; the syntax for defining the labels is 

described in Appendix A. 

 

 

Figure 6.4.11  SIF display panel Axes menu. 
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Figure 6.4.12  Format X Axis dialog. 

 

 

 

Figure 6.4.13  XY plot Labels dialog. 

 

6.4.2.2 SIF Plot with Simple Template Intersections 

 

If Simple Template Intersections (see Section 6.1.21) is turned on, the template will not extend to 

the model surface.  The SIF plot is based on the template element nodes; thus, the A and B 

represent the ends of the template and not the ends of the geometric crack front, Fig 6.4.14. The 

normalized crack front position (N Coord) is also based on the template; A and B always 

represent N Coord values of 0 and 1.  When using the M-integral, SIFs are computed at the 

element mid-side nodes.  In Fig 6.4.14, the first N Coord position is 0.0109 (and the last is 

0.9869).  This normalized position is based on the cumulative template length between A and B.  
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Figure 6.4.14  SIFs when Simple Intersection Template is turned on. 

 

 

 

6.5  Grow Crack 
 

When the Grow Crack menu option is selected, the Compute SIF's wizard is displayed first 

(see Section 6.4) if the SIFs have not already been computed. 

 

The Crack Growth wizard allows the user to specify algorithms and parameters to determine 

the local direction and relative extension of crack growth.   

 

The first panel in the wizard, Fig 6.5.1, allows one to specify the growth model type.  Subcritical 

crack growth includes fatigue, stress corrosion, and creep models.  Quasi-static crack growth is a 

simplified model that uses a simple power-law to advance the crack front.  User-defined crack 

growth is active if the user has pre-defined Python extensions; Python extensions are described 

under the Advanced menu (see section 14.7).  Growth parameters can also be read from a file 

using the Browse button. 

 

Depending on the chosen growth type, different wizard panels will be displayed, which allow the 

user to choose the rules, models, and parameters for the crack extension and kink angle 

computations. 
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Figure 6.5.1. Growth parameters panel. 

 

 

6.5.1 Subcritical crack growth 

 

Subcritical crack growth includes computation of both kink angle and extension along the crack 

front.  Cycles or time or a combination of the two are related to the amount of extension.  For 

each step of crack growth, there will be an average number of cycles and/or time stored, which 

will be used/displayed in the Fatigue Life dialog (see Section 9). 

6.5.1.1 Kink Angle Model 

 

The first panel of Subcritical crack growth is shown in Fig 6.5.2.  This dialog allows one to 

specify the method for computing kink angle.   

 

 

 

Figure 6.5.2 Kink angle model panel. 
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6.5.1.1.1 Max Tensile Stress (MTS) 
 

The default for computing the kink angle is the maximum tensile stress (MTS) theory. The crack 

kinks in the direction where tensile stress ahead of the crack front is maximized, Fig 6.5.3.  At 

each node along the crack front, the computed SIFs are used to determine the kink angle :  

 

𝜃 = 𝑐𝑜𝑠−1 (
3𝐾𝐼𝐼

2 +√𝐾𝐼
4 + 8𝐾𝐼

2𝐾𝐼𝐼
2

𝐾𝐼
2 + 9𝐾𝐼𝐼

2 ) 

 

Figure 6.5.3 MTS kink angle theory. 

 

 

6.5.1.1.2 Max Shear Stress (MSS) 
 

The MSS option is used when the crack growth is dominated by the mode II SIF and the material 

allows shear-dominated growth.  The user can refer to:  Pettit et al, Next generation 3D mixed mode 

fracture propagation theory including HCF–LCF interaction, EFM 102 (2013) 1–14.   

 

6.5.1.1.3 Generalized Stress 
 

The Generalized Stress option determines the kink angle based on the maximum of MTS and 

MSS.  It should be used with care as it can lead to large kinks in the crack front that can be 

difficult to insert/mesh. 

 

6.5.1.1.4 Strain Energy Release Rate (SERR) 
 

The SERR option computes a kink angle based on the growth direction that maximizes the strain 

energy release. 
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6.5.1.1.5 Planar 
 

The Planar option sets the kink angle to zero.  If the user knows that the crack growth is planar, 

this option will negate any numerical noise in the computed SIFs and force the crack to remain 

planar.  This is the only option available for symmetry surface crack growth. 

 

6.5.1.1.6 User Defined Model 
 

The User-Defined Model will be active for the user-defined Python extensions if the kink angle 

function is defined and selected; see Section 4 of the Commands & Python document. 

 

6.5.1.1.7 Kink angle limit 
 

The kink angle limit can be used to limit the amount of crack turning for a step of growth.  For 

partial crack front extension and large kink angles, this option can significantly improve the 

crack growth insertion/remeshing. 

 

6.5.1.1.8 Mixed Mode Eta Factors 
 

The eta factors apply to the MSS and SERR computations.  The user must provide them. 

 

6.5.1.1.9 Crack Growth Resistance 
 

Crack growth resistance can be either isotropic or anisotropic.  If the Anisotropic Toughness box 

is checked, the Set Toughness Parameters button is activated, Fig 6.5.4.  The fields correspond 

to the material toughness values. 

 

 

 

Figure 6.5.4  Anisotropic toughness parameters dialog. 
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Currently, FRANC3D supports one anisotropic crack growth resistance model.  It is an 

orthotropic model based on six principal material toughness values.   These values are illustrated 

in Fig 6.5.5.  The e's are the material property axes, which, in general, will not be aligned with 

the global Cartesian or the crack front coordinate systems.  The first toughness subscript 

identifies the material axis perpendicular to the crack plane and second subscript gives the 

direction of propagation. 

 

 

 

 

 

 

 

Figure 6.5.5  Orientations for the six principal material toughness values. 

 

 

Fig 6.5.6 shows the crack-front orientation and defines the a and n vectors.   x, y, and z are local 

crack-front coordinate axes that, in general, are not aligned with the global Cartesian coordinate 

axes.  

 

  is the local kink angle. 

 

 

 

Figure 6.5.6  Definition of the crack-front a and n vectors. 
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The crack orientation and kink angle sensitive local resistance to crack growth 

 

Kp() is given 

by 

  

   

 

  

 

where 

 

Kij  and 

 

Kik  are the principal toughness values (no summation on repeated indices), 

 

ai  

and 

 

ni  are the Cartesian components of the a and n vectors, and l and n (no subscript) are shape 

parameters.  The n shape parameters control the shape of the toughness envelope in the principal 

planes.  For example, Fig 6.5.7 shows the variation in 

 

K3 as function of 

 

  assuming that crack 

front coordinates are aligned with the Cartesian coordinates.  The l shape parameter has a similar 

effect on the variation of the toughness between the principal planes. 

 

 

 

Figure 6.5.7  The variation in 

 

K3 as function of 

 

  assuming that crack front coordinates are 

aligned with the Cartesian coordinates. 

 

6.5.1.2 Subcritical Growth Units 

 

Selecting Next in the dialog seen in Fig 6.5.2 leads to the Subcritical Growth Parameters dialog, 

Fig 6.5.8.  Note that the yellow (warning) triangles indicate parameters need to be set before you 

can continue. 
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Figure 6.5.8  The Subcritical Growth Parameters dialog. 

 

 

The Units used in the FE model should have already been set, but this dialog displays the units 

and allows the user to change them if needed. 

 

Select the Change button on the right side of the Units used in the FE model to display the Units 

dialog box, Fig 6.5.9.  Either SI or US units can be chosen; if the FE units do not correspond to 

the units shown, choose other.  Units of time are independent.  

 

Note that FRANC3D needs to match the FE units with crack growth rate units, which can be 

different.  By explicitly specifying the units used for the FE model and for the growth model, 

FRANC3D can perform unit conversions automatically.  

 

If other units are used, it is up to the user to make the units consistent between the FE model and 

the crack growth rate model. 
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Figure 6.5.9.  The Units dialog. 

 

 

6.5.1.3 Subcritical Load Schedule 

 

A Crack Growth Load Schedule (see Fig 6.5.8) does two main things.  First, it defines a mapping 

from the load steps defined in the FE model to the corresponding SIFs to predict crack growth 

rates.  Second, it defines the sequence these SIFs are applied. 

 

6.5.1.3.1  Load Schedule: New Schedule 
 

Select the New Schedule button (see Fig 6.5.8) to display the Load Schedule dialog, Fig 6.5.10.  

A load schedule is comprised of a collection of load events.  Load events are organized in a tree-

like structure.  The root of the tree is a Schedule event.   

 

Initially, the upper part of the dialog (Fig 6.5.10) shows one Schedule event, which is the main 

root of the tree.  A left click on this event does two things: 1) it makes the Add button active, and 

2) it raises the Repeat tab in the lower part of the dialog (right panel).  
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Figure 6.5.10  The Load Schedule dialog. 

 

 

 

Select the Add button to display the Event Type dialog, Fig 6.5.11.  There are seven different 

event types: 

➢ Simple Cyclic – a simple K = Kmax – Kmin cycle, where the Kmax and Kmin loadings are 

proportional, so Kmin = R*Kmax, and R is given by the analyst. 

➢ Non-Proportional Cyclic – a K = Kmax – Kmin cycle, where the Kmax and Kmin loadings 

are not proportional (they come from different load steps), and R = Kmin/ Kmax is 

computed. 

➢ Transient – For a transient event, a list of analysis load steps, sub-steps (frames), or a 

combination are specified.  FRANC3D will examine all the associated K’s and select 

Kmax and Kmin from among these to define K = Kmax – Kmin. 

➢ Spectrum – For a spectrum event, one or more load spectra are specified.  A load 

spectrum is a list of load multipliers used to define a sequence of Kmax and Kmin values, 

which are used to define a sequence of K’s.  If multiple spectra are specified, they are 

superimposed. 

➢ Hold Event – The four load events defined above can include a hold (dwell) time.  A hold 

event allows one to define a hold time without any companion load cycling. 

➢ Dynamic Pairing – examines all SIFs and dynamically creates max-min pairs. 

➢ Schedule – A schedule event can contain child events and allow a tree-like structure to be 

constructed. 
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Figure 6.5.11 The event type dialog. 

 

 

Note that some event types will not be active if there is only one set of SIFs.  Non-Proportional 

Cyclic and Transient types require at least two load steps or sets of SIFs.   

 

If the Non-Proportional Cyclic event type is selected, the Load Schedule dialog is updated, Fig 

6.5.12; and the Load Steps tab is automatically selected.  The yellow triangles indicate that the 

load steps associated with Kmax and Kmin must be specified.  The Select a load step button brings 

up the dialog shown to the right in Fig 6.5.12.  For both Kmax and Kmin, the load step is selected 

from the “pull-down” list of load steps.   

 

If there is only one substep (frame) for a load step, the Load Sub-Step option is unavailable. If 

there are multiple substeps, the user can choose the substep as well. 

 

Load and temperature scaling factors can be defined.  Note that the temperature multiplier does 

not account for coupling between the temperature and the stress intensity factors, so it should be 

used with care.   

 

The Temperature Offset can be used if the analysis was done using relative temperatures while 

the crack growth rate models assume thermometer temperatures. 

 

Note that in the Select Load Step dialog, the Sum Multiple Steps button allows Kmax and Kmin to 

be defined as the sum of the K’s associated with two or more load steps (each with its own load 

multiplier). 

 

Once the load steps for Kmax and Kmin have been selected, the Load Schedule dialog is updated as 

shown in Fig 6.5.13. 
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Figure 6.5.12  The Load Schedule dialog with a non-proportional cyclic load event added.  

The Select a load step button displays the dialog on the right. 

 

 

Figure 6.5.13  The Load Schedule dialog after load steps selected for Kmax and Kmin. 
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The Load Schedule dialog with the Temperature tab selected is shown in Fig 6.5.14, with 

Temperature dependent crack growth checked. 

 

 

 

Figure 6.5.14  The Temperature tab of the load schedule dialog. 

 

 

Because predicting crack growth might involve several different FE load steps, each of which 

can have associated temperatures, it is not obvious what temperature to use when evaluating a 

temperature dependent growth model.  The following options are available: 

 

• Constant – a constant temperature, provided by the user, is assumed for all crack front 

nodes, and is used for evaluating temperature dependent growth models. 

• Kmin – the crack-front temperatures associated with the load step used for determining 

Kmin is used. 

• Kmax – the crack-front temperatures associated with the load step used for determining 

Kmax is used. 

• Khold – the crack-front temperatures associated with the load step used for determining 

Khold is used. 

• External – the crack-front temperatures are read from an independent set of analysis 

results.  This will be a mesh file (e.g., .inp file) and the associated results file (e.g., an 

.odb or .dtp file). 
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• Interpolate – the crack front temperatures will be linearly interpolated between the Kmin 

and Kmax temperatures using a user-provided parameter that can vary between zero and 

one, where zero is the Kmin temperature and one is the Kmax temperature.  

 

Note that if Kmin, Kmax, or Khold are specified to be computed from the sum of multiple load steps, 

only temperatures from the first load step specified in the list of steps will be used to determine 

crack-front temperatures. 

 

The Load Schedule dialog with the Time tab selected is shown in Fig 6.5.15, with Time 

dependent crack growth checked; the hold time is added as part of a Non-Proportional Cyclic 

event. 

 

Simple Cyclic, Non-Proportional Cyclic, Transient, and Spectrum Load event types all allow a 

hold time.  A hold time can also be specified as an independent Hold event.  

 

Note that one might consider separate cyclic and hold events if, for example, the cyclic growth 

rate and hold growth rates were to be computed for different temperatures.  FRANC3D will 

compute the crack extension for all the cyclic loading in an event before computing the extension 

due to a hold time.  If it is desired to have the time dependent growth computed first, that should 

be done with a hold event that appears before the cyclic event in the load schedule.  

 

The Hold FOREVER option makes the hold time infinitely long.  This could be used, for 

example, if one wanted to simulate time dependent crack growth (e.g., stress corrosion cracking) 

and keep the crack growth simulation going until a critical stress intensity factor was reached. 

 

The Static tab is shown in Fig 6.5.16.  It allows the analyst to specify that the K from a load step 

(or sum of load steps) is to be added to both Kmax and Kmin.  This will not change the K, but it 

will change the stress ratio, R, for crack growth models sensitive to R.  This could be, for 

example, in situations where there is a steady “fixed” load, and an alternating cyclic load.  

 

The static load can be defined as a crack face traction, with stresses read from external analyses 

results (e.g., .inp and .odb files).   

 

The Other tab is shown in Fig 6.5.17.  It allows one to define how K is treated if the Kmin 

becomes greater than Kmax.  
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Figure 6.5.15  The load schedule dialog with the Time tab selected. 

 

 

Figure 6.5.16  The load schedule dialog with the Static tab selected. 
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Figure 6.5.17  The load schedule dialog with the Other tab selected. 

 

 

By default, a load event (load cycle, hold time, or combination) will be applied once.  The 

Repeat tab allows the analyst to specify that the load event should be applied some finite number 

of times.  It also allows one to specify that the event will be repeated FOREVER. 

 

All load events must be the “child” of a Schedule event.  When the repeat count is set for a 

Schedule event, all the child events are repeated for the specified number of times.  By 

organizing the events into a tree like structure and setting repeat counts for the Schedule and 

loading events, arbitrarily complex load sequences can be defined. 

 

These options, along with options set for the crack growth rate model, will determine when 

FRANC3D will stop a crack growth simulation.  Crack growth will always stop if the Kmax at any 

point on a crack front reaches a critical value.  It will also stop if the K for all points on the 

crack front fall below a threshold K.  In addition, if none of the load event events in the load 

schedule is set to repeat FOREVER, FRANC3D will make one complete pass through the load 

schedule and then stop the crack growth.  If a FOREVER repeat is specified, FRANC3D will 

continue to apply the corresponding load event (sequence of children events in the case of a 

Schedule event) until one of the stopping criteria from the crack growth rate model is reached. 

 

If the load sequence is to be applied FOREVER, this could be specified either in the Non-

Proportional Cyclic event or in the root Schedule event, Fig 6.5.18.  It is preferential to specify 

repeat FOREVER for the root schedule event.  This allows FRANC3D to more easily determine 

if an accelerated cycle counting algorithm can be used when computing a fatigue life.   
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Figure 6.5.18  Load schedule dialog with Repeat FOREVER selected for the schedule. 

 

6.5.1.3.1.1  Simple Cyclic Event 
 

If the user chooses a Simple Cyclic load type (see Fig 6.5.11), the lower portion of the Load 

Schedule dialog appears as in Fig 6.5.19.  The user can specify a given Stress ratio (R), and then 

specify the load step (and substep if there is more than one) along with load and temperature 

multipliers and temperature offset.  The stress ratio will be used to compute Kmin and thus the K 

values. 

 

 

Figure 6.5.19  Simple cyclic load event options. 
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6.5.1.3.1.2  Non-Proportional Cyclic Event 
 

If the user chooses a Non-Proportional Cyclic load type (see Fig 6.5.11), the lower portion of the 

Load Schedule dialog appears as in Fig 6.5.20.  The user must specify the load step (and substep 

if there is more than one) along with load and temperature multipliers and temperature offset for 

Kmax and Kmin; stress ratio and K are computed from these, and kink angle is based on K. 

 

 

Figure 6.5.20  Non-proportional cyclic load event options. 
 

6.5.1.3.1.3  Transient Event 
 

If the user chooses a Transient load type (see Fig 6.5.11), the lower portion of the Load Schedule 

dialog appears as in Fig 6.5.21.  The user must specify the load steps (and substeps if more than 

one) along with load and temperature multipliers and temperature offset, Fig 6.5.22 – left side.  If 

multiple load steps are to be analyzed, use the Multiple Steps button to select the load steps, Fig 

6.5.22 – right side.  FRANC3D computes the Kmax and Kmin values from all the selected load 

steps; stress ratio and K are computed from these, and kink angle is based on K. 

 

 

 

Figure 6.5.21 Transient load event options. 
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Figure 6.5.22  Transient load event load step selection. 

 

 

6.5.1.3.1.4  Spectrum Event 
 

If a user chooses a Spectrum load type (see Fig 6.5.11), the lower portion of the Load Schedule 

dialog appears as in Fig 6.5.23.  The user must specify the load steps (and substeps if more than 

one) along with a load spectrum; multiple spectra can be used. 

 

 

 

Figure 6.5.23  Spectrum load event options. 

 

 

This option allows one to specify a load spectrum (variable amplitude load schedule) to be used 

when computing crack growth rates.  A spectrum is defined as a series of load ranges.  

Associated with each load range is an optional repeat count (the default value is one).  One can 

also specify a multiplier and offset that will be applied to all values in the spectrum (e.g., to 

support the use of a normalized spectrum). 

 

If only one load case is used in the analysis, and load range i has specified values  and  

the expressions used for computing the SIF ranges and R ratio crack for range i are 

 

Smax, i
raw

 

Smin,i
raw
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 ,   

 

 ,   

 

  and   

 

where s is the spectrum multiplier, and t is the spectrum offset.  The  and  are used to 

compute the crack growth rate for stress range i. If multiple load cases are being used there are 

additional options for setting these values.  

 

For variable amplitude loading, the crack growth rates used for computing the relative amounts 

of crack growth for crack front points are the average crack growth rates computed for one pass 

through the spectrum.  That is 

 

   

 

where  is the crack growth rate computed for any given crack front point, and n is the 

number of load ranges in the spectrum. 

 

 The corresponding predicted kink angle is a weighted average kink angle computed as 

 

   

 

where  is the kink angle determined (implicitly) for range i using one of the criteria 

described in Section 6.5.1.1. 

 

The Select a load step button (in Fig 6.5.23) displays the dialog for selecting the load step (see 

Fig 6.5.22).   

 

The Select a load spectrum button first displays a dialog for selecting the spectrum file, Fig 

6.5.24.  

 

FRANC3D reads the data and displays it in a dialog, Fig 6.5.25 – left side, which allows one to 

specify the delimiter and to ignore the first line if labels are present.  The next dialog, Fig 6.5.25 

– right side, allows one to specify the Min, Max, and Count columns. 

 

 

 

Smax, i = sSmax, i
raw + t

 

Smin,i = sSmin,i
raw + t

 

Kmax, i = Smax, i Kcomp

 

Kmin,i = Smin,i Kcomp

 

K i = Kmax, i −Kmin,i

 

Ri = Kmin,i Kmax, i

 

Ki

 

Ri

 

da

dN
=

da

dN i

(K i,Ri,...)
i=1

n



n

 

da dN

 

 kink =

da

dN i

(K i,Ri,...)  kink,i(K I ,i,K II ,i,K III ,i,...)
i=1

n



da

dN i

(K i,Ri,...)
i=1

n



 

kink,i
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Figure 6.5.24  Select load spectrum file dialog. 
 
 
 

   

Figure 6.5.25  Select load spectrum file dialog. 
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Once the spectrum has been read, the Load schedule dialog appears as in Fig 6.5.26.  The 

Display button beside the Spectrum label can be used to view the spectrum, Fig 6.5.27.   

 

 

 

Figure 6.5.26  Spectrum load event with load step and spectrum defined. 

 
 

 

Figure 6.5.27  Spectrum display dialog. 
 

 

The magnifying glass icons allow one to view a segment of the spectrum and the arrow icons 

allow one move forward or backward through the spectrum.  A cycle range can be specified as 

well, which can be faster than multiple levels of zooming. 
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6.5.1.3.1.5  Hold Event 
 

If the user chooses a Hold load type (see Fig 6.5.11), the lower portion of the Load Schedule 

dialog appears as in Fig 6.5.28.  The user must specify the hold time and the load step.  The hold 

time was described previously as part of the root schedule; see Section 6.5.1.3. 

 

 

 

Figure 6.5.28  Hold load event options. 
 
 

6.5.1.3.1.6  Dynamic Pairing Event 
 

If the user chooses a Dynamic Pairing load type (see Fig 6.5.11), the Load Schedule dialog 

appears as in Fig 6.5.29.  Once the event is added, select this event (with a left click), and click 

the Add button to display the dialog shown in Fig 6.5.30.  This dialog allows one to build up a 

series of events within the Dynamic Pairing event. 

 

Note that the repeat count for Dynamic Pairing events can only be set to one.  The top-level 

schedule repeat count can be set to FOREVER to force the Dynamic Pairing event to be repeated 

more than one time.  
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Figure 6.5.29. Dynamic Pairing load event added to the root schedule. 

 

 

Figure 6.5.30  Dynamic Pairing event types. 

 

There are four event types: 

➢ Low Cycle Reversal – the load step associated with a LCF event is specified. 

➢ High Cycle Const Amp – the load step associated with both a static and a vibratory load 

step are specified. 
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➢ Resonance Blossom – the load step associated with a static load step and a vibratory load 

step are specified along with several parameters, Fig 6.5.31.  One must specify the 

resonance frequency (in Hz), the radial acceleration or deceleration (in radians/sec2, this 

is assumed to be constant throughout the blossom), the engine order (number of forced 

excitations per rotation), and a critical damping ratio (dimensionless). 

➢ Spectrum – For a spectrum event, one or more load spectra are specified as described for 

the Spectrum event in Section 6.5.1.3.1.4. 

 

 

 

Figure 6.5.31  Resonance blossom parameters. 

 

 

6.5.1.3.1.7  Schedule Event 
 

If the user chooses a Schedule load type (see Fig 6.5.11), the Load Schedule dialog appears as in 

Fig 6.5.32.  This allows one to build up a sub-schedule with any of the load types just described. 
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Figure 6.5.32 Schedule load event added to the root schedule. 
 

 

6.5.1.3.2  Load Schedule:  Read From File 
 

The Crack Growth Load Schedule Read From File button (see Fig 6.5.8) allows one to read a 

load schedule that was previously defined and saved to a file.  This file contains only the load 

schedule information.  It is used in conjunction with the Save To File button in Section 6.5.1.3.5.  

It is an ASCII text file and should contain this data “block”: 

 
FATIGUE_LOAD_SCHEDULE 
( 
    VERSION: 1 
    SCHEDULE ( 
       …. 
    ) 
) 

 

6.5.1.3.3  Load Schedule: Wizard 
 

The Crack Growth Load Schedule Wizard button (see Fig 6.5.8) presents a series of dialog 

boxes that leads you through the step-by-step process of creating the load schedule.  The first 
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dialog, Fig 6.5.33, shows the load schedule types that can be built using this wizard; note that 

some event types are not included. 

 

 

 

Figure 6.5.33  Load schedule wizard first dialog. 

 

The subsequent dialogs will depend on the selected schedule type…. 

 

6.5.1.3.4  Load Schedule:  View/Edit 
 

The Crack Growth Load Schedule View/Edit button (see Fig 6.5.8) displays the previously 

defined load schedule in the dialog.  The load schedule can be completely revised if needed. 

 

6.5.1.3.5  Load Schedule:  Save To File 
 

The Crack Growth Load Schedule Save To File button (see Fig 6.5.8) allows the user to save the 

load schedule to a file.  This file contains only the load schedule information; it is used in 

conjunction with the Read From File button in Section 6.5.1.3.2. 

 

6.5.1.4  Subcritical Growth Rate Model 

 

The Subcritical Growth Parameters dialog (see Fig 6.5.8) requires that you set a Crack Growth 

Rate Model.  This is material dependent data that describes the crack growth rate base on cyclic 

loading and/or time. 

 

6.5.1.4.1  Growth Rate Model:  New Model – cyclic loading 
 

Select the New Model button to display the dialog shown in Fig 6.5.34.  Cyclic loading and time 

dependent growth rate models can be defined.  The cyclic loading models are described first. 
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Figure 6.5.34 The crack growth rate model type dialog. 

 

 

The Cyclic Loading Growth Model dialog, Fig 6.5.35, supports two general types of cyclic 

growth models, “paired” and “inclusive” models.  The difference between them is based on how 

the stress ratio effects are incorporated.  For a paired model, the “shape” of the crack growth rate 

curve (Paris, Sigmoidal, etc.) is selected independently from the stress ratio algorithm (Walker, 

Newman Closure or Table).  The inclusive models (two different versions of the NASGRO 

equation) have stress ratio effects built into the model equations. 

 

 

 

Figure 6.5.35  The cyclic loading growth model. 

 

 

For the Paris crack growth rate model, for example, with no stress ratio effects, the next dialog 

allows you specify either a temperature dependent or independent model, Fig 6.5.36.  If the 
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growth rate model is temperature independent, this means that only one set of growth rate 

parameters (C and m for the Paris model) are required.   

 

For temperature dependent models, different sets of growth model parameters are specified for 

different temperatures, and FRANC3D interpolates among these values to find the appropriate 

growth rate for the crack-front temperature.  

 

 

Figure 6.5.36  The temperature independent model selected. 

 

 

For a temperature independent Paris model, the dialog shown in Fig 6.5.37 is displayed.  The 

Model Label, and Description fields are optional.  These might be useful if the model parameters 

are stored in a file for later reuse. 

 

The units must be specified.  The units need not be the same units use in the FE analysis.  If the 

units are different, FRANC3D will automatically perform the necessary unit conversions.   

However, FRANC3D assumes that the units used within the growth model description (or within 

the FE analysis) are self-consistent.  

 

 

 

Figure 6.5.37  Dialog for entering temperature independent Paris growth model parameters. 
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Each of the growth rate and stress ratio models are described in the following subsections. The 

dialogs for entering the growth rate model parameters are like that shown in Fig 6.5.37; any 

differences will be noted in each subsection. 

 

6.5.1.4.1.1  Paris model 
 

The Paris growth rate model (see Fig 6.5.37) is a power law model expressed as 

 

 

 

da dN =C(Keff )
n

  

 

The parameters 

 

C  and 

 

n  must be specified along with values for 

 

Kthreshold and 

 

Kcritical.  If 

 

Keff  Kthreshold,  is set to zero.  If 

 

Keff  (1−R)Kcritical, unstable crack growth is 

assumed and is infinite.  

 

Note that FRANC3D labels the exponent for the Paris model as “n”.  In addition to C and n, 

values must be entered for Kthreshold and Kc.  Specifying a small value for Kthreshold or a large 

value for Kc will effectively turn off the possibility that the crack growth simulation will stop due 

to a below-threshold or above-critical condition. 

 

6.5.1.4.1.2  Bilinear Paris model 
 

The Bilinear Paris model, Fig 6.5.38, is an extension of the Paris model; it has two linear 

portions when plotted on a log/log graph.  The equation is: 

 

 

 

da

dN
=
C1(Keff )

n1 Keff  K*

C2(Keff )
n2 Keff  K*

 

 
 

  
  

 

The parameters 

 

C1, 

 

C2 , 

 

n1, and 

 

n2  must be specified along with values for 

 

Kthreshold and 

 

Kcritical.  If 

 

Keff  Kthreshold, 

 

da dN  is set to zero.  If 

 

Keff  (1−R)Kcritical, unstable 

crack growth is assumed and 

 

da dN  is infinite.  

 

 

 

da dN

 

da dN
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Figure 6.5.38  Dialog for entering temperature independent Bilinear Paris parameters. 

 

6.5.1.4.1.3  Sigmoidal cyclic loading growth model 
 

The expression for the sigmoidal model, Fig 6.5.39, is: 
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The parameters B, P, Q, D, 

 

Kthreshold, and 

 

Kc must be specified. 

 

 

 

Figure 6.5.39  Dialog for entering temperature independent Sigmoidal growth model parameters. 
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6.5.1.4.1.4  Hyperbolic Sine model 
 

The expression for the hyperbolic sine model, Fig 6.5.40, is: 

 
 

 

log( da dN)=C1sinh(C2[log( K)+C3])+C4   

 

The parameters

 

C1, 

 

C2 , 

 

C3 , 

 

C4 , 

 

Kthreshold, and 

 

Kc must be specified. If 

 

Keff  Kthreshold, 

 

da dN  is set to zero.  If 

 

Keff  (1−R)Kcritical, unstable crack growth is assumed and 

 

da dN  

is infinite. 

 

 

Figure 6.5.40  Dialog for entering temperature independent Hyperbolic sine growth model 

parameters. 
 

 

6.5.1.4.1.5  Table Lookup growth model 
 

For a table lookup model, Fig 6.5.41, a list of 

 

Keff  and corresponding 

 

da dN  values are 

specified.  Linear interpolation is performed among logs of the specified values.  The following 

equation is used to interpolate between values i and i+1:  

 

 

 

log(da dN)= log(da dN
i
)+
log(Keff Ki)

log(Ki+1 Ki )
log

da dN
i+1

da dN
i

 

 
  

 

 
    

 

In addition to the 

 

(Keff ,da dN) values, a value must be specified for 

 

Kcritical.  The smallest 

specified 

 

Keff  is assumed to be 

 

Kthreshold.  For 

 

Keff  greater than the largest value specified 

and 

 

Keff  (1−R)Kcritical,  the slope of the curve between the two highest specified points is 
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extrapolated.  This is unrealistic for many cases, so it is best to provide 

 

(Keff ,da dN) data that 

extend past the critical values. 

 

One can use the File button (in Fig 6.5.41) to import data from an ASCII txt file.  The data is 

displayed in a dialog, Fig 6.5.42 – left side, which allows one to specify the delimiter.  The next 

dialog, Fig 6.5.42 – right side, allows one to identify the columns for K and da/dN.  Once data 

has been read or entered, the Plot button (in Fig 6.5.41) can be used to display the data, Fig 

6.5.43. 

 

 

Figure 6.5.41  Dialog for entering temperature independent Table lookup growth model. 
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Figure 6.5.42  Dialog for importing Table lookup growth model data. 
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Figure 6.5.43  Plot of Table lookup growth model data. 
 

 

6.5.1.4.1.6  No Stress Ratio model 
 

This option turns off stress ratio effects.  That is 

 

   

 

All the above growth rate model dialogs were shown with the stress ratio option set to None. 

 

6.5.1.4.1.7  Walker Stress Ratio model 
 

The expression for the Walker equation is 

 

   

 

 

Keff = K

 

Keff = (1− R)m−1K

m =
m+ R  0

m − R  0

 
 
 
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The parameters +m  and −m  must be specified. 

 

NOTE: the Walker equation is defined relative to R = 0.  That is, the parameters used for the 

paired growth rate model (e.g., Paris parameters) should be those appropriate for R = 0.  

 

For each of the growth models paired with the Walker model, the dialogs are shown in Figs 

6.5.44 – 48. 

 

 

 

Figure 6.5.44  Dialog for entering temperature independent Paris growth and Walker stress ratio 

model parameters. 

 
 

 

Figure 6.5.45  Dialog for entering temperature independent Bilinear Paris growth and Walker 

stress ratio model parameters. 
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Figure 6.5.46  Dialog for entering temperature independent Sigmoidal growth and Walker stress 

ratio model parameters. 

 

 

 

Figure 6.5.47  Dialog for entering temperature independent Hyperbolic sine growth and Walker 

stress ratio model parameters. 
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Figure 6.5.48  Dialog for entering temperature independent Table lookup growth and Walker 

stress ratio model parameters. 
 

 

6.5.1.4.1.8  Newman Closure Stress Ratio model 
 

The expression for Newman Closure is 

 

   

 

where f is a function that accounts for the crack front being open for only a portion of the load 

cycle due to plasticity induced crack front closure.  It is defined as 

 

   

 

where the coefficients are given by: 

 

 

Keff =
(1− f )

(1−R)
K

 

f =
Kopen

Kmax
=
max(R,A0 +A1R+A2R

2 +A3R
3) R  0

A0 +A1R −2  R  0

 
 
 
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The values of a  and  

 

Smax s0  must be specified, where  is a plane stress/strain constraint 

factor and 

 

Smax s0  is the ratio of the maximum applied stress to the flow stress. 

 

NOTE: the Newman Closure equation is defined relative to closureRR = .  That is, the parameters 

used for the paired growth rate model (e.g., Paris parameters) should be those appropriate for the 

case of closureRR = , where closureR  is the stress ratio where crack closure effects are no longer 

significant.  This value is typically about 0.7 for most materials. 

 

For each of the growth models paired with the Newman Closure model, the dialogs are shown in 

Figs 6.5.49 – 53. 

 
 

 

Figure 6.5.49  Dialog for entering temperature independent Paris growth and Newman Closure 

stress ratio model parameters. 
 

 

a
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Figure 6.5.50  Dialog for entering temperature independent Bilinear Paris growth and Newman 

Closure stress ratio model parameters. 
 
 
 

 

Figure 6.5.51  Dialog for entering temperature independent Sigmoidal growth and Newman 

Closure stress ratio model parameters. 
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Figure 6.5.52  Dialog for entering temperature independent Hyperbolic sine growth and Newman 

Closure stress ratio model parameters. 

 
 

 

Figure 6.5.53  Dialog for entering temperature independent Table lookup growth and Newman 

Closure stress ratio model parameters. 
 

6.5.1.3.1.9  Table Lookup Stress Ratio model 
 

For a tabular stress ratio model, parameters for the associated growth rate model are specified for 

various R values.  For example, the specified values for a Paris model with tabular stress ratio 

model would be 
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Linear interpolation is performed to find the crack growth rate for any R value between two 

specified values iR  and 1+iR .  That is 

 

 
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
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++ iiii

i

i dN
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dN
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RR
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If R is smaller than the smallest R specified, the growth rate corresponding to the smallest 

specified R is used (if the user specifies that the values are capped, otherwise extrapolation is 

done).  Likewise, if R is greater than the greatest R specified, the growth rate corresponding to 

the largest specified R is used (if the user specifies that the values are capped, otherwise 

extrapolation is done). 
 

For Table lookup growth rate and Table lookup stress ratio, FRANC3D interpolates using both 

tables to find a crack growth rate for a given K and R.  

 

Given query values  and , crack growth rates are extracted from the table using the 

following algorithm: 

 

1.  and  values are found that bracket the query value, . 

 

2. , , , and  are found where  and 

, with  and  values associated with  and  and  

values associated with . 

 

3. Linear interpolation in log/log space is used to find intermediate growth rate data,  

 

  

 

 and 
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4. Finally, normal linear interpolation is used to find the final growth rate 

 

  

 

If during the interpolation process a query value (  or ) is found to be larger or 

smaller than the largest or smallest corresponding value in the table, the query value is replaced 

with the largest or smallest, respectively, available value. 

 

Not that, as with all interpolation procedures, the accuracy of the results is dependent on the 

density of the data available for interpolation.  Very sparse tables can lead to inaccurate and, in 

some cases, unrealistic crack growth predictions. 
 

For each of the growth models paired with Table lookup stress ratio selected, the dialogs are 

shown in Figs 6.5.54 – 58. 
 
 

 

Figure 6.5.54  Dialog for entering temperature independent Paris growth and Table lookup stress 

ratio model parameters. 
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Figure 6.5.55  Dialog for entering temperature independent Bilinear Paris growth and Table 

lookup stress ratio model parameters. 
 
 

 

Figure 6.5.56  Dialog for entering temperature independent Sigmoidal growth and Table lookup 

stress ratio model parameters. 
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Figure 6.5.57  Dialog for entering temperature independent Hyperbolic sine growth and Table 

lookup stress ratio model parameters. 

 
 

 

Figure 6.5.58  Dialog for entering temperature independent Table lookup growth and Table 

lookup stress ratio model parameters. 

 
 

For the Table lookup dialog (in Fig 6.5.58), double-click on the “table data” beside the given R 

value to enter the da/dN versus K data, using the dialog shown in Fig 6.5.59. 
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Figure 6.5.59  Dialog for entering temperature independent Table lookup growth and Table 

lookup stress ratio model da/dN vs K data. 

 
 

6.5.1.4.1.10  NASGRO Version 4 equation 
 

NASGRO is a fatigue life prediction program initially developed at the NASA Johnson Space 

Flight Center and now supported and maintained by Southwest Research Institute.  Built into the 

NASGRO program is an analytical crack growth rate equation that incorporates several features 

observed in real materials such as sensitivity to near-threshold and near-critical growth, 

sensitivity to the R-ratio, and small crack sensitivity.  The cost for flexibility in the growth model 

is that there are sixteen fitting parameters.  Some are common material properties (e.g., yield 

stress), but most must be determined by performing regression analyses on empirical data. 

 

The NASGRO package includes a database of pre-computed parameters for a wide range of 

materials and product forms.  However, as of NASGRO version 4, this database is only 

accessible to members of the NASGRO consortium.  As a practical matter, this means that this 

model will be most useful to users who have access to the NASGRO program and can access the 

parameters for a material of interest (see NASGRO version 3 below). 

 

The NASGRO version 4 crack growth rate equation, Fig 6.5.60, is: 

 

  (12.5.13) 

 

where C, n, p, and q are empirical constants.  C and n are like the constants in the Paris and 

Walker equations.  However, while C in the Paris model should be selected to correspond to the 

R of interest, and C in the Walker equation should be for R = 0, in the NASGRO equation the C 

should correspond to a high R where closure effects are no longer significant (usually an R of 

about 0.7)  
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Figure 6.5.60  NASGRO version 4 growth rate model dialog. 

 

 

f is the function associated with Newman closure.  is the threshold stress intensity factor 

range below which there is no crack growth.  It is approximated by the following empirical 

equations: 

 

   

 

where 

 

   

 

and  is an empirical constant,  is the observed threshold for a high R-ratio, and  is a 

small crack parameter (usually 0.0015in, 0.0381 mm). 
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 is the fracture toughness.  In FRANC3D, one has the choice to use the plane strain fracture 

toughness, , the part-through toughness, , or compute it from: 

 

   

 

where 

 

   

 

 and  are empirical constants, and t, the "thickness", is specified by the user (in 3D 

applications the notion of thickness is not well defined and engineering judgment must be used 

to set this value). 

 

More details about this model can be found in the NASGRO theory manual.  Note that 

FRANC3D expects consistent units for the model parameters; in particular, the length units for K 

and C must be the same. 

 

The Write button allow one to save the parameters in this dialog to a file.  The Browse button 

allows one to read this saved data from a file. 

 

6.5.1.4.1.11  NASGRO Version 3 equation 
 

NASGRO version 3 is an earlier version of the NASGRO crack growth rate equation.  The 

current version of the equation (version 4) does a better job of modeling observed crack growth 

rates for some conditions.  This earlier version is included in FRANC3D because version 3 of 

NASGRO, the last public domain version, included a database of equation parameters for a wide 

variety of materials and product forms.  That database is accessible from within FRANC3D. 

 

The NASGROv3 crack growth rate equation is slightly different than version 4 equation.  The 

base equation is the same: 

 

   

 

The difference has to do with how threshold values are computed.  In version 3, the expression is 

 

 

RC

th

th

RA

f

aa

a
KK

+












−−

−

+
=

1

00
0

)1)(1(

1
  

 

 

Kc

 

K Ic

 

K Ie

 

Kc =K Ic (1+ Bke
−(Ak t t0 )

2

)

 

t0 = 2.5 KIc sys( )
2

 

Ak

 

Bk

 

da

dN
=C

1− f

1− R

 

 
 

 

 
 

 

 
 

 

 
 

n 1−
K th
K

 

 
 

 

 
 

p

1−
Kmax

Kc

 

 
 

 

 
 

q



 148 

where a  is the crack length and 0a  has a fixed value of 0.0015 in (0.0381 mm). 

 

 

Fig 6.5.61 shows the dialog for entering the NASGRO model parameters.  The NASGRO 

version 3 material database contains data for a wide variety of materials, and this data is included 

in FRANC3D and accessible by selecting the Material Properties Database button.   

 

 

 

Figure 6.5.61 NASGRO version 3 growth rate model. 

 

 

The dialog boxes shown in Fig 6.5.62, allow the analyst to automatically fill in the required 

NASGRO v3 parameter fields from this database. 
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Figure 6.5.62 NASGRO version 3 material database dialog boxes 

 

6.5.1.4.1.12  Modified Hartman-Schijve 
 

The Modified Hartman-Schijve growth model is shown in Fig 6.5.63. 

 

 

 

Figure 6.5.63 Paris temperature dependent model with no stress ratio model. 
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6.5.1.4.1.13  User-defined model 
 

The user-defined option will be active if the user has included the Python extensions and 

appropriate Python functions.  This is described further in Section 14.6. 

 

6.5.1.4.1.14  Temperature dependent growth rate 
 

Temperature dependent growth rate models are implemented in a tabular manner.  Growth model 

parameters are specified for several different temperatures and interpolation is performed among 

the computed dNda  values.  For example, the specified data for a temperature dependent paired 

Paris/Walker growth model would be  
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Three different interpolation options are available: closest, next highest, and linear interpolation.  

For closest interpolation, dNda  is determined for the tabular temperature closest to the input 

value.  For next highest interpolation, dNda  is determined for the next tabular temperature 

higher than the input value.  The expression for linear interpolation between two tabular values i 

and i+1 is 
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If the input temperature is smaller than the smallest temperature specified, the growth rate 

corresponding to the smallest specified temperature is used (if the user specifies that the values 

are capped, otherwise extrapolation is done)..  Likewise, if the input temperature is greater than 

the greatest temperature specified, the growth rate corresponding to the largest specified 

temperature is used (if the user specifies that the values are capped, otherwise extrapolation is 

done). 

 

If temperature data is not available in the data for the current FEM model, room temperature 

(70˚F, 20˚C) is assumed. 

 

The dialogs for the Paris growth model, for no stress ratio, Walker stress ratio and Table lookup 

stress ratio are shown in Figs 6.5.64 – 66.  For the Table lookup model, double-click on the 

“table data” to enter the Paris data for the specified temperature, Fig 6.5.67. 

 

The dialogs for the other “paired” growth models are similar.  
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Note that for Table lookup growth rate with Table lookup stress ratio and temperature 

dependence, there are multiple levels of tables for entering the data. 

 

 

 

Figure 6.5.64 Paris temperature dependent model with no stress ratio model. 

 

 

 

Figure 6.5.65 Paris temperature dependent model with Walker stress ratio model. 
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Figure 6.5.66 Paris temperature dependent model with Table lookup stress ratio model. 

 
 

 

Figure 6.5.67 Paris temperature dependent model with Table lookup stress ratio model dialog for 

entering Paris data. 
 

 

 

6.5.1.4.2  Growth Rate Model: New Model – time dependent loading 
 

There are five time-dependent growth models, Fig 6.5.68; these are described in the subsections 

below.  Each of the models can be temperature dependent or independent, Fig 6.5.69, like the 

cyclic growth rate models. 
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Figure 6.5.68  Dialog to select a time dependent growth model type. 

 

 

 

Figure 6.5.69  Dialog to specify temperature dependent or independent for time dependent 

growth model. 

 

 

6.5.1.4.2.1  Time Dependent Power Law 
 

 

The dialog to specify the power law time dependent growth and temperature independent model 

parameters is shown in Fig 6.5.70.  Again, as for cyclic loading, Units must be specified.  For 

time dependent rates, the threshold (Kth) is an actual K value rather than a K value.  If Khold is 

below this value for any crack front point, there will be no time dependent crack extension for 

that point.  
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Figure 6.5.70  Dialog box for entering time dependent power law growth model parameters. 

 

 

6.5.1.4.2.2  Time Dependent Terachi SCC  
 

The dialog to specify the Terachi stress corrosion crack (SCC) time dependent growth model 

parameters is shown in Fig 6.5.71.  The dialog is like that of the Power law model.  However, the 

equation is a function of the material yield stress. 

 

 

 

Figure 6.5.71  Dialog box for entering time dependent Terachi SCC growth model parameters. 
 

 

Yield Stress can be specified as constant or can be given in a table.  For the Table option, pairs of 

numbers are given that specify a depth from the nearest surface and a corresponding yield stress.  

Linear interpolation is performed within the given values, with the minimum and maximum 
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values assigned to crack front points whose depths fall below or above the given depths, 

respectively. 

 

6.5.1.4.2.3  Zencrack COMET model 
 

The dialog to specify the Zencrack COMET time dependent growth model parameters is shown 

in Fig 6.5.72.  The exponent is temperature dependent and must be set here. 

 

 

 

Figure 6.5.72  Dialog box for time dependent Zencrack COMET growth model parameters. 

 

 

6.5.1.4.2.4  Time Dependent Table Lookup  
 

Time dependent growth can be entered using a Table lookup model, Fig 6.5.73. Interpolation is 

done based on the K values to obtain the da/dt. 
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Figure 6.5.73  Dialog box for entering time dependent Table lookup data. 
 
 

6.5.1.4.2.5  User model  
 

The user-defined option will be active if the user has included the Python extensions and 

appropriate Python functions.  This is described further in Section 14.7. 

 
 

6.5.1.4.2.6  Temperature dependent time dependent growth 
 

As with the cyclic growth rate models, time dependent growth models can also be temperature 

dependent.  The dialogs are shown in Figs 6.5.74 – 75 for the power-law and table-lookup time-

dependent models.  For the Table lookup model, there is a lower-level table that is accessed by 

double-clicking the “table data” field, Fig 6.5.76. 
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Figure 6.5.74  Dialog for entering temperature dependent time dependent Power law data. 

 

 
 

 

Figure 6.5.75  Dialog for entering temperature dependent time dependent Table lookup data. 
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Figure 6.5.76  Dialog box for entering Table lookup K vs da/dt data. 

 

6.5.1.4.3  Growth Rate Model:  Read From File 
 

The Crack Growth Rate Model Read From File button (see Fig 6.5.8) allows one to read a crack 

growth model that was previously defined and saved to a file.  This file contains only the crack 

growth rate information.  It is used in conjunction with the Save To File button in Section 

6.5.1.4.6.  It is an ASCII text file and should contain this data “block”: 

 
CRACK_GROWTH_RATE 
( 
VERSION: 2 
       …. 
) 

 

6.5.1.4.4  Growth Rate Model:  View/Edit da/dN 
 

The Crack Growth Load Schedule View/Edit da/dN button (see Fig 6.5.8) displays the 

previously defined cyclic loading growth rate model in the dialog.   

 

6.5.1.4.5  Growth Rate Model:  View/Edit da/dt 
 

The Crack Growth Rate Model View/Edit da/dt button (see Fig 6.5.8) displays the previously 

defined time dependent growth rate model in the dialog.   

 

6.5.1.4.6  Growth Rate Model:  Save To File 
 

The Crack Growth Rate Model Save To File button (see Fig 6.5.8) allows the user to save the 

growth model to a file.  This file contains only the crack growth rate information; it is used in 

conjunction with the Read From File button in Section 6.5.1.4.3. 
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6.5.1.5  Subcritical Mixed-mode equivalent K 

 

The equivalent K or K can be defined using only Mode I (KI) or using all three Modes, Fig 

6.5.77.  If the Kequiv is based on all three SIF modes, the sign can be set based on the sign of KI, 

KII or KIII or it can be set as always positive or always negative.  

 

 

 

Figure 6.5.77  Equivalent K options 

 

If the SingleCrystal menu is active, the dialog will include an additional option, Fig 6.5.78, that 

allows one to use KRSS as Kequiv; Section 12 will describe the single crystal options in more 

detail. 

 

 

Figure 6.5.78  Single Crystal Equivalent K options  

 

6.5.1.6  Subcritical Effective dK 

 

There are two options for how K is computed.  The default behavior is to simply compute K = 

Kmax – Kmin.  In cases where the minimum loading at the crack front is compressive (and contact 

elements are not explicitly inserted into the crack faces to prevent crack overlap), the computed 

Kmin and corresponding stress ratio (R) will be negative.  Such crack face overlap is physically 

unrealistic, but it is customary practice to accept the negative values, and meaningful engineering 

predictions can be performed with these values provided the appropriate parameters are used 

with the growth rate and/or stress ratio models. 

 

Optionally, FRANC3D can be instructed to compute a more physically realistic K that only 

considers portions of a load cycle where the Ks are positive.  That is: 
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Effective values of the stress intensity factor range and R account for the situation where the 

crack is closed during a portion (or all) of a load cycle. The default behavior in FRANC3D is to 

check for a closed crack for the complete cycle and to set the stress intensity factor range and R 

to zero: 
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This default behavior allows for negative R values. 

 

FRANC3D allows the option to truncate the stress intensity factor range to eliminate the negative 

(closed) portion of the cycle.  In this case, the expressions are: 
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Note that there are several mechanisms that have been identified as being able to keep the crack 

closed even when the current "remote" loading is positive.  The most significant is plasticity-

induced crack closure.  This is one proposed explanation for the observed dependency of crack 

growth rates on the R.  The effective values computed here do not explicitly account for this 

(plasticity-induced closure is treated implicitly by some of the available crack growth rate 

models), they only consider "global" closure where the currently applied "remote" load is 

negative. 
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6.5.1.7  Subcritical Integration Options 

 

There are two options that affect how the crack growth integrations are performed when 

computing total life (see Fig 6.5.8).  If the Accelerated counting option is selected (the default), 

FRANC3D will try to use an accelerated cycle counting algorithm based on Runga-Kutta 

integration.  If this option is turned off, FRANC3D will perform cycle-by-cycle counting.  The 

accelerated counting might be slightly less accurate than cycle-by-cycle counting, but usually the 

difference in the computed fatigue lives for the two methods is less than 1-2% of the total cycle 

count.  On the other hand, for analyses where the per cycle crack extension is small, for some 

models, the accelerated counting has been shown to give greater than 1000x reductions in the 

time required to compute total fatigue lives. 

 

The Constant K for time integration option can be set to speed-up the integration of time 

dependent growth.  In general, the stress intensity factor will be function of time, so FRANC3D 

evaluates the integral: 

 =

t

m
hold dKAa

0

)(   

where t is the hold time.  The integral is evaluated using Runge-Kutta integration. 

 

If, however, the crack growth over a hold interval is small, K can be assumed to be constant 

during the interval leading to the (much faster to evaluate) expression: 

tKAa m
hold =  

If this option is selected, FRANC3D will assume that K is constant over all time intervals. 

 

The user can choose between Runge-Kutta (RK) and Cycle-by-cycle (CxC) integration to 

compute life or cycles. A 2nd order RK approach is implemented, Fig 6.5.79. 

 

 

 

Figure 6.5.79  Second order Runge-Kutta integration. 
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6.5.1.8  Dynamic Pairing Metric 

 

There are two options, currently active, that determine the dynamic pairing.  The K is the 

standard default, but d/dN can be chosen instead. 

 

 

6.5.2  Quasi-static crack growth 

 

The first dialog of quasi-static crack growth, Fig 6.5.80, is the same as for subcritical crack 

growth.  The method for computing the kink angle must be specified (see Section 6.5.1.1). 

 

 

 

Figure 6.5.80  Kink angle model panel. 
 

 

The next dialog, Fig 6.5.81, allows the user to specify the power for the growth model, as well as 

specifiying the Kequiv and the load step(s) to be used.  The extension at all crack front points are 

computed based on the simple power law, Fig 6.5.82.  

 

The sign for Kequiv can be set (see Section 6.5.1.5).  If the SingleCrytal menu is active, Kequiv can 

be set to KRSS (see Section 6.5.1.5); this option is not shown in Fig 6.5.82. 
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Figure 6.5.81  Quasi-static growth parameters panel. 

 

 

Figure 6.5.82  Quasi-static crack growth. 

 

 

The default value of n is set to 2.  This is based on a simplified analysis of crack front node 

interactions.  Consider a crack front with nodes i and j as shown in Fig 6.5.83.  If we ignore 

interactions among nodes: 
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Figure 6.5.83  Nodes i and j on crack front. 

 

 

6.5.3  User-Defined crack growth 

 

User-defined crack growth is activated if the user has pre-defined Python extensions; this is 

described in Section 14.7. 

 

 

6.5.4  Read growth parameters from a file 

 

The user can save the crack growth model data to a file after defining it, and this file can be read 

back into FRANC3D.  This is especially useful for the subcritical crack growth.  This file is an 

ASCII text file and contains both the load schedule (see Section 6.5.1.3) and the crack growth 

rate (see Section 6.5.1.4) data. 

 

 

i

 

j
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6.5.5  Crack growth front fitting 

 

Once the crack growth model has been defined, FRANC3D will display the computed crack 

growth, Fig 6.5.84.  The crack extension can be adjusted in this dialog if needed.  The computed 

new crack front points are smoothed and extrapolated (for surface flaws); there are several 

options for this. 

 

 

 

Figure 6.5.84  Crack growth display dialog. 
 

 

Specified extension or number of cycles or elapsed time can be chosen to adjust the amount of 

crack extension. The cycles and time options are available if the crack growth model includes 

such.  

 

Note that a scale node of 0.5 represents the median; extensions are sorted from minimum to 

maximum, and the scale node varies from 0 to 1.  For a specified median-extension, the crack 

extension at crack front point i is computed from the expression: 
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where  is the crack extension specified for the point with the median stress intensity 

factor range (Fig 6.5.85),  is the crack growth rate computed at point i using the specified 

growth rate model, and  is the crack growth rate computed at the crack front point 

with the median stress intensity value.  The crack growth rates at crack front points will be 

functions of the corresponding , R, and other growth model parameters.  

 

 

 

Figure 6.5.85  Computed extension based on specified median extension. 

 

 

Note that the selection of the reference 

 

K  value is arbitrary.  The maximum, minimum, and 

average 

 

K  are reasonable values to consider.  The median value is used by default in 

FRANC3D because experience shows that the maximum and minimum values frequently occur 

where a crack front meets a free surface where the accuracy of the computed stress intensity 

factors are known to be least accurate.   

 

In some cases, the inaccuracy of these maximum and minimum values can lead to a very 

unintuitive relationship between the reference specified amount of crack extension and the actual 

predicted crack front.  In extreme cases, inaccurate maximum and minimum values can have a 

significant impact on the average value leading to an unintuitive behavior for this measure also.   

 

The scale node setting allows the user to alter the location of the specified extension.  The 

extensions are sorted from minimum to maximum, and the scale node can vary from 0 to 1. For 

example, setting the scale node to 1 means that the specified extension will be applied at the 

crack front location where the maximum extension is computed.  The ai are computed relative 

to this location (and its corresponding values SIF, growth rate, etc.). 
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The expression for crack extension at crack front point i using the specified cycles option is 

 

   

 

where N is the specified number of cycles and  is the crack growth rate computed at point 

i using the specified growth rate model. 

 

The specified number of applied cycles approach seems more intuitive than the specified median 

crack front extension approach for many analysts.  However, the fatigue crack growth models are 

highly nonlinear functions so trial-and-error might be required when using the specified cycles 

approach to find the number of cycles that does not give excessively large or small predicted 

crack extensions.  Excessively large values might give inaccurate results, while excessively small 

crack extensions might require many growth steps or, in some cases, might cause meshing 

problems. 

 

6.5.5.1  Multiple crack front fitting 

 

For a model with multiple crack fronts, there is an extra panel on the left side at the bottom, Fig 

6.5.86.  The Grow crack fronts pane allows one to turn off crack growth or to scale the extension 

for a particular crack front.  The growth of multiple crack fronts is treated in the same manner as 

a single crack front – all the SIFs for all the fronts are examined to find the median value and 

then all crack front extension is computed as described above.    

 

 

 

Figure 6.5.86  Crack growth extension and fitting options for multiple crack fronts. 
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6.5.5.2  Front fitting options 

 

The Front fitting pane includes options for curve fitting, fields for extrapolating the ends of the 

fitted curves, and the option to discard crack front points at either end.  The curve-fit options are:  

1) kink angle/extension poly, 2) fixed order poly, 3) multiple poly, 4) Hermitian, 5) cubic spline, 

6) moving poly, and 7) no smoothing.  These are described in the following sub-sections. 

 

The polynomial order for any of the poly-fitting options can be set in the fixed poly order field.  

The default order is 3.   

 

The ends of the fitted curves can be extrapolated to ensure that the curves intersect the model 

surface.  It is required that the crack surface geometry intersect the model surface.  New crack 

surface geometry is created between the current and new crack fronts.  FRANC3D tries to ensure 

that the curves are extrapolated far enough, but the user also can visually determine whether the 

extrapolation is sufficient (or too much). 

 

A set of points at either end of the crack front can be ignored.  If the end points cause problems 

in fitting or extrapolating, the user can ignore some of these end points.   

 

The Save .frt and .crk files option allows the user to save the new front points and the new crack 

geometry to a file before inserting it into the model.  The .frt file can be read using the Read 

Crack Growth wizard, which is described in Section 6.6.  The .crk file can be read using the 

Flaw From Files option, see Section 6.2. 

 

The Kink Angles and Extension buttons bring up plots of the computed kink angle, Fig 6.5.87 – 

left panel, and crack front extension, Fig 6.5.87 – right panel, along the crack front, respectively.   

 

 

  

Figure 6.5.87  Plots of kink angle and crack front extension along the crack front. 
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6.5.5.2.1 Kink Angle/Extension Poly Fit 
 

Using the kink angle and extension data, a best fit polynomial is fit through the kink-angle and 

extension data, using the polynomial order from the fixed poly order field.  The curve-fits can be 

extrapolated, and then new extrapolated crack front points are defined based on these and the 

existing crack front geometry.  

 

As an example, consider a penny-surface crack with the kink angle and extension from Fig 

6.5.87.  The initial crack boundary edges, the actual crack surface, which is shaded grey, the new 

front points as green dots, and the curve fit shown as a blue line are shown in Fig 6.5.88.  The 

black dots on the original crack front correspond to the fitted front points, where the extension 

and kink angle are applied to produce the new fitted points.  The kink angle and extension curves 

are extrapolated to compute these new end points that fall outside the model.  

 

 

Figure 6.5.88  New front fit based on kink angle and extension curve-fits. 

 

6.5.5.2.2 Fixed order poly through points 
 

The fixed order polynomial option is the simplest and the most used fitting option. A polynomial 

is fit through the new front points in Cartesian space based on a least-squares fit.  The order of 

the polynomial is provided in the fixed poly order field.  This polynomial can be extrapolated a 

small distance to make sure the new front intersects the model surface.  Best results are obtained 

with low order polynomials and limited extrapolation; if the crack front does not suit a simple 

polynomial, one of the other fitting options should be chosen. 

 

6.5.5.2.3 Multiple poly through points 
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For long shallow crack shapes, the multiple polynomial fit might be the best option.  This option 

uses three polynomials.  The number of points in the two end polynomials versus the middle 

polynomial can be adjusted using the multiple poly ratio.  The ends of the polynomials are 

blended, but kinks can be created so this option should be used with care. 

 

6.5.5.2.4 Hermitian closed poly 
 

The Hermitian polynomial is used for fitting closed crack fronts such as interior cracks.  It is not 

active if all cracks are open-ended surface cracks.  The Hermitian fit is performed using four 

equal segments; thus, it works best for circular shapes.  

 

6.5.5.2.5 Cubic spline 
 

A cubic spline fit can be used for crack fronts that do not allow for a simple low order 

polynomial fit.  A cubic spline will follow arbitrary curves.  The ends of the crack front are 

extrapolated using a linear segment through the end points for open-ended surface cracks. This 

option is comparable to the moving polynomial described next. 

 

6.5.5.2.6 Moving polynomial 
 

A moving polynomial fit uses the polynomial order given in the fixed poly order field.  A subset 

of the crack front points is used for successive curve fits, moving along the full crack front in 

increments from one end to the other.  Like the cubic spline fit, this option is good for arbitrary 

curves. The ends of the crack front are extrapolated using a linear segment through the end 

points for open-ended surface cracks. 

 

As an example of crack fronts that do not work well with a simple polynomial fit, consider the 

crack fronts in Fig 6.5.89.  Fig 6.5.90 shows these same crack fronts using a moving polynomial 

fit; comparable results can be obtained for cubic spline fits.   

 

For the left-side crack in Fig 6.5.89, an 8th order polynomial fits the data, but extrapolating such 

a high order polynomial does not work well; in this case the extrapolated curve does not intersect 

the model surface.  In the second example, a 12th order polynomial cannot capture the curve.   

 

Fig 6.5.90 shows a moving polynomial (or spline) fit that matches the data and provides 

extrapolated end points that are outside the model. 

 

For crack fronts with concave segments, new crack front points can overlap depending on the 

amount of extension.  The moving polynomial (and cubic spline) fits look for reversals in the 

crack front points, and points are discarded if this happens. 
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Figure 6.5.89  New front fit based on a simple polynomial fit. 

 

 

  

Figure 6.5.90  New front fit based on a moving polynomial fit. 

 

6.5.5.2.7 No smoothing 
 

The final fitting option removes all smoothing, but the ends can be extrapolated. The 

extrapolation of the ends is based on a simple fit through a small set of points at each end. 

 

 

 

6.5.6  Crack growth front template mesh 

 

The final crack growth display wizard panel, Fig 6.5.91, allows one to set the crack front mesh 

template parameters.  The model is displayed in the upper 3D model view window and the user 

can select a camera position that shows the template.  The lower third of the window contains 

one pane for the template parameters.   

 

Most of the template parameters and buttons are identical to those for inserting a new crack, see 

Section 6.1.21.  The template radius can be set as an absolute value or as a percentage of the 

crack extension; the choice should depend on the model and expected growth behavior.   
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Sections 8 and 9 of the Users Guide provide some guidance for setting the template radius and 

the crack growth increment. 

 

 

 

Figure 6.5.91  Crack growth - front mesh template. 
 

 

 

6.6  Read Crack Growth Wizard 
 

The Read Crack Growth wizard consists of two panels.  The first, Fig 6.6.1, allows the user to 

specify the file name containing the new crack front points.   
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Figure 6.6.1  Read new crack front - file import dialog. 

 

 

The format for this file is simply:  "x  y  z" ; one set of coordinates per line. 

 

The second panel, Fig 6.6.2, displays the new front points within the model and allows the user 

to specify the fitting, extrapolation, and template parameters.  The front fitting options and flaw 

template panes are like those described in Sections 6.5.5 – 6.5.6.  

 

The template is off in the left panel of Fig 6.6.2 so that the front points that were read from the 

file are visible; the template is turned on in the right panel. 

 

 

  

Figure 6.6.2  Read crack growth - display panel. 

 

 

 

6.7  Grow/Merge Cracks Wizard 
 

The Grow/Merge Cracks function is not fully completed yet.  The current implementation 

allows semi-co-planar cracks, whose advancing crack fronts intersect, to be merged to create a 
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single crack.  The initial dialogs for computing SIFs and setting crack growth parameters are as 

described in Sections 6.4 and 6.5.  The difference is seen when the crack growth is displayed, Fig 

6.7.1.  

 

The Growth & Merge dialog allows the user to adjust the extension (or cycles) to ensure the 

fronts intersect at a reasonable location to create a merged front.  The fitting options are limited 

to cubic spline and moving polynomials.  The ends of the curve must still intersect the model 

surface, so the user is able to adjust the amount of extrapolation.   

 

   

 

 

Figure 6.7.1  Grow/Merge Cracks – two co-planar cracks whose advancing fronts intersect. 

 

 

Select Next to define the template mesh for the merged front, Fig 6.7.2. The template mesh 

radius might need to be adjusted to obtain a reasonable mesh at the point where the fronts merge.  

Select Next to complete the process of merging and subsequent insertion and remeshing of the 

model.  The result should be a merged crack as shown in Fig 6.7.3. 

 

Section 8.4 of the Users Guide describes a current limitation to merging.  
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Figure 6.7.2  Grow/Merge Cracks – two co-planar crack fronts merged with template mesh. 

 

 

Figure 6.7.3  Two co-planar cracks merged. 
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6.8  Edit Crack Geometry 
 

The Edit Crack Geometry dialog, Fig 6.8.1, provides some options to display and modify the 

crack surface geometry.  The crack geometry along with the uncracked FE model is displayed.  

The right-side display options are the same as the main FRANC3D window.  The left side pane 

provides options for modifying the current crack geometry.   

 

The Replace crack with edited version button will replace the crack geometry, currently 

attached to the model, with the edited geometry. If there are problems when trying to grow the 

crack, editing the geometry might resolve these and allow the crack to grow. 

 

 

 

Figure 6.8.1  Edit Crack Geometry dialog. 

 

 



 178 

6.8.1 Reset Original Crack Geometry 

 

The Reset Original Crack Geometry button resets the geometry to the original crack geometry 

that is first displayed in the dialog. 

 

 

6.8.2 Read .crk file 

 

The Read .crk file option allows one to read any .crk file that has been saved, where the .crk file 

contains the Bezier triangular patches and a list of point IDs (from these patches) that define the 

crack front.  

 

6.8.3 Add face to crack 

 

The Add face to crack option allows one to create a new triangular Bezier patch.  Use the Pick 

Points button to collect two corner points of the triangular patch; the points must already exist.  

Once the points are collected, use the Add button to create the patch. 

 

6.8.4 Delete face from crack 

 

The Delete face from crack option allows one to remove a triangular Bezier patch.  Use the Pick 

Face button to collect the patch, and then use the Delete button to remove the patch. 

 

6.8.5 Split face into four 

 

The Split face into four option allows one to divide a triangular Bezier patch into four patches.  

Use the Pick Face button to collect the patch, and then use the Do Split button to divide the 

patch. 

 

6.8.6 Merge duplicate points 

 

The Merge duplicate points option allows one to merge two geometry points that have identical 

coordinates.  Use the Pick Point button to collect the points, and then use the Do Merge button 

to remove the duplicate. 

 

6.8.7 Split boundary edge 

 

The Split boundary edge option allows one to divide a boundary edge in half.  Use the Pick 

Edge button to collect the edge, and then use the Do Split button to split the edge. 

 

6.8.8 Add edge to front 

 

The Add edge to front option allows one to add a boundary edge to the crack front.  Use the Pick 

Edge button to collect the edge, and then use the Do Add button to add the edge to the front.  

The edge should be connected to an existing front edge. 
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6.8.9 Map library flaw 

 

The Map library flaw option allows one to map a library flaw shape onto the current geometry.  

This allows you to create a non-planar library flaw shape if the existing crack surface is non-

planar.   

 

6.8.10 Flatten to plane 

 

The Preview flatten to plane option allows one flatten the current geometry to a planar crack.  A 

least-squares planar fit of the crack surface is generated and displayed when the box is checked.  

The Do Flatten button is used to replace the crack geometry with the planar geometry.  The 

boundary of the planar geometry can be stretched to make sure that it intersects with the model 

surfaces. 

 

6.8.11 Coarsen crack geometry 

 

The Preview coarse geometry option allows one to reduce the number of triangular Bezier 

patches in the current crack.  This option retains the non-planar surface.  The boundary is not 

coarsened.    

 

6.8.12 Smooth crack geometry 

 

The Preview smooth geometry option allows one to improve the Bezier triangle shapes.  The 

boundary is not modified. 

 

6.8.13 Advance current front(s) 

 

The Advance current crack front(s) option allows one to extend the crack geometry by reading a 

file that contains the xyz coordinates of the extended front. 

 

6.8.14 Save crack to file 

 

The Save crack to file option allows one to save the crack geometry to either a .crk or a .stl file. 

The .stl file will not include the crack front information. 

 

6.8.15 Feature Display 

 

The Feature Display pane has options to turn on/off display of various crack geometry features. 

The overlaps, duplicate, and face kinks options can be used to hilght problems in the crack 

geometry. 
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6.9  SIFs Along a Path 
 

The SIFs along a Path dialog, Fig 6.9.1, allows the user to display SIF history data.  The crack 

surface and crack fronts are displayed on the left-side, and the SIF history and path options are 

displayed on the right-side of the dialog.  The tabs along the top of the XY plot allow one to 

display the three SIF modes (KI, KII and KIII) as well as the J-integral and T-stress values. The 

Define Path and Export tabs are described in the following sub-sections. 

 

Above the tabs is a drop-down menu that allows the user to specify the load step for which SIF 

history is plotted. If there is only one load step, the drop-down menu is inactive.  This is like the 

drop-down menus in the SIF plot dialog (see Section 6.4).  The substeps dropdown is not 

available here; only results for the last substep for each load step can be displayed.   

 

The crack front is specified from the Path tab. 

 

 

 

Figure 6.9.1  SIFs along a path dialog. 

 

 

6.9.1  Define Path Tab 

 

Traditional fatigue lifing methodologies require a SIF history that consists of a single valued 

stress intensity factor (K) and a single valued crack size (a) for each crack increment.  

Developing such a "K-history" is straightforward for a 2-D analysis but is more complicated for 

3D analyses.  In 3D, one has a distribution of K values along a crack front, and there might not 

be an obvious crack dimension that uniquely characterizes the crack “length”. 

 

Three different Path Type algorithms are available in the Define Path tab, Fig 6.9.2.  The results 

for the three algorithms are illustrated below using three different crack growth simulations.  It 
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should be noted that while the crack growth might appear planar in these three examples, the 

algorithms work for non-planar growth. 

 

 

 

Figure 6.9.2  Define path tab. 

 

6.9.1.1  Constant Normalized Distance 

 

The first algorithm uses a constant, user-specified, normalized distance along the crack fronts.  

Fig 6.9.3 shows the computed paths for 50% normalized distance.  The figure shows that this 

approach works very well for the first crack and is reasonable for the third crack.  For the middle 

crack, however, the path is sinuous; this can be even more pronounced for crack fronts that 

transition from corner- to through-cracks. 
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Figure 6.9.3  Computed K paths for a constant normalized distance of 50%. 

 

 

6.9.1.2  Nearest Point on Next Front 

 

The second algorithm is a modification of the first approach.  The analyst selects a point on the 

initial crack front.  The algorithm then searches for the nearest point on the next crack front and 

makes this the next point in the history.  The process is repeated for all remaining crack fronts.  

The Ks in the history are the interpolated values at the "nearest points", and the crack length is 

the distance from the crack "origin" to the initial crack front point plus the (straight line) 

distances between successive "nearest points". 

 

This algorithm is illustrated in Fig 6.9.4.  For all three cracks, the path was started at locations of 

10%, 20%, ... 90% along the initial crack front.  The algorithm performs very well for the first 

crack.  For the middle crack, some of the paths converge into one path at 10% of the distance 

along the crack front.  This is because of the path constraints, which are described in Section 

6.9.1.2.  For the third crack, most of the paths merge due to these path constraints. 

 

 

     

 

 
 

Figure 6.9.4  Computed K paths using nearest next point.  Paths are at 10% increments with a 

10% and 90% minimum and maximum threshold. 
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6.9.1.3  Intersection of Fronts with a Plane 

 

The third algorithm defines a plane nominally perpendicular to the crack surface and gives the 

path as the points where the crack fronts intersect the plane.  This algorithm is illustrated for the 

first of the three cracks above in Fig 6.9.5.  It is not clear how one would apply this algorithm to 

the third crack in Fig 6.9.4. 

 

  

Figure 6.9.5  Computed plane intersection points for a crack. 

 

 

6.9.1.3.1  Start: Step and Final: Step 
 

For crack fronts that might split, merge, or disappear, there is the option to specify both the 

starting and ending crack step number and the crack front number, if there is more than one 

front, Fig 6.9.6.   

 

6.9.1.3.2  Search from final front 
 

The Search from final front option is active for the Nearest Point on Next Front.  The algorithm 

starts at the last front and searches ‘backwards’ for the nearest point on the previous front. 
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Figure 6.9.6  SIF path starting at step 9 for front 2. 
 

6.9.1.4  Path Constraints 

 

There is a user-settable threshold that prevents the computed paths from getting too close to the 

free surfaces where the accuracy of the computed stress intensity factors is questionable.  The 

user can set both the minimum and maximum thresholds in the dialog. 

 

6.9.1.5  Path Curve Fitting 

 

Path curve fitting provides a best fit, in a least-squares sense, through the path computed by one 

of the three algorithms.  Fig 6.9.7 shows the least-squares fit to the paths shown in Fig 6.9.3.  A 

quadratic curve was used for the first crack, and as expected, there is modest improvement in the 

path for this case.  A cubic curve was used for middle crack, which yields a path that is 

aesthetically more pleasing.  A fifth order curve was used for the third crack and gives some 

improvement over the initial computed path by smoothing the kinks. 

 

      

 
 

 

Figure 6.9.7   Computed least-squares fits to the paths of Fig 6.9.3. 
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6.9.1.6  Crack Starting Information 

 

The crack starting information has two options: crack start point and initial crack length. Setting 

either of these provides a starting point for computing the total crack path length. 

 

 

6.9.2  Export Tab 

 

The Export tab, Fig 6.9.8, allows one to save the SIF data to a file.  The normalized coordinates 

seen in the XY plot can be exported to regenerate the XY plots.  The Cartesian coordinates of the 

mid-side nodes along the crack front along with the crack front local basis can also be exported.  

One could use this information to compute crack growth or to plot crack front geometry outside 

of FRANC3D. 

 

 

 

Figure 6.9.8  SIF history dialog – Export tab. 

 

 

6.9.3 File/Data/Axes Menu 

 

Fig 6.9.1 shows a menu bar with three menu items: File, Data and Axes.  These menus are the 

same as the menus for the SIF Plot dialog (see Section 6.4.2.1).  
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6.10  SIFs For All Fronts 
 

The SIFs for all Fronts dialog, Fig 6.10.1, allows the user to display SIF data for all fronts in a 

single plot.  The crack front lines are displayed in the left-side model window, and the SIFs for 

all crack fronts are displayed on the right-side of the dialog.  The tabs along the top of the XY 

plot are the same as the tabs for SIFs Along a Path (see Section 6.9).   

 

There are two drop-down menus that allow the user to specify the load step and crack front for 

which SIF data is plotted. The substeps dropdown is not available here; only results for the last 

substep for each load step can be displayed.  The Crack Front drop-down is active if there are 

multiple cracks in the model. 

 

 

 

Figure 6.10.1  SIFs for all fronts dialog. 

 

 

6.10.1  Export Tab 

 

The Export tab displays the dialog in Fig 6.10.2; this is only slightly different from that in Fig 

6.9.3.  There is an option to reverse the order of the points, so that data is exported going from 

point B to A.  

 

 

6.10.2 File/Data/Axes Menu 

 

Fig 6.10.1 shows a menu bar with three menu items: File, Data and Axes.  These menus are the 

same or like the menus for the SIF Plot dialog (see Section 6.4.2.1).  
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Figure 6.10.2  Export tab for SIFs for All Fronts dialog. 

 

 

 

7.  Wizards and Dialog Boxes for Loads Menu 
 

The wizards and dialog boxes for the Loads menu options are described in this section.  

 

 

7.1  Crack Face Pressure/Traction 
 

The Loads Crack Face Pressure/Traction (CFT) option allows one to define crack face 

pressures or tractions.  This capability is often used to simulate residual stresses.  It can also be 

used in a sub- modeling approach where the sub-model containing the crack is analyzed using 

crack face tractions based on the stresses from an uncracked “global” model. 

 

The first panel of the wizard is shown in Fig 7.1.1.  Use the Add button to create a new entry in 

the list.  Once an entry has been added, it can be edited or deleted by selecting the name and then 

the Edit or Delete button. 

 

The Crack Face Traction/Residual Stress Type panel is displayed when the Add button is 

clicked, Fig 7.1.2; it allows one to choose the type of crack face loading.  The choices are:  1) 

Constant crack face pressure, 2) 1-D Radial residual stress distribution, 3) 2-D Radial residual 

stress distribution, 4) Surface treatment residual stress distribution, and 5) Residual stress defined 

on a mesh.  These will be described in more detail below.  
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Figure 7.1.1  Crack Face Tractions – top level dialog. 

 

 

The Advanced button at the bottom allows one to specify whether the CFT is applied in a new 

load step, after all the original FE load steps are applied, or added to one of the existing FE load 

steps.  The dialog is slightly different for ABAQUS compared with ANSYS and NASTRAN; the 

dialog display is based on the input FE model that is being cracked/analyzed. 

 

 

 

Figure 7.1.2  Crack Face Tractions – type dialog. 

 

 

7.1.1  Advanced button 

 

The Advanced options dialog is shown in Fig 7.1.3.  The left image is for ABAQUS models, and 

the right image is for ANSYS and NASTRAN models.  The default is to create a new load step 

for the CFT.  However, one can change this so that the CFT is added to an existing load step.  If 

the Add to existing load step is chosen, the user can then select the load step that will be used.  
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For ABAQUS, CFT can be applied using an amplitude function so that the CFT is applied the 

same as the existing loads.  However, there are limitations; see Section 12 of the User’s Guide. 

 

 

   

Figure 7.1.3  Advanced options dialog to set the analysis load step (left side is for ABAQUS). 

 

 

7.1.2  Constant Crack Face Pressure Panel 

 

The constant crack face pressure panel allows one to specify a uniform pressure on the crack 

face, Fig 7.1.4.  A positive pressure value will tend to open the crack.  If there are no nodal 

temperatures, the Next button will return the display to the top-level panel (see Fig 7.1.1).  If 

there are nodal temperatures, the Next button will display the Set Temperature dialog, Fig 7.1.5. 

 

The temperature for the crack face traction load step can be set to a Constant value, such as the 

reference temperature, or it can be set based on the last load step, or it can be set from an external 

source.  The External data option allows one to specify an ABAQUS .inp, ANSYS .cdb or 

NASTRAN .bdf (or .nas or .dat) file depending on the original model type.  

 

The Set Temperature panel is the same for all crack face traction types.  The CFT and effects of 

temperature are described in more detail in Section 12 of the User’s Guide. 
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Figure 7.1.4  Constant Crack Face Pressure panel. 

 

 

 

Figure 7.1.5  Set Temperature dialog. 
 

 

 

7.1.3  1-D Radial Residual Stress Distribution Panel 

 

The 1-D radial residual stress distribution panel allows one to specify a radial distribution of 

stress that can be applied to the crack face, Fig 7.1.6.  The stress varies along a radius from some 

origin.  The user can specify the distribution axis as well as the axis offset.  

 

The distance vs stress data can be entered into the dialog or read from a file, using the Read 

From File button.  The file is a simple ASCII text file with lines of data that matches the dialog. 

Use the Save To File button to save the data from the dialog to a .txt file.  The Read Only option 

disables the interactive editing of the data in the table. 
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Figure 7.1.6  1-D radial residual stress distribution dialog. 

 

 

For example, consider a corner crack in a brick, Fig 7.1.7 – left panel.  The crack has a radius of 

2.0 and the corner is located at x=0, y=5, and z=5.  A 1-D radial distribution is defined, Fig 7.1.9 

– right panel, with the distribution axis set to y and the axis offset defined as x=0 and z=5.  The 

crack face traction distribution is shown in Fig 7.1.8 – left panel.  To visualize the pressure that 

is applied to the crack, the ANSYS color contours for the stress in the y-direction on one side of 

the crack are shown in Fig 7.1.8 – right panel.  This image shows the radial pattern of the 

pressures with the origin at the crack corner.  

 

 

  

Figure 7.1.7  A corner crack in a brick (left panel) with a 1-D radial residual stress (right panel). 
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Figure 7.1.8  A 1-D radial residual stress distribution (left panel) applied to the corner crack and 

corresponding y-stress color contours in ANSYS (right panel). 

 

 

7.1.4  2-D Radial Residual Stress Distribution Panel 

 

The 2-D radial residual stress distribution panel allows one to specify a stress distribution that 

varies in two directions: axial and radial, Fig 7.1.9.  The stress varies with radius from some 

origin. Use the Read Data From File button to import the data into the dialog. 

 

 

 

Figure 7.1.9  2-D radial residual stress distribution panel. 
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The data in the file should be arranged in the same way as it appears in the dialog, Fig 7.1.10.  

There is a blank space at the top left. 

 

 

 

Figure 7.1.10  2-D radial residual stress data from file. 

 

 

The Save Data To File button will save the data from the dialog to a .txt file.  The dialog is set 

as read-only, and there is no option to switch this off; you should edit the file instead.  

 

 

7.1.5  Surface Treatment Residual Stress Distribution Panel 

 

The surface treatment residual stress distribution panel, Fig 7.1.11, allows one to specify a stress 

distribution that varies in a direction that is normal to a surface that has been retained as a 

“residual stress surface” when reading the FE file.  The stress varies with distance from the 

surface.   

 

 

 

Figure 7.1.11  User defined surface treatment residual stress panel. 
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Data can be imported using the Read From File button; the file is ASCII text and arranged in 

the same way as shown in the table with each line containing a distance and a stress value. The 

Save To File allows the data to be saved to a .txt file.  The table can be set to read-only using the 

Read Only option. 

  

 

After entering the stress versus distance, the user presses Next to select the treated surface, Fig 

7.1.12.  This dialog is the same as that for selecting surfaces to be retained when importing a FE 

model (see Section 4.5). 

 

 

 

Figure 7.1.12  User defined surface treatment – select surface dialog. 

 

 

 

As an example, a brick model is defined with the top surface (positive y-axis) defined as a 

“treated_surface”, Fig 7.1.13 – left panel.  The stress distribution shown in Fig 7.1.11 is applied 

as the surface treatment crack face traction.  The distribution acts normal to the 

“treated_surface”, and distance will be measured in the -y direction.  The resulting crack face 

traction distribution on the crack shown in Fig 7.1.13 (left panel) can be visualized using 

ANSYS, Fig 7.1.13 – right panel.  
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Figure 7.1.13  Example of a surface treatment residual stress crack face traction.  

 

 

There are a few things that will be noted here.  Consider the crack shown in the left panel of Fig 

7.1.14 and the residual stress distributions shown in the right panel of Fig 7.1.12.  First, if the 

nodes on the crack surface are at a depth that is greater than the residual stress, no crack face 

tractions are computed.  Using the ‘a’ distribution, the lower third of the crack will not have 

crack face tractions.  Second, if the mesh on the crack surface is coarse compared to the residual 

stress distribution, the computed crack face traction will not adequately capture the residual 

stress distribution. Based on the coarse mesh shown in the left panel of Fig 7.1.15, the computed 

traction value at the node indicated by the red circle, using the ‘a’ distribution from Fig 7.1.14, 

would be close to zero.  If a pseudo-refined mesh is defined, as in the middle and right panels of 

Fig 7.1.15, then the ‘a’ distribution can be captured and appropriately distributed onto the nodes 

of the actual coarse mesh.  Ideally, one would use a suitably refined mesh in the model to avoid 

this problem. 

 

 

   

Figure 7.1.14  Surface treatment residual stress applied as crack face traction up to the defined 

depth of the distribution.  

 

 

   

Figure 7.1.15  Surface treatment residual stress applied as crack face traction with automatic 

pseudo-mesh refinement to capture the distribution. 
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7.1.6  Mesh-Based Stress Distribution Panel 

 

The mesh-based stress distribution panel allows one to specify a stress distribution based on a FE 

mesh and stress file, Fig 7.1.16.  The user chooses the mesh and associated stress file; normally, 

this is an uncracked model.  FRANC3D queries this data to compute tractions on the crack face.  

 

The mesh and associated stress results do not have to correspond exactly with the model used for 

crack insertion, however, the mesh and stress must occupy the same physical space as the crack.  

At each node on the crack surface mesh, FRANC3D queries the stress-mesh to find the element 

and associated nodes that contains the point, and then retrieves the stress for these nodes.  The 

element shape functions are used to interpolate the stress to the crack surface node location.  

 

For mesh based CFT, one can apply the results for any of the three analysis codes to the current 

model.  For example, one can apply ANSYS stress to an ABAQUS crack growth simulation. 

 

 

 

 

Figure 7.1.16  Mesh based stress distribution panel. 

 

 

If the chosen FE model (and results) contain multiple load steps, the user should specify the ID 

for the load step (and for the substep if there is more than one per load step).  The -1 in the 

substep field indicates that FRANC3D will use the last substep.   

 

The stress can be scaled also.  A user might instead choose to scale the SIFs that result from the 

CFT load step, but if the CFT is added to an existing load step, then the scaling might need to be 

applied here. 
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8.  Wizards and Dialog Boxes for Analysis Menu 
 

The wizards and dialog boxes for the Analysis menu options are described in this section.  

 

 

8.1  Static Crack Analysis 
 

The Static Crack Analysis menu item allows one to set up and run a static (current crack 

configuration with no crack growth) deformation analysis.  One would use this, for example, if 

one had inserted a crack into a body and wanted to compute stress-intensity factors for this crack 

without performing any crack growth.  The ANSYS, ABAQUS and NASTRAN wizard panels 

are discussed below; the wizard panels are similar for all the analysis codes, but there are some 

differences as will be noted below. 

 

8.1.1  Fdb File Name Panel 

 

The first panel, Fig 8.1.1, allows one to specify the name of the files.  The base file name is used 

for all files created for this static analysis, with different file extensions applied.  The .fdb 

extension will be added if the user does not type it into the File Name field.  The .fdb file is the 

FRANC3D restart file and stores information about the imported FE model, the flaw geometry, 

and the crack growth data.   

 

Note that the uncracked file name must not be re-used here; the uncracked model is needed for 

each step of crack growth and should not be overwritten.  

 

 

 

Figure 8.1.1  Fdb file name dialog. 
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8.1.2  Analysis Code Panel 

 

The user might be asked to choose the analysis code, Fig 8.1.2.  ANSYS, ABAQUS or 

NASTRAN can be chosen, and subsequent panels will differ slightly.  In most cases, this dialog 

will be skipped, and the analysis code will be selected based on the original imported model 

type. 

 

 

 

Figure 8.1.2  Analysis code panel. 

 

 

8.1.3  ANSYS Options Panel 

 

The dialog in Fig 8.1.3 allows one to set options and analysis parameters for ANSYS.   

 

The top section contains the ANSYS executable file name and license string.  These values 

should be set in the Preferences (see Section 5.2) but can be modified or set here.  A Python 

script can be executed on the .cdb file prior to running ANSYS; the Python executable can be set 

here also. 

 

The second section allows one to edit default settings; see Section 8.1.3.1.  

 

The third section allows the user to select the global model to connect to the local cracked model.  

If there is no global model, this option should be unchecked.  The global model file name should 

be filled automatically based on the original FE model import. 

 

The fourth section allows the user to specify whether crack face traction (CFT) and crack face 

contact (CFC) conditions are applied.  If CFTs are defined (see Section 7), the Apply crack face 

tractions should be checked automatically.   

 

Crack face contact conditions can be applied if the crack will be subjected to compressive loads.  

If the Define crack face contact option is checked, the Contact button is activated; see Section 

8.1.3.2. 
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Figure 8.1.3  ANSYS options and analysis parameters. 

 

 

The last section contains the View/Edit Command button, which will be described in Section 

8.1.5.  This option is inactive if the Connect to global model is selected, as it will be active in the 

subsequent panel. 

 

8.1.3.1  ANSYS Edit Defaults 

 

The ANSYS Local Model Output dialog, Fig 8.1.4, allows the user to adjust some of the default 

settings.   

 

The Output Results and Extract results options limit the amount of data that is extracted and 

saved to the .dtp file. Results for the crack front mesh template nodes are required for computing 

SIFs.  To display the deformed shape in FRANC3D (see Section 11.1), the results for the local 

model should be extracted, and this is the default.   

 

Crack front elements typically will be singular quarter-point wedge elements, but these can be 

converted to regular wedge elements with mid-side nodes if needed.  Blunted brick elements can 

be written instead but the support for these elements is limited. 

 

Commands to tell ANSYS to compute the contour integral can be included in the .cdb file that 

FRANC3D writes.  Either the J-integral or the material-force option can be selected. 
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FRANC3D can import the contour integral results from the ABAQUS .dat file; see the 

Advanced menu.   

 

 

 

 

Figure 8.1.4  ANSYS edit defaults dialog. 
 

8.1.3.2  ANSYS Crack Face Contact 

 

The ANSYS Crack Face Contact dialog, Fig 8.1.5, allows the user to set crack face contact 

options.  The material and real constant ids should not conflict with any of the data that exists in 

the original model.  The parameters in the dialog are described in the ANSYS documentation.  
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Figure 8.1.5  ANSYS crack face contact dialog. 

 

 

8.1.4  ANSYS local/global model connection Panel 

 

If the Connect to global model option (see Fig 8.1.3) is selected, the global model file must be 

set, Fig 8.1.6.  The Browse button can be used to find the file.  Note that the check box and the 

global model filename are filled automatically, based on the initial FE model import. 

 

 

 

Figure 8.1.6  ANSYS connect to global model box. 

 

 

If the Connect to global model option is selected, the Finish button in Fig 8.1.3, switches to a 

Next button.  The next panel, Fig 8.1.7, defines how the local and global models will be 

combined.  Note that the user cannot proceed to the next panel if the Connect to global box is 

checked and the Global model filename has not been entered.  
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Figure 8.1.7  ANSYS local/global model connection panel. 

 

 

The simplest method to connect a local crack model to a global model is through node-merging.  

If the user retained surface mesh facets on the cut-surfaces for the local model, then these 

surfaces can easily be glued together by merging nodes.  Alternatively, constraint equations or 

contact conditions can be defined between the cut-surfaces of the local and global models.  

FRANC3D will generate the necessary commands to join the local and global model portions 

together.   

 

Selecting the Constraint equations option activates the Constraint button; see Section 8.1.4.1.  

 

Selecting the Contact conditions option activates the Contact button; see Section 8.1.4.2.  

 

Extra local/global contact/constraint can be defined (see lower section of Fig 8.1.7) for surfaces 

other than the crack faces and the cut-surfaces; see Section 8.1.4.3.  

 

8.1.4.1  ANSYS Constraint 

 

The ANSYS Constraint dialog, Fig 8.1.8, allows the user to set the constraint connection options 

between the local and global model portions.  Typically, all three (displacement) components 

will be selected, but the user has the option to not select a component. 
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Figure 8.1.8  ANSYS constraint connection dialog. 

 

8.1.4.2  ANSYS Contact 

 

The ANSYS Contact dialog, Fig 8.1.9, allows the user to set contact connection options between 

the local and global model portions.  This dialog is slightly different from the crack face contact 

dialog; there is no option to include the crack front nodes. 

 

 

 

Figure 8.1.9  ANSYS contact connection dialog. 
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8.1.4.3  ANSYS Extra Connection 

 

Additional local/global connections can be defined (see Fig 8.1.7).  Click the Add Connection 

button to display the dialog in Fig 8.1.10.  The connection can be made using contact or 

constraint.  The contact and constraint dialogs shown in Sections 8.1.4.1-2 are reused here, 

depending on the chosen connection type.  The two mate surfaces from the global and local 

model must be selected by the user. 

 

To delete an extra connection, highlight the connection name and click the Delete Connection 

button. 

 

 

Figure 8.1.10  ANSYS contact connection dialog. 

 

8.1.4.4  ANSYS Command Line Panel 

 

If the user selects the View/Edit Command button in Fig 8.1.7, the ANSYS command is 

displayed in a separate dialog, Fig 8.1.11.  The command line can be edited if desired.  

Typically, users will set the ANSYS executable and parameters in the Preferences rather than 

editing this command. Editing this command line is not “permanent”, but the edits should be 

carried forward for subsequent static analyses of the current model. 

 

 

 

Figure 8.1.11  ANSYS Command Line panel. 

 



 205 

8.1.4.5  ANSYS Write Files but DO NOT run analysis 

 

In some cases, the user might want to write the analysis files from FRANC3D without running 

ANSYS.  The Write files… option (see Fig 8.1.7) will cause FRANC3D to write all the analysis 

files.   

 

A .txt file is written along with the .cdb and .fdb files; the ANSYS command is written to this .txt 

file for reference.  Note that if one sends this file to a different computer for analysis, the .dtp file 

that is extracted must be retrieved so that FRANC3D can compute SIFs (see Section 4.7).  

 

8.1.5  ABAQUS Options Panel 

 

If ABAQUS is the solver, the user can set options and analysis parameters for ABAQUS, Fig 

8.1.12.  The first pane contains the ABAQUS executable file name.  This should be set in the 

Preferences (see Section 5.2) but can be modified or set here.  A Python script can be executed 

on the .inp file prior to running ABAQUS.  The Python executable can be set here also. 

 

The second pane allows one to edit default settings; see Section 8.1.5.1.  

 

The third pane allows the user to select the global model to connect to the local cracked model.  

If there is no global model, this option should be unchecked. The global model file name should 

be filled automatically based on the original FE model import. 

 

The fourth section allows the user to specify whether CFT and CFC are applied.  If CFTs are 

defined (see Section 7), the Apply crack face tractions should be checked automatically.   

 

Crack face contact conditions can be applied also if the crack will be subjected to compressive 

loads.  If the Define crack face contact option is checked, the Contact button is activated; see 

Section 8.1.5.2. 

 

 

 



 206 

 

Figure 8.1.12  ABAQUS options panel. 

 

 

The final pane contains the button View/Edit Command, which will be described in Section 

8.1.6.  This option is inactive if the Connect to global model is selected, as it will be active in the 

subsequent panel. 

 

8.1.5.1  ABAQUS Edit Defaults 

 

The ABAQUS Local Model Output dialog, Fig 8.1.13, allows the user to adjust some of the 

default settings.   

 

The results for the last frame of each load step are extracted by default, but the user can choose 

to extract results for every frame (substep).  The Extract results option limits the amount of data 

that is extracted and saved to the .dtp file. Results for the crack front mesh template nodes are 

required for computing SIFs.  To display the deformed shape in FRANC3D (see Section 11.1), 

the results for the local model should be extracted, and this is the default.  

 

Crack front elements typically will be singular quarter-point wedge elements, but these can be 

converted to regular wedge elements with mid-side nodes if needed.  In some cases, when using 

crack face contact, quarter-point nodes will cause ABAQUS errors; near-quarter point nodes can 

be used instead in this case – the error that is introduced by this change on node position should 

be small.  Blunted brick elements can be written instead but the support for these elements is 

limited. 
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Commands to compute contour (J, C, K or T) integrals can be included in the ABAQUS file.  

Note that ABAQUS uses collapsed bricks rather than singular wedge elements for the contour 

integral.   

 

FRANC3D is capable of computing J-integral for elasto-plastic ABAQUS models. 

 

FRANC3D can import the contour integral results from the ABAQUS .dat file; see the 

Advanced menu.   

 

 

Figure 8.1.13  ABAQUS edit defaults dialog. 

8.1.5.2  ABAQUS Crack Face Contact 

 

The ABAQUS Crack Face Contact dialog, Fig 8.1.14, allows the user to set crack face contact 

options.  A new Surface interaction name must be defined, and it should not conflict with any of 

the data that exists in the original model; the Accept button will be activated once a surface 

interaction name is added.  Parameters in this dialog are described in the ABAQUS 

documentation.  
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Figure 8.1.14  ABAQUS crack face contact dialog. 

 

 

8.1.6  ABAQUS local/global model connection Panel 

 

If the Connect to global model option (see Fig 8.1.12) is selected, the global model file must be 

set, Fig 8.1.15.  The Browse button can be used to find the file.  Note that the check box and the 

global model filename are filled automatically, based on the initial FE model import. 

 

 

 

Figure 8.1.15  ABAQUS connect to global model box. 

 

 

If the Connect to global model option is selected, the Finish button in Fig 8.1.12, switches to a 

Next button.  The next panel, Fig 8.1.16, defines how the local and global models will be 

combined.  Note that the user cannot proceed to the next panel if the Connect to global box is 

checked and the Global model filename has not been entered.  
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Figure 8.1.16  ABAQUS local/global model connection panel. 

 

 

The simplest method to connect a local crack model to a global model is through node-merging.  

If the user retained surface mesh facets on the cut-surfaces for the local model, then these 

surfaces can easily be glued together by merging nodes.  Alternatively, constraint equations or 

contact conditions can be defined between the cut-surfaces of the local and global models.  

 

Selecting the Constraint equations option activates the Constraint button; see Section 8.1.6.1.  

 

Selecting the Contact conditions option activates the Contact button; see Section 8.1.6.2.  

 

An extra check box allows the user to switch the master and slave pairing; the default is to use 

the Global as master. 

 

Extra local/global contact/constraint can be defined (see lower section of Fig 8.1.16) for surfaces 

other than the crack faces and the cut-surfaces; see Section 8.1.6.3.  

 

8.1.6.1  ABAQUS Constraint 

 

The ABAQUS Constraint dialog, Fig 8.1.17, allows the user to set constraint connection options 

for the local and global model portions.   
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Figure 8.1.17  ABAQUS constraint connection dialog. 

 

8.1.6.2  ABAQUS Contact 

 

The ABAQUS Contact dialog, Fig 8.1.18, allows the user to set contact connection options for 

the local and global model portions. This dialog is mostly the same as that for CFC, but in this 

case the user is allowed to select from existing Surface interaction names. 

 

 

 

Figure 8.1.18  ABAQUS contact connection dialog. 

 

 

8.1.6.3  ABAQUS Extra Connection 

 

Additional local/global connections can be defined (see Fig 8.1.16).  Click the Add Connection 

button to display the dialog in Fig 8.1.19.  The connection can be made using contact or 

constraint.  The contact and constraint dialogs shown in Sections 8.1.6.1-2 are reused here, 



 211 

depending on the chosen connection type.  The two mate surfaces from the global and local 

model must be selected by the user. 

 

To delete an extra connection, highlight the connection name and click the Delete Connection 

button. 

 

 

 

Figure 8.1.19  ABAQUS contact connection dialog. 

 

8.1.6.4  ABAQUS Command Line Panel 

 

If the user selects the View/Edit Command button in Fig 8.1.16, the ABAQUS command is 

displayed in a separate panel, Fig 8.1.20.  The command line can be edited if desired. Typically, 

users will set the ABAQUS executable and parameters in the Preferences rather than editing this 

command. Editing this command line is not “permanent”, but the edits should be carried forward 

for subsequent static analyses of the current model. 

 

 

 

Figure 8.1.20  ABAQUS Command Line panel. 

8.1.6.5  ABAQUS Write Files but DO NOT run analysis 
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In some cases, the user might want to write the analysis files from FRANC3D without running 

ABAQUS.  The Write files… option (see Fig 8.1.16) will cause FRANC3D to write all the 

analysis files.   

 

A .txt file is written along with the .inp and .fdb files; the ABAQUS command is written to this 

.txt file for reference.  Note that if one sends this file to a different computer for analysis, the .dtp 

file that is extracted must be retrieved so that FRANC3D can compute SIFs (see Section 4.7).  

The .dtp file is extracted from the ABAQUS .odb file by running the command:  

 

abaqus python writeDtpFile.py 
 

The writeDtpFile.py is written by FRANC3D along with the other restart/analysis files. 

 

 

 

8.1.7  NASTRAN Options Panel 

 

If NASTRAN is the solver, the user can set options and analysis parameters for NASTRAN, Fig 

8.1.21.  The first pane contains the NASTRAN executable file name.  This should be set in the 

Preferences (see Section 5.2) but can be modified or set here. A Python script can be executed on 

the .bdf file prior to running NASTRAN.  The Python executable can be set here also. 

 

The second pane allows one to edit default settings; see Section 8.1.7.1.  

 

The third pane allows the user to select the global model to connect to the local cracked model.  

If there is no global model, this option should be unchecked. The global model file name should 

be filled automatically based on the original FE model import. 

 

The fourth section allows the user to specify whether CFT and CFC are applied.  If CFTs are 

defined (see Section 7.2), the Apply crack face tractions should be checked automatically.   

 

Crack face contact conditions can be applied also if the crack will be subjected to compressive 

loads.  If the Define crack face contact option is checked, the Contact button is activated; see 

Section 8.1.7.2. 

 

The final pane contains the button View/Edit Command, which will be described in Section 

8.1.8.  This option is inactive if the Connect to global model is selected, as it will be active in the 

subsequent panel. 
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Figure 8.1.21  NASTRAN options panel. 

 

 

8.1.7.1  NASTRAN Edit Defaults 

 

The NASTRAN Local Model Output dialog, Fig 8.1.22, allows the user to adjust some of the 

default settings.   

 

Crack front elements typically will be singular quarter-point wedge elements, but these can be 

converted to regular wedge elements with mid-side nodes if needed.  NX NASTRAN might 

generate an error when using quarter point elements, so elements with mid-side nodes can be 

used instead. There might be a loss of accuracy in the computed SIFs. 

 

NASTRAN checks the element shape by default, but this can be turned off using the 

GeomCheck option. 
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Figure 8.1.22  NASTRAN edit defaults dialog. 
 
 

8.1.7.2  NASTRAN Crack Face Contact 

 

The NASTRAN Crack Face Contact dialog, Fig 8.1.23, allows the user to set crack face contact 

options.  The parameters in the dialog are described in the NASTRAN documentation and will 

be different depending on the flavor of NASTRAN that is used.  Note that NASTRAN does not 

output contact pressure to the .pch file so one must compute SIFs using displacement correlation 

if CFC is included. 

 

 

 

Figure 8.1.23  NASTRAN contact dialog. 

 

 

8.1.8  NASTRAN local/global model connection Panel 

 

If the Connect to global model option (see Fig 8.1.21) is selected, the global model file must be 

set, Fig 8.1.24.  The Browse button can be used to find the file.  Note that the check box and the 

global model filename are filled automatically, based on the initial FE model import. 
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Figure 8.1.24  NASTRAN connect to global model box. 

 

 

If the Connect to global model option is selected, the Finish button in Fig 8.1.21, switches to a 

Next button.  The next panel, Fig 8.1.25, defines how the local and global models will be 

combined.  Note that the user cannot proceed to the next panel if the Connect to global box is 

checked and the Global model filename has not been entered.  

 

 

 

Figure 8.1.25  NASTRAN local/global model connection panel. 

 

 

The simplest method to connect a local crack model to a global model is through node-merging.  

If the user retained surface mesh facets on the cut-surfaces for the local model, then these 

surfaces can easily be glued together by merging nodes.  Alternatively, glued contact can be 

defined between the cut-surfaces of the local and global models by selecting the Constraint 

surfaces option. 
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Selecting the Constraint surfaces option activates the Constraint button; see Section 8.1.8.1.  

 

Extra local/global contact/constraint can be defined (see lower section of Fig 8.1.25) for surfaces 

other than the crack faces and the cut-surfaces; see Section 8.1.8.2.  

 

8.1.8.1  NASTRAN Constraint 

 

The NASTRAN Constraint dialog, Fig 8.1.26, allows the user to set glued contact options for the 

local and global model portions.   

 

 

 

Figure 8.1.26  NASTRAN constraint connection dialog. 

 

 

8.1.8.2  NASTRAN Extra Connection 

 

Additional local/global connections can be defined (see Fig 8.1.25).  Click the Add Connection 

button to display the dialog in Fig 8.1.27.  The connection can be made using glued contact.  The 

dialog shown in Section 8.1.8.1 is reused here.  Two mate surfaces from the global and local 

model must be selected by the user. 

 

To delete an extra connection, highlight the connection name and click the Delete Connection 

button. 

 

 



 217 

 

Figure 8.1.27  NASTRAN contact connection dialog. 

 

 

8.1.8.3  NASTRAN Command Line Panel 

 

If the user selects the View/Edit Command button in Fig 8.1.25, the NASTRAN command is 

displayed in a separate panel, Fig 8.1.28.  The command line can be edited if desired. Typically, 

users will set the NASTRAN executable and parameters in the Preferences rather than editing 

this command.  Editing this command line is not “permanent”, but the edits should be carried 

forward for subsequent static analyses of the current model. 

 

 

 

Figure 8.1.28  NASTRAN Command Line panel. 

 

8.1.8.4  NASTRAN Write Files but DO NOT run analysis 

 

In some cases, the user might want to write the analysis files from FRANC3D without running 

NASTRAN.  The Write files… option (see Fig 8.1.25) will cause FRANC3D to write all the 

analysis files.   

 

A .txt file is written along with the .bdf (or .nas) and .fdb files; the NASTRAN command is 

written to this .txt file for reference.  Note that if one sends this file to a different computer for 
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analysis, the .pch file that is written by NASTRAN must be retrieved so that FRANC3D can 

compute SIFs (see Section 4.7).  

 

 

8.2  Crack Growth Analysis  
 

This wizard allows one to set up and run a series of crack growth analyses.  The first set of 

wizard panels are the same as for the Grow Crack wizard described in Section 6.5.  The SIF 

computation method along with the crack growth extension and kink angle models must be 

defined.   

 

The analysis code panels are the same as those described in Section 8.1.  

 

The wizard panels that are displayed after defining the crack growth model, but before the 

analysis code panels, are described next.   

 

 

8.2.1  Crack Front Smoothing Panel 

 

The crack front smoothing panel, Fig 8.2.1, provides crack front fitting and template options.  

The options here are the same as the front fitting options described in Section 6.5.5, although 

they are arranged differently.  One might do one step of crack growth as described in Section 6.5 

before attempting automatic growth to determine the appropriate (best) fitting and extension for 

the model.  The fitting options might need to change as the crack grows. 
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Figure 8.2.1  Crack growth analysis wizard panel for fitting and template parameters. 

 

 

8.2.2  Crack Growth Increments Panel 

 

The next panel, Fig 8.2.2, allows the user to specify the number of crack growth steps and the 

median crack growth increment per step.  The dialog that is displayed will depend on whether 

you chose to do quasi-static (left side of Fig 8.2.2) or subcritical (right side of Fig 8.2.2) growth. 

 

There are three choices for entering the extension per step: a constant value for all steps, a linear 

variation, and user-defined values.  The user-defined values can be read from a .txt file; the data 

consists of extension length (or number of cycles) for each step. 
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Figure 8.2.2  Crack growth analysis wizard panel for median crack growth increments. 

 

 

The subcritical growth dialog includes various Growth Termination Criteria.  Some of the 

criteria are turned on by default and cannot be turned off.  Other criteria can be turned on as 

desired.  Note that maximum crack depth might be difficult to determine. 

 

 

8.2.3  Analysis Code Panel 

 

The next panel, Fig 8.2.3, allows one to specify the base file name.  All crack growth steps will 

use this as the base name, and a crack step number will be appended.  Finally, the current crack 

growth step number can be set; this number is used to create the file name (e.g., 

base_STEP_002).  The solver is chosen automatically based on the original input FE model. 

 

Depending on the solver, the subsequent wizard panels will be for ANSYS, ABAQUS or 

NASTRAN.  These panels were described in Section 8.1. 
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Figure 8.2.3  Crack growth analysis wizard panel for analysis code and base file name. 

 

 

 

 

9.  Fatigue Menu Wizards and Dialog Boxes 
 

The wizards and dialog boxes for the Fatigue menu option are described in this section. 

 

 

9.0 Fatigue Cycle Computation 
 

Earlier versions of FRANC3D, relied on a “K vs a” type of SIF history to compute fatigue 

cycles.  A path through the crack fronts is defined, Fig 9.0.1, and the SIFs are computed at each 

point where the path crosses a crack front; this gives a SIF versus path length plot, Fig 9.0.2.  

There are drawbacks to this approach: 1) a single path can be difficult to define for many cracks, 

and 2) different paths tend to give different numbers of cycles. 

 

 

 

 

Figure 9.0.1  A path through a series of crack fronts. 
 

path
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Figure 9.0.2  SIF (range) versus path length. 

 
 
 
 

 

Figure 9.0.3  Ambiguous path selection. 

 

K along path

? ? ? ?
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Figure 9.0.4  Different paths give different numbers of cycles. 

 

 

Cycle counting uses a “multiple variable degree of freedom” approach.  For each node j on crack 

front i, Fig 9.0.5: 

a) project from node j, perpendicular to the crack-front i, to find the intersection with the 

next crack front i+1, 

b) interpolate (if needed) to find K at the intersection point with crack-front i+1 

c) assume a linear variation in the K’s going from step i to step i+1 and integrate to find 

the cycles (Ni,j) 

d) average the computed cycles for all crack front nodes to obtain one value for cycles 

required to grow from crack front i to crack front i+1. 

 

 

 

Figure 9.0.5  Cycles computed for each node along the crack front. 

istep

1step +i

ji,node

ki ,1node +

1,1node ++ ki

x

yz

jiK ,

jiK ,1+

kiK ,1+

1,1 ++ kiK



 224 

This process is repeated for each step of crack growth, Fig 9.0.6, which produces cycles versus 

crack-growth-step, Fig 9.0.7. 

 

 

Figure 9.0.6  Cycles computed for each node along each crack front. 

 

 

 

Figure 9.0.7  Cycles versus crack step. 

 

 

There are several benefits of this approach.  The most significant is that all paths give the same 

number of cycles.  Paths along the model surface, where SIFs are least accurate, can be plotted 

and the cycles will be consistent with a path through the mid-points of the fronts, Fig 9.0.8. 

 

crack front icrack front i+1

node j
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Figure 9.0.8  Different paths give the same number of cycles. 

 

 

For cracks such as that shown in Figs 9.0.3 and 9.09, path selection might be ambiguous, but all 

paths will give a consistent number of cycles, assuming the paths go through the same number of 

crack steps. 

 

 

Figure 9.0.9  Different paths give the same number of cycles. 

 

 

9.1  Fatigue Life Predictions 
 

The Fatigue Life wizard, Fig 9.1.1, allows the user to compute fatigue cycles.  The dialog shows 

the cracked model on the left.  The right side will display plots of cycles, SIFs, and other data.  

The buttons and options in the middle pane are described here.   

 

Note that the Set Parameters button leads to the crack growth model selection described in 

Section 6.5.1.  The crack growth model that was used to grow the crack can be re-used here, or 

one can choose a different model to compute the life. 
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If the user grew the crack with a quasi-static growth model, the right-side pane in Fig 9.1.1 will 

indicate that no lifing parameters have been defined.  If crack growth was done using a 

subcritical growth model, the parameters are already defined and the right-side pane will show a 

plot of cycles versus crack step, Fig 9.1.2. 

 

 

Figure 9.1.1  Fatigue life dialog. 

 

 

 

Figure 9.1.2  Fatigue life plot. 

 

 

9.1.1  Read SIF Data 

 

The Read Sif Data button (Fig 9.1.1) allows one to read the .fcg file.  The .fcg file is 

FRANC3D’s file format for storing fatigue crack growth data, which includes all the SIF history 



 227 

data.  The .fcg file can be created using the Advanced menu option: Create Growth History, 

Section 12.5.  The file selector dialog, Fig 9.1.3, is displayed. 

 

 

 

Figure 9.1.3  File selector dialog for .fcg files. 

 

 

9.1.2  Set Parameters 

 

The Set Parameters button leads to the definition of the crack growth rate model, which was 

described in Section 6.5.1. 

 

 

9.1.3  Read Parameters 

 

The Read Parameters button allows one to read a previously saved crack growth rate model 

from a file.  The file selector dialog, Fig 9.1.4 is displayed with the available .cgp files. 
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Figure 9.1.4  File selector dialog for .cgp files. 

 

9.1.4  Save Parameters 

 

The Save Parameters button allows one to save the current crack growth model data to a file.  

The file selector, Fig 9.1.5, is displayed; the user can enter a .cgp file name.  This file can be re-

used as in Section 9.1.3. 

 

 

Figure 9.1.5  File selector dialog for .cgp files. 



 229 

 

 

9.1.5  Plot Cycles – Plot Time 

 

The right-side pane can be used to plot either cycles or time. 

 

9.1.5.1  Plot options 

 

There are three plot options:  Growth Step, Relative Variance, and Path.   

 

Growth Step corresponds to the discrete steps of crack growth that the user defines for analysis.  

The plot on the right shows computed cycles versus crack step #.  The cycle count at each step is 

the average cycle count computed for all mid-side nodes when growing the crack from one step 

to the next. 

 

The second option, Relative Variance, displays the standard deviation in the computed data. 

 

The third option, Path (Fig 9.1.6), allows the user to define a path.  Pressing the Define button, 

invokes the dialog shown in Fig 9.1.7.  This dialog is the same as for the Path tab described in 

Section 6.8.1.   

 

 

 

Figure 9.1.6  Surface length versus cycles. 
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Figure 9.1.7  Define Path dialog for plotting fatigue cycles vs path. 

 

 

9.1.6  Data Table 

 

The Data Table option displays whatever data is currently active in tabular form, Fig 9.1.8.  The 

dialog has an Export button that allows one to save this data to a file.  Press the Export button 

to invoke the file export dialog to save the data to a .txt file. 

 

 

 

Figure 9.1.8  Data table dialog. 
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9.1.7  Crack Front Plots 

 

The Crack Front Plots option displays the SIF and other data, Fig 9.1.9. There are tabs along the 

top right that allow one to display Kmax, Kmin, Delta K, Keq, Kstatic, Khold, R, and Temp.  

The data can be displayed in a table or exported to a file using the Table and Export tabs.  Data 

can be displayed for each crack front and for each crack growth step. 

 

 

 

Figure 9.1.9  Crack Front Plots dialog. 
 

 

9.2  View/Edit Growth Parameters 
 

The View/Edit Growth Parameters menu option allows the user to view and edit all the current 

crack growth parameters.  The dialogs described in Section 6.5 are presented with the current 

settings and values; these can be edited here.  

 

 

9.3  Crack Front Fatigue Values 
 

The Crack Front Fatigue Values menu option displays the dialog shown in Fig 9.1.9. 

 

 

 

10.  Fretting Menu Wizards and Dialog Boxes 
 

The wizards and dialog boxes for the Fatigue menu option are described in this section.  
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10.1 Read Model and Results 
 

FRANC3D can read ANSYS and ABAQUS files for fretting analysis.  The FE information is 

contained in .cdb and .inp files, respectively, Fig 10.1.1.  The FE information consists of nodes, 

elements, and a definition of the contact surfaces.   

 

Once the FE model is imported, analysis results must be imported.  A typical fretting test is 

conducted by applying a normal load (P) and then applying a maximum and minimum tangential 

(shear) load (Qmax and Qmin).  Simulating this can produce a pair of results files for the Qmax and 

Qmin conditions.  In most cases, the Q load is applied in smaller increments, which provides 

results at multiple intermediate substeps, as well as the Qmax and Qmin maximum load steps. 

 

Select the Fretting Read model and results menu item, to display the dialog in Fig 10.1.1, and 

choose the fretting model.  The File type can be changed to Abaqus to display .inp files.  

 

Once the FE model is chosen, the results file must be selected, Fig 10.1.2.  One can choose to 

read a pair of analysis results, corresponding to the Qmax and Qmin load steps, or read a .dtp file 

with multiple load step results. 

 

 

 

Figure 10.1.1  Fretting dialog for importing FE model data. 
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Figure 10.1.2  Fretting Read Results dialog. 

 

 

For the Pair of results option, select the Browse button for Qmax or Qmin to display the 

dialog shown in Fig 10.1.3.  If an ANSYS .cdb file was imported, ANSYS results files are 

expected.  The ANSYS .str files are simply the nodal stress listings saved to a file.  

Corresponding strain (.stn), displacement (.dsp) and contact status (.con) listings should also 

exist with the same name prefix.    

 

ABAQUS results are read from .fil files.  

 

 

Figure 10.1.3:  Fretting dialog for locating results files. 
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Selecting the Multiple load steps option activates the Select .dtp file field, Fig 10.1.4, and allows 

one to Browse for the .dtp file.  The .dtp files can be created from ANSYS using APDL 

commands and from ABAQUS using Python commands.  

 

 

Figure 10.1.4:  Fretting dialog for locating results files. 

 

 

FRANC3D reads the mesh information and results and determines the contact surfaces.  The user 

can choose the contact pair to be analyzed using the dialog shown in Fig 10.1.5.  The contact 

pairs are listed on the left side and colored blue in the model.  The blue surface is colored red 

when it is selected.  Note that only one contact pair is analyzed at a time.  

 

 

 

Figure 10.1.5   Select contact-pair surfaces dialog. 
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10.2 Import Nucleation Data 
 

FRANC3D can import experimental fretting fatigue test data and perform curve fit operations on 

the data.  Select the Import Nucleation Data menu item to display the dialog shown in Fig 

10.2.1.  The user should select the file containing the raw experimental data.  The format for this 

text file is: 

 
sigma_axial cycles 

--------------------------- 

675.3  2.23e4 

655.7  2.63e4 

533.8  4.45e4 

 

 

 

 

Figure 10.2.1   Fretting dialog for importing experimental fretting nucleation data. 

 

 

 

Select the Browse for File button, Fig 10.2.1, to display the File open dialog, Fig 10.2.2., and 

select the appropriate .txt file. 

 

The fretting data is shown in tabular form, Fig 10.2.3.  Select the Plot/Edit button to display the 

dialog shown in Fig 10.2.4.  The fretting nucleation data is shown in tabular and graph form.  

The user can edit the data in the table by selecting the Edit menu item and switching from the 

default Read Only mode.  The user can also perform curve fitting operations on the data using 

the Fit menu.  The Fit menu provides seven different equations for comparison, but the standard 

fretting model corresponds to the Power Law2 equation. 
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Figure 10.2.2  Fretting dialog for selecting the fretting nucleation data file. 

 

 

 

Figure 10.2.3  Fretting dialog shows fretting nucleation data in tabular form. 
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Figure 10.2.4  Fretting dialog for plotting fretting nucleation data. 

 

 

The usual fretting nucleation model uses a power law relationship with four coefficients to relate 

the fretting nucleation cycles on the horizontal axis with the fretting parameter on the vertical 

axis.  This power law is highlighted in Fig 10.2.5, which also shows the fit through the data.  The 

goodness-of-fit is displayed on the top of the plot with the equation.  The equation coefficients 

are shown in the top-level dialog, Fig 10.2.6. 

 

 

 

Figure 10.2.5  Fretting dialog for plotting fretting nucleation data with power law curve fit 

through the data. 
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Figure 10.2.6  Fretting dialog shows fitted equation and coefficients. 
 

 

10.3 Fretting Crack Nucleation 
 

FRANC3D computes fretting fatigue crack nucleation cycles and initial crack location (and 

possibly orientation) based on one or more of the fretting nucleation models that have been 

implemented.  These include:  the equivalent stress, the critical plane shear stress amplitude, the 

critical plane Smith-Watson-Topper, the Ruiz-Chen model, and a modified Smith-Watson-

Topper model.  The model equations and parameters are briefly summarized here.   

 

For more details, refer to: Three-dimensional Simulation of Fretting Crack Nucleation and 

Growth, B.J. Carter, E.C. Schenck, P.A. Wawrzynek, A.R. Ingraffea, and K.W. Barlow, EFM, 96 

(2012), p.447-460. 

 

The equivalent stress model is defined by: 

 

seq = 0.5 (spsu)
w (smax)

1-w     (1) 

 

where spsu and smax are functions of the nodal stress components and w is a material dependent 

fitting parameter.  Based on curve fitting of experimental data, the equation in the form of the 

power law: 

 

seq = aNi
b + cNi

d      (2) 

 

relates seq to Ni, where coefficients a – d are material dependent fitting parameters.  For 

example, for Ti-6Al-4V, a = 52476, b = -0.6471, c = 450.85 and d = -0.03582.   

 

The critical plane shear stress amplitude model is defined by: 
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crit  = max/G (1-R)m      (3) 

 

where max is the maximum shear stress on the critical plane, R is the shear stress ratio, G is the 

shear modulus, and m is a material dependent fitting parameter.  Substituting crit for seq in 

equation (3), one can compute Ni given the appropriate values for the coefficients a – d.  For Ti-

6Al-4V, a = 6.46, b = -0.686, c = 4.65x10-3 and d = 1.22x10-2. 

 

The critical plane Smith-Watson-Topper model is defined by: 

 

crit = smax () = (sf
2 / E) (2Ni)

2b  + s f f (2Ni)
b+c     (4)   

 

where smax is the maximum principal stress and  represents the normal strain amplitude on the 

critical plane; this equation is already in the form of equation (3).   E is the elastic modulus, sf
  

and f  are material strength parameters, and b and c are fitting parameters.  For Ti-6Al-4V, sf
   = 

376.6 MPa, b = 1.78x10-4, c = -0.767 and f  = 32.4. 

 

The Ruiz-Chen model fretting parameter, F2, is equal to the product of the shear stress (), 

relative slip (), and bulk normal stress (s): 

 

F2 = s                           (8) 

 

The number of cycles is computed by replacing seq in equation (2) with F2.  The parameters a, b, 

c, and d will be material dependent. 

 

Recent work by Hirsch2 (2013) following work by Ding et al3 (2007) indicate that a fretting 

model that combines the Ruiz-Chen and SWT (or Fatemi-Socie) models can more effectively 

predict fretting crack nucleation location and cycles, in addition to accounting for the transition 

from fretting to wear.  Hirsch (2013) used the Fatemi-Socie model for his material and test 

specimens and proposed the following: 

 

FS ·D = f (Nf)                         (9) 

where 

 

 

 

 

 

 

 
2 Hirsch, M. (2013) Temperature Dependent Fretting Damage Modeling of AISI 301 Stainless Steel.  PhD Thesis, 

Georgia Institute of Technology. 
3 Ding, J. et al., (2007) Fretting fatigue predictions in a complex coupling. International Journal of Fatigue, 29, 

1229-44. 
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and a, b, c, and d are constants, FS is the Fatemi-Socie parameter, R is the wear rate, Weff is the 

effective work, kdam is the fraction of the total frictional energy that goes toward fatigue damage, 

acp is the ratio of the frictional energy, and () is the frictional work. 

 

The first dialog box that is displayed after selecting the Fretting Crack Nucleation menu item, 

if there are more than two load steps, is shown in Fig 10.3.1.  The user can specify the pair of 

load steps of interest or have FRANC3D process all load step pairs to find the pair that 

maximizes the fretting parameter. 

 

 

 

Figure 10.3.1   FRANC3D Fretting dialog to select load step results. 

 

 

The next dialog box, Fig 10.3.2, allows the user to select one of the fretting nucleation models.  

Selecting Next leads to the dialog shown in Fig 10.3.3, which lets the user define the fretting 

model parameters.  Note that the user can select the fitting coefficients based on a curve fit 

through the experimental data (see previous section).  If these coefficients are not available, the 

option for curve fit values is disabled.  All fretting models have similar dialogs, Figs 10.3.4 - 

10.3.7.   
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Figure 10.3.2   Dialog to select fretting nucleation model. 

 

 

 

Figure 10.3.3  Fretting dialog to set equivalent stress fretting model parameters. 
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Figure 10.3.4  Fretting dialog to set critical shear stress model parameters. 

 

 

Figure 10.3.5  Fretting dialog to set Smith-Watson-Topper (SWT) model parameters. 
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Figure 10.3.6  Fretting dialog to set Ruiz-Chen model parameters. 

 

 

Figure 10.3.7  Fretting dialog to set modified SWT (FS) model parameters. 

 

 

The dialog boxes shown in Figs 10.3.3 - 10.3.7 have an option for averaging stress and strain.  

Rather than computing the fretting parameters based on surface node values, the user can choose 

the element centroid or an averaged value.  If the averaged at node option is chosen, the next 
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dialog box is shown in Fig 10.3.8.  The user can adjust the size of the displayed sphere by 

changing the Averaging length value. Note that stress values are not averaged across material 

region boundaries.  Typical length values used in the literature are based on material grain size. 

 

 

 

Figure 10.3.8   Fretting dialog for volume averaging of stress (and strain). 

 

 

Selecting Next on the dialog shown in Fig 10.3.8 leads to the dialog shown in Fig 10.3.9.  This 

dialog shows the model and allows the user to view the contact surfaces, the edge of contact, the 

fretting nucleation cycles, and the fretting parameter values.  The latter two items can be 

displayed as text or using color contours. 

 

Selecting the Save to File button on the dialog shown in Fig 10.3.9 leads to the file save dialog 

shown in Fig 10.3.10.  The fretting nucleation data is saved to a text file with the following 

format:   

 
primary surface 

       node         x                        y                              z             parameter   cycles 

       19222       0.49648972       0.91291108             0.15          25             19283 

       20917       0.52414545       0.94056681             0.12          29            18453 

       20881       0.51283174       0.92925310             0.12          24            19898 
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Figure 10.3.9   Fretting dialog for displaying fretting nucleation cycles and parameter values 

and contours. 

 

 

 

Figure 10.3.10   Fretting dialog for selecting file to save fretting nucleation predictions. 

 

 

The user can go Back and choose a different fretting nucleation model to compare predictions.   
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10.3.1 Surface treatment residual 

 

An additional option for each of the fretting models (except for the Ruiz-Chen model) is the 

ability to add a surface treatment residual stress.  Checking the Add residual stress box, leads to 

the dialog in Fig 10.3.11. The residual stress treatment is the same as described in Section 7.2.4.  

The stress versus distance from the surface is specified or read from a file, and then the treated 

surface is identified.  The residual stress is added to (or subtracted from) the bulk stress when 

computing the fretting parameters. 

 

 

 

Figure 10.3.11   Fretting dialog for selecting file to save fretting nucleation predictions. 

 

 

10.4 Region Color 
 

FRANC3D will display material regions with distinct colors.  The Region Color menu item 

allows the user to turn on or off the region coloring, Fig 10.4.1.  This option is purely for display 

purposes, and regions can be differentiated in complex multi-region models. 

 

 

Figure 10.4.1   Fretting dialog for turning off/on region coloring.  



 247 

 

 

11.  Display Menu Wizards and Dialog Boxes 
 

The wizards and dialog boxes for the Display menu options are described in this section.  

 

 

11.1  View Response Dialog 
 

The View Response menu item allows one to view the deformed shape of the current model.  

Analysis results are required to activate this menu item.  The dialog shown in Fig 11.1.1 is 

displayed.   

 

The Display Mesh Overlay can be turned off to remove the surface mesh facets from the model 

view.  

 

The deformed shape can be displayed by turning on the Display on Deformed Geometry option 

and entering a non-zero magnification factor, Fig 11.1.2.  If there are multiple load steps, the 

deformed shape for a specific load step or for the sum of all load steps can be selected. 

 

 

 

Figure 11.1.1  View Response dialog showing undeformed mesh. 
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Figure 11.1.2  View Response dialog showing the deformed shaded solid and the original 

wireframe outline. 

 

 

 

11.2  Create Animation Wizard 
 

The Create Animation menu item allows one to create and save crack growth animation files.  

The dialog, Fig 11.2.1, allows one to select a set of FRANC3D restart (.fdb) files to create an 

animation of the crack growth. 

 

The File – Read Files menu option displays the file selector dialog, Fig11.2.2.  One can select 

the set of .fdb files for the crack growth animation.  Use the Shift or Ctrl key to select multiple 

files.   

 

Select Accept when ready, and FRANC3D will read each of the .fdb files along with the 

associated FE files.  This process can take some time depending on the number of files and the 

size of the model; a status bar is displayed as the files are processed. 
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Figure 11.2.1  Create Animation dialog. 

 

 

 

Once all files have been processed, the first crack model is displayed, Fig 11.2.3.  The ordering 

of the crack models is based on the file name.   

 

The Last and Next buttons at the bottom are activated; the First and Prev buttons will be 

activated if one steps to the next or last crack model.  

 

The avi file button is also activated.  This allows one to save an .avi file of the crack growth 

steps.  The file consists of a series of images (one for each step of crack growth) based on the 

current model view (camera position).  You should orient the model into a camera position that 

shows all of the crack growth steps before clicking the avi file button. 

 

The Settings menu has two options:  1) Frame Rate and 2) Angle Threshold.  The frame rate of 

the .avi file can be adjusted to speed up or slow down the animation.  The angle threshold 

controls the display of the geometric lines and surfaces (see Section 14.1). 

 

Note: if the last step of crack growth is not displayed correctly when playing, make a copy of the 

last step, and include it at the end of the list of files that are selected.  For example, in Fig 11.2.2, 

the extra copy of the ‘_step_006’ might be called “_step_006b’. 
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Figure 11.2.2  Create Animation select .fdb files. 

 
 

 

Figure 11.2.3  Create Animation dialog with cracked model imported. 
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12.  Single Crystal Menu Wizards and Dialog Boxes 
 

The wizards and dialog boxes for the Single Crystal menu options are described in this section.  

 

 

12.1  Resolved Stress Intensities 
 

The Resolved Stress Intensities menu item allows one to view the SIFs along the crack front 

resolved onto slip planes.  The first dialog, Fig 12.1.1, allows you to select the SIF computation 

method; this is the same as in Section 6.4.  The SIFs Display dialog, Fig 12.1.2, is different from 

the standard SIF display (see Section 6.4); it includes options to display the SIFs resolved into 

the various slip planes (e.g., 111).  Rather than the standard three SIF modes (KI, KII and KIII), 

one can plot KRSS, KRNS and KRSS/KRNS.  

 

 

 

Figure 12.1.1  Compute SIFs computation method dialog. 

 

 

 

Figure 12.1.2  Resolved SIFs display dialog. 
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The View Orientations button displays the dialog in Fig 12.1.3.  This gives a visual display of 

the slip plane orientation relative to the crack orientation. 

 

 

 

Figure 12.1.3  View Orientations dialog. 

 

 

 

12.2  Resolved SIFs Along a Path 
 

The Resolved SIFs Along a Path menu item allows one to view the SIFs along a path through 

the crack fronts.  The dialog, Fig 12.2.1, is slightly different from the standard dialog in Section 

6.9.  As for the Resolved SIFs dialog (see Fig 12.1.2), the user can select the slip plane and plot 

KRSS, KRNS and KRSS/KRNS along the path. 
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Figure 12.2.1  Resolved SIFs along a path dialog. 

 

 

12.3  View Crystal Orientations 
 

The View Crystal Orientations menu item allows one to visualize the crystal orientation, Fig 

12.3.1, relative to the model and the crack.  The slip planes can be displayed and moved around 

in the model using the options on the left side. 

 

 

 

Figure 12.3.1  Crystal Orientation dialog. 
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13.  Electrical Menu Wizards and Dialog Boxes 
 

 

14.  Advanced Menu Wizards and Dialog Boxes 
 

The wizards and dialog boxes for the Advanced menu options are described in this section.  

 

 

14.1  Edges Wizard 
 

The Edge Extraction dialog, Fig 14.1.1, allows the user to control the geometry that is extracted 

from the finite element facets.  The Angle Threshold can be adjusted to increase or decrease the 

number of surfaces by blending facets together.  

 

The left side image in Fig 14.1.1 shows a curved surface that is treated as a single surface based 

on the default angle threshold. If the angle is increased from 151 to 166, the surface appears as 

shown on the right.  In most cases, the default angle is good.  However, for coarse meshes and 

doubly curved surfaces, it is sometimes helpful to break the surface into more patches. 

 

Section 4.4 of the User’s Guide describes a case where the edge wizard is used to improve the 

geometry of an airfoil model. 

 

 

  

Figure 14.1.1  Edge extraction dialog; angle threshold increased. 

 

 

The Planar Seed Fill option uses a different algorithm to break the surface patches, Fig 14.1.2. 

The Planar Threshold and Minimum Facets can be used to adjust the algorithm results.  The 

results will vary depending on the underlying model mesh. 
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Figure 14.1.2  Edge extraction dialog with do planar seed. 
 

 

For cylindrical surfaces such as a hole in a plate, the user can add edges to break up the surface.  

By selecting the Add button for Edge Lines in Fig 14.1.1, the dialog in Fig 14.1.3 is displayed to 

allow the user to define edges, which are used to divide the surface. 

 

 

 

Figure 14.1.3  Add edge dialog. 

 

 

 

14.2  Display COD Data  
 

The Display COD Data menu item allows the user to view and save crack displacement data.  

The first dialog that is displayed, Fig 14.2.1, prompts the user to enter a distance back from the 

crack front where crack displacements will be computed.  The default is to measure the distance 

from the crack front template nodes.  If the user turns this option off, geometric points along the 

front are used. 
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Figure 14.2.1 Write crack front data - Save File As dialog. 

 

 

Select Accept on the dialog in Fig 14.2.1, and the dialog shown in Fig 14.2.2 is displayed.  This 

dialog displays the crack opening (COD), sliding (CSD) and tearing (CTD) displacements along 

with the corresponding SIFs (KI, KII and KIII).   

 

The three menu items:  File, Data and Axes are the same as for the SIF plot dialog (see Section 

6.4).  As with the SIF plot dialog, the data can be exported to a file, Fig 14.2.3.  The data export 

options include the crack displacements along with the locations where the displacements are 

computed. 

 

 

 

Figure 14.2.2 Write COD data – create file dialog. 

 

 



 257 

 

Figure 14.2.3  Write COD data – export tab. 

 

 

14.3  Write Template Data  
 

The Save File As dialog, Fig 14.3.1, is presented so that template data can be saved to a file.  

The data is saved to an ASCII text file with .std extension.   

 

 

Figure 14.3.1 Write template data - Save File As dialog. 

 

 

The file format for this file is briefly described here. 

 
STD_TEMPLATE_DATA 
{ 
VERSION: 1 
NUM_FRONTS: 1 
CRACK_FRONT: 0 49 25 OPEN 
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  CORNER_SET: 0  # corner node ids of template element ring 
     11978 12907 11421 12440 11888 6756 7686 7222 8147 5762 
     6227 10350 10816 973 1436 4673 5142 8373 8835 
 …. 
  SIDE_SET: 0  # side node ids  
     6938 3386 6470 14975 6003 2013 616 1081 3384 
     2479 2916 6383 2450 7784 6385 6854 9277 8246 
     8815 4877 8353 3061 1198 1662 7643 3527 7180 
     13551 6713 14015 14362 6338 13898 4288 
 ….. 
NODE_COORDS: 1781 # list of all node ids and coordinates 
  7321            -0.52397588            -0.01178516              9.9308077 
  11252            -0.47625961         1.0479856e-014              9.7249057 
…. 
NODE_DISP: 1781 # list of all node ids and displacements 
  7321  2.34113830186791e-005   0.000939063262674639  -0.000290174323814175 
  11252  2.24602369565477e-005   0.000940419013229567    -0.0002799458448084 
…. 
} 

 

 

14.4  Create Growth History  
 

The Create Growth History dialog, Fig 14.4.1, allows a user to create and edit the SIF history 

data.  A list of the crack growth steps is provided, and then for each step, the data for each crack 

front is given.   

 

The dialog has three menu items: File, Edit and Plot.   

 

The File menu has three options, Fig 14.4.2.  Read History invokes the usual File Open dialog 

with the .fcg file filter.  Append History invokes the usual File Open dialog with the .fcg file 

filter.  Save History invokes the usual File Save As dialog to save the data to a new .fcg file. 
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Figure 14.4.1  Create Growth History dialog. 

 

 

 

Figure 14.4.2  File menu for Create Growth History dialog. 

 

 

The Edit menu option has one entry.  Set Start Condition invokes the File Open dialog with the 

.fcg filter.  The .fcg file should containt the start condition for the SIF history. 

 

The Plot menu option has one entry.  Plot Crack Fronts invokes the dialog shown in Fig 14.4.3.  

This dialog allows the user to view the front-edges for all crack fronts for all crack growth steps. 
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Figure 14.4.3  Plot crack fronts dialog from Growth History dialog. 

 

 

 

14.5  Export Crack Data  
 

The Export Crack Data menu item invokes the File Save As dialog; it allows one to save the 

current crack growth data to a .fcg file (see Section 14.4). 

 

 

14.6  Read User Extensions  
 

The Read User Extensions menu item allows one to import Python functions into FRANC3D for 

use during crack growth.  A user can define their own rules for growing a crack with Python 

functions.  This is more fully described in the Command Language & Python Extensions 

reference.   

 

Note that the PATH and PYTHONPATH environment variables will need to be set to have all 

the Python capabilities.  Python 3.6 and later versions should work. 

 

A dialog is displayed allowing one to choose the Python (.py) file containing the functions, Fig 

14.6.1.  After selecting the file and clicking Accept, FRANC3D reads the .py file and displays a 

list of the “known” functions that were read, Fig 14.6.2.   
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Figure 14.6.1  User extensions open file dialog. 

 
 

 

Figure 14.6.2  User Python extension functions. 

 

 

See the Command & Python reference for a more complete description of the Python extension. 

 

 

 

14.7  Initial Stress File  
 

The Initial Stress File menu item is temporary; it allows one to define initial stress conditions 

with ABAQUS.  See Section 7.1.6 for a description of the dialog that is displayed. 
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14.8  Initial Strain File  
 

The Initial Strain File menu item is temporary; it allows one to define initial strain conditions 

with ABAQUS.  See Section 7.1.6 for a description of the dialog that is displayed. 

 

 

14.9  Plot CFT Stress File  
 

Plot CFT Stress File allows one to contour crack face traction values based on mesh-based stress 

input. See Section 7.1.6 for a description of the dialog for entering the mesh-based stress input.   

 

Once the data is imported, the dialog shown in Fig 14.9.1 is displayed.  The traction values on 

the crack surface, computed from the input stress, are contoured.  This dialog is intended to be 

used to verify that the stresses are being extracted and applied as expected. 

 

 

 

Figure 14.9.1  Plot CFT stress dialog. 

 

 

14.10  Edit Retained Nodes  
 

The Edit Retained Nodes menu item allows one to revise the retained nodes and facets if these 

are interfering with crack growth.  A crack cannot be inserted/extended into a retained surface. 

Use of this dialog, Fig 14.10.1, is described in Section 5.6 of the User’s Guide. 
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Figure 14.10.1  Edit Retained Nodes dialog. 

 

 
 

14.11  Contour Integral Data  
 

The Contour Integral Data menu item allows one to import and plot the analysis contour integral 

(CI) data.  ABAQUS and ANSYS contour integral data is supported.  The ABAQUS .dat file or 

the ANSYS .out file can be selected; these files contain the CI data in the following format for 

ABAQUS: 

 

 
                              J - I N T E G R A L   E S T I M A T E S 

 

   CRACK   CRACKFRONT          C O N T O U R S 

   NUMBER  NODE SET 

                                1               2               3               4               5 

                                6 

 

     1        -10-              1.4192E-02      1.5211E-02      1.5659E-02      1.6162E-02      1.6702E-02 

                                1.7303E-02 

     1        -11-              1.5466E-02      1.6031E-02      1.6078E-02      1.6093E-02      1.6102E-02 

                                1.6115E-02 

 

 

and for ANSYS: 

 
***** POST1 J-INTEGRAL   RESULT LISTING *****  
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 CrackID =   1 

  Crack Front Node =    5656 

   Contour Values =   0.15010E-01  0.15471E-01  0.15495E-01  0.15504E-01 

   Contour Values =   0.15512E-01  0.15521E-01 

  Crack Front Node =   28626 

   Contour Values =   0.15631E-01  0.16093E-01  0.16144E-01  0.16167E-01 

   Contour Values =   0.16181E-01  0.16195E-01 

 

 

 

The CI data is displayed in a dialog, Fig 14.11.1.  The data can be displayed either Along the 

Front or By Ring.  The number of contour rings is based on the crack front template mesh.  The 

default template has one ring of wedges (or collapsed bricks) and two rings of bricks, which 

gives three contour rings.  For better results, additional rings are usually required. 

 

 

 

Figure 14.11.1  Contour Integral Data dialog. 
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Appendix A:  XY Plot Label Syntax 
 

 

// Layout a label like an equation 

// 

// Items: 

//    |Seq(<item1>,<item2>, ... ,<itemn>)   - sequence of items 

//    |Sub(<base>,<subscript>)              - item with a subscript 

//    |Sup(<base>,<superscript>)            - item with a superscript 

//    |Ss(<base>,<superscript>,<subscript>) - item with a both sub and superscript 

//    |Sqrt(<item>)                         - square root 

// 

// Symbols and Operators: 

//    $Eq      - equals 

//    $Gt      - greater than 

//    $Lt      - less than 

//    $Ge      - equal or greater than 

//    $Le      - equal or less then 

//    $Plus    - plus sign 

//    $Minus   - minus sign 

//    $Mult    - multiplication sign (cross) 

//    $Div     - division sign (bar and two dots) 

//    $Del     - partial derivative 

//    $About   - two wavy lines 

//    $alpha   - lower case alpha 

//    $Alpha   - upper case Alpha 

//    $beta    - lower case beta 

//    $Beta    - upper case beta 

//    $delta   - lower case delta 

//    $Delta   - upper case delta 

//    $(       - left paren 

//    $)       - right paren 

 

 

// 

// Render a math equation using a subset of the Latex equation grammar 

// 

// Native symbols 

//     + - = ! / ( ) [ ] < > | ' : 

// 

// Escaped symbols 

//     \Alpha   \alpha 

//     \Beta    \beta 

//     \Delta   \delta 

//     \Eta     \eta 

//     \Gamma   \gamma 
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//     \Sigma   \sigma 

//     \Theta   \theta 

//     \geq 

//     \leq 

//     \times 

//     \div 

//     \partial 

//     \sim 

// 

// Items: 

//     \sum{} 

//     \sqrt{} 

//     \frac{}{} 

//     \lines{{}{}} 

// 

// Other: 

//     "_" denotes subscript 

//     "^" denotes superscript 

// 

// Approximate Grammar: 

// 

// <equation> := <sequence> 

// 

// <sequence> := <seq_item> | <sequence> <seq_item> 

// 

// <seq_item> := <atom> | <group> | <sub_item> 

//               <sup_item> | <both_item> | <sum_item> 

//               <sqrt_item> | <frac_item> | <lines_item> 

// 

// <atom> ::= <character> | <symbol> | <digit> 

// 

// <group> ::= {<sequence>} 

// 

// <modifier> ::= <atom> | <group> 

// 

// <sub_part>  ::= _<modifier> 

// <sup_part>  ::= ^<modifier> 

// <both_part> ::= _<modifier>^<modifier> 

// 

// <sub_item>  ::= <eqn_item><sub_part> 

// <sup_item>  ::= <eqn_item><sup_part> 

// <both_item> ::= <eqn_item><both_part> 

// 

// <sum_item> ::= \sum <eqn_item> | 

//                \sum<sub_part> <eqn_item> | 

//                \sum<sup_part> <eqn_item> | 
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//                \sum<both_part> <eqn_item> 

// 

// <sqrt_item> ::= \sqrt<eqn_item> 

// 

// <frac_item> ::= \frac<group><group> 

// 

// <lines_item> ::= \lines {<group> <group> ... } 
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